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1.0 Introduction
This reference guide is for application engineers who build and configure the FleX-Net™ Fire 
Alarm Control Panel. It covers FleX-Net™ firmware version 12.2.33 and Configurator version 
12.2.33.

For FleX-Net™ version 12.1, see revision 3.2 of this guide.

1.1 Related Documents

• LT-6707 Advanced Logic Programming Manual
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2.0 Working with the Fire Alarm Control 
Panel and the Configurator
This chapter covers the most important things you need to know about the Fire Alarm Control 
Panel and the Configurator.

The Fire Alarm Control Panel network (also called the Fire Alarm Control Panel, the FACP, or 
the panel) is the system of networked panels that controls the fire detection and prevention 
system.

The MGC Fire Detection and Mass Notification Configurator 2018 (the Configurator) is the 
software application that lets you configure and manage the jobs that control the Fire Alarm 
Control Panel network. A job is a set of configuration data that uniquely describes and controls 
a set of Fire Alarm Control Panel hardware. The application icon is called MGC Configurator 
V12_2.

This chapter includes:

• Connecting the Configurator to the Fire Alarm Control Panel
• Sending a Job to the Fire Alarm Control Panel
• Getting the Active Job from the Fire Alarm Control Panel

• Exporting a Job
• Managing Jobs
• Changing the Active Job

• Deleting a Job
• Getting Configuration Information
• Getting Information about the CodeMeter Key

• Restarting the Fire Alarm Control Panel
• Watchdog Jumpers
• Synchronize Sounder Base Addresses

• Print Active Events
• Connect a Virtual Terminal Program

2.1 Connecting the Configurator to the Fire Alarm Control Panel

You need the following items in order to connect the Configurator to the Fire Alarm Control 
Panel:

• Windows 7 or 10 computer with a USB port
• Serial cable or USB to serial cable
• UIMA4 cable

• Registered CodeMeter key
• MGC Fire Detection and Mass Notification Configurator 2018 (the Configurator) version 

12.2.33

To connect the Configurator to the Fire Alarm Control Panel you must:
• Insert the CodeMeter key.
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• Connect the computer and start the Configurator.

Follow the instructions below to complete these steps.

2.1.1 Inserting the CodeMeter Key

The CodeMeter key is a USB flash drive that controls access to the Fire Alarm Control Panel.

• Insert your CodeMeter key into the computer.

The CodeMeter icon in the Windows system tray (the lower right-hand corner of the 
screen) turns blue.

Figure 1 Connected CodeMeter key

If the CodeMeter key is not connected, the icon is grey.

Figure 2 Disconnected CodeMeter key

2.1.2 Connecting the Computer

Connect the computer to the Fire Alarm Control Panel for configuration

1. Connect the RS-232 cable or the USB cable to the UIMA4 cable.

2. Connect the 10-pin head of the UIMA4 cable to the last CPU in the CPU chain that starts 
from the main board.

3. Connect the other end of the RS-232 cable or the USB cable to the computer.

4. Start the Configurator.

The Configurator prompts you for your PIN.

5. Type your four digit PIN.

Figure 3 Security Key Logon

Note: The port is P3 on the FleX-Net™ main board and ALCN-792MISO, P4 on 
ALC-386S, and P10 on ANC-5000.i
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6. Click Panel > Connect.

You are now connected to the Fire Alarm Control Panel.

2.2 Sending a Job to the Fire Alarm Control Panel

Send a job

1. Click Job > Open Job and open the job that you want to send.

2. In the Configurator, click Panel > Connect.

3. Click Panel > Send Job.

4. Select the nodes that you want to send the job to.

Figure 4 Send Job

A window appears warning you that the job you are about to overwrite on the panel is not 
backed up on the local database. This message only applies if you are sending the same 
version of a job that is already on the panel.

Figure 5 The job you are about to overwrite on the panel is not backed up on 
the local database

5. Click Yes.
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A window appears asking if you want to make this job the active job.

Figure 6 The job has been successfully stored

6. Click Yes if you want to make this job the active job.

A window appears saying that the job was successfully downloaded to the FACP.

Figure 7 Job successfully downloaded

7. Click OK.

8. The panel restarts.

2.3 Getting the Active Job from the Fire Alarm Control Panel

Get the current active job from the Fire Alarm Control Panel

1. In the Configurator, click Panel > Connect.

2. Click Panel > Get Job.

If a window appears saying that the job is already in the database:

a. Click Yes to save it as a new version.

Figure 8 Job Already in Database
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A window appears asking for the new version information.

Figure 9 New Job Version Information

b. Type a comment in the Comments box, and then click OK.

A window appears saying that the job was successfully uploaded from the FACP.

Figure 10 Job successfully uploaded

3. Click OK.

2.4 Exporting a Job

You can export jobs from the Configurator, and send them to other technicians or use them in 
other applications. The job file contains all the job information, including CPUs, devices, and 
correlations. You can export jobs in a number of formats. The two most commonly used 
formats are:

• Database files (*.mdb). This format is used by other technicians. If you export a job in 
this format, another technician can import it into the Configurator on another computer.

• OpenGN Phase II (*.xml). This format is used by OpenGN.

2.4.1 Exporting a job as a database file or an XML file

Export the job as a database file or an XML file

1. In the Configurator, click Job > Export Job.

The Export current job to a file window appears.

The Configurator gives the job a name of the form Job_nn-w, where nn is the job 
number, and w is the version number. You can change this name.

2. Choose a location to save the file, and type a name for the file.
• To export the job as a database file:

• Select Database files (*.mdb) in the Save as type pulldown menu.
• To export the job as an XML file for OpenGN:

• Select OpenGN Phase II (*.xml) in the Save as type pulldown menu.
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3. Click Save.

4. If the Select Firmware Version window appears, make sure that the numbers in the first 
two fields match the firmware version of the FACP that is running the job that you are 
exporting. Then click OK.

2.5 Managing Jobs

You can manage the jobs on the panel and see which job is active and what has changed.

Manage jobs on the panel

• In the Configurator, click Panel > Manage Jobs.

The Manage Jobs Configuration on Panel window appears.

Figure 11 Manage Jobs

The FACP can hold three jobs in its memory. This window shows the jobs that are currently on 
the panel. The active job is orange if not selected and blue if selected. This window also shows 
any changes that have been made.

•  A green check mark indicates items that are the same.

•  A red arrow indicates items that were removed.

•  A blue arrow indicates items that were added.

In Figure 11, Version 1 had an annunciator at address 34. This annunciator was removed in 
version 2.

2.6 Changing the Active Job

The FACP can hold three jobs in its memory. One of these jobs is the active job. The FACP 
can have only one active job at a time. You can make one of the other jobs the active job using 
the Configurator or using the switches on the FACP.
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2.6.1 Changing the Active Job using the Fire Alarm Control Panel

Change the active job using the Fire Alarm Control Panel

On the main display of any node (transponder unit) or on an annunciator for any node in the 
system:

1. Press the MENU button, and then press the arrow buttons to scroll down to Choose 
Config.

2. Press ENTER.

3. If the system asks for your passcode, enter it, and then press ENTER.

4. Press the arrow buttons to scroll through the available configurations, and then press the 
ENTER button to choose the configuration you want.

5. Press ENTER to confirm.

The system changes the active job.

2.6.2 Changing the Active Job using the Configurator

You can change the active job using the Configurator.

Change the active job using the Configurator

1. In the Configurator, click Panel > Manage Jobs.

The Manage Jobs Configuration window appears.

2. Right-click the job you want to make active, and then click Activate Job.

3. Click Yes to confirm.

The system changes the active job.

4. Click OK to close the Manage Jobs Configuration window.

2.7 Deleting a Job

The FACP can hold three jobs in its memory. If there are already three jobs on the FACP and 
you want to send a new job, you must delete one of the old jobs.

Note: This procedure changes the configuration for all the nodes that are currently 
connected to the system.

Note: This procedure changes the configuration for all the nodes that are currently 
connected to the system.

Note: You cannot delete the active job. You must make another job active first.

i

i

i
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Delete a job

1. In the Configurator, click Panel > Manage Jobs.

The Manage Jobs Configuration window appears.

2. Select the checkbox of the job that you want to delete.

3. Click Delete Selected.

4. Click Yes to confirm.

The system deletes the job.

2.8 Getting Configuration Information

If you experience difficulty, it is helpful to have information about how the Fire Alarm Control 
Panel is configured. You can get this information from the Configurator and from the Fire 
Alarm Control Panel itself.

2.8.1 Getting Configuration Information from the Configurator

Get configuration information from the Configurator

1. In the Configurator, click Panel > Connect.

2. Click Panel > Panel Information.

The Panel Information window appears.

Figure 12 Panel Information

Job Name The name of the job that is currently active on the FACP.

Version The version number of the job that is currently active on the FACP.

Date The date and time when the job was sent to the FACP.

ESD The ESD (Electronic Systems Distributor) number of the organization 
that sent the job. Each organization has a unique ESD number, so 
that one organization cannot modify systems that another 
organization has configured.

Technician The number of the technician who sent the job.
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3. Click Advanced.

The Advanced Panel Information window appears.

Figure 13 Advanced Panel Information

2.8.2 Getting Configuration Information from the Fire Alarm Control Panel

You can get configuration information from the FACP itself, including the number of the ESD 
and technician that configured the FACP.

Get configuration information from the FACP

1. On the main display of any node or on an annunciator for any node in the system, press 
the MENU button.

2. Use the arrow buttons to scroll to Config Info, and then press ENTER.

The display shows the ESDNo (ESD number) and TechNo (technician number).

3. Press the down arrow button to see the Build Time (the date and time when the firmware 
on the CPU was built).

4. Press the down arrow button to see the IP information for this node (the IP address, the 
subnet mask, and the default gateway).

2.9 Getting Information about the CodeMeter Key

Get information about the CodeMeter Key

1. Insert the CodeMeter key into the computer.

2. In the Configurator, click Panel, and then click Security Key Info.

Config The version of the Configurator that sent the job to the FACP.

Last changed The date and time the FACP was last changed.

Panel Time The date and time on the FACP.

Node The number assigned to each node.

CPU/Address The number for each CPU on the node.

Type The type of CPU, for example a Main CPU, LCD Annuciator, Loop 
Controller, or Audio Controller.

Version The version of the firmware on the CPU.

Language The language that the display uses for messages and menus.

Status The status should be Online.

Config Version 
GUID A number that uniquely identifies the active job on the FACP.
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The Security Key Information window appears.

Figure 14 Security Key Information

2.10 Restarting the Fire Alarm Control Panel

There are two ways to restart the Fire Alarm Control Panel.

• A network restart reboots all the CPUs on the network.
• A hard restart (also called a factory default) reboots the CPUs, and also makes the 

currently active job inactive.

Assigned to ESD The ESD (Electronic Systems Distributor) number assigned to the 
key. Each organization has a unique ESD number, so that one 
organization cannot modify systems that another organization has 
configured.

Training The level of training that your organization has completed. The level 
of training determines what you can do with FleX-Net™.

• Base Systems: You can use the key with a single-node system.

• Multi-node Systems: You can use the key with multi-node 
systems.

• Audio Systems: You can use the key with systems that have an 
audio component.

ESD Expiry Date The date when your key expires. If your key has expired or is about to 
expire, contact Mircom technical support at 1-888-647-2665.

Technician The number assigned to the technician. Each technician in your 
organization has a unique number.

Paid for Licenses 
Unit Count

The number of Web Services licenses and BACnet Services licenses 
that you have. You can use one Web Services license and one 
BACnet Services license with each job.
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2.10.1 Performing a Network Restart of the Fire Alarm Control Panel

You must perform a network restart:

• After you upgrade the firmware.
• As the first step of troubleshooting. If a network restart does not solve the problem, you 

can perform a hard restart. See section 2.10.3 on page 24.

Perform a network restart of the system

1. On the main display of any node or on an annunciator for any node in the system, press 
the MENU button.

2. Scroll down to Network Restart, and press ENTER.

3. Press ENTER to confirm.

The system restarts.

2.10.2 Performing a Network Restart of a Single CPU

Perform a network restart of a single CPU

• Short (close) the reset jumper with a screwdriver for a second.

Every CPU has a reset jumper. Reset jumpers are labeled as follows:

• FX-2000N: JW2

• ANC-5000 Audio Network Controller Board: JW4

• RAXN-LCD Network Remote Annunciator Panel: JW1

• ALCN-792MISO Quad Loop Adder Module: JW1

2.10.3 Performing a Hard Restart of the Fire Alarm Control System

The next troubleshooting step to try after a network restart is a hard restart. A hard restart 
makes the currently active job inactive.

Perform a hard restart

1. Determine which components in your system have CPUs.

The following components have CPUs:

• Main panels, for instance FX-2000N series panels

• Audio controllers, for instance ANC-5000

• Remote annunciators, for instance RAXN-LCD

• Loop adders, for instance ALCN-792MISO Quad Loop Adder

Attention: Performing a hard restart inactivates the active job.!
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See Figures 15 and 16 for pictures of a CPU.

Figure 15 FX-2003-12NDS board showing the CPU

Figure 16 Close-up of a CPU

2. Set DIP switch 8 to ON (the up position) on all the components that have CPUs.

3. On the main display of any node or on an annunciator for any node in the system, press 
the MENU button.

4. Scroll down to Network Restart, and press ENTER.

5. Press ENTER to confirm.

After the FACP restarts, it should display Configuration data wiped.

6. Set DIP switch 8 back to OFF (the down position) on all the components that have 
CPUs.

2.11 Watchdog Jumpers

The watchdog jumper controls the watchdog timer, which restarts the CPU if there is a 
malfunction. Every CPU has a watchdog jumper. For proper operation of the CPU, the 

Attention: Remember to set DIP switch 8 back to OFF after a hard restart.

CPU

!
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watchdog jumper must be closed. If you are experiencing problems, for example if the system 
does not restart properly, make sure that the watchdog jumper is closed.

Watchdog jumpers are labeled as follows:

• FX-2000N series panels: JW4
• ANC-5000 Audio Network Controller Board: JW5
• RAXN-LCD Network Remote Annunciator Panel: JW2

• ALCN-792MISO Quad Loop Adder Module: JW2

2.12 Synchronize Sounder Base Addresses

When an addressable sounder base is added to the job in the Configurator, it is assigned an 
address based on the address of the AP sensor it is connected to (see section 19.12 on 
page 159). However, the physical sounder base has a default address which might not match 
the configured address. This mismatch generates a “mismatched address” or “unconfigured 
device” error on the panel. This error will usually occur on new installations, or in situations 
where the sounder bases have been replaced.

The menu item Pairing Sound B synchronizes the internal address of the sounder base with 
the address of the AP sensor it is connected to. This command applies only to the node it is 
sent from.

Synchronize sounder base addresses

1. On the main display or on an annunciator, press the MENU button.

2. Scroll down to Pairing Sound B, and press ENTER.

3. Enter your passcode if required.

4. Press ENTER to confirm.

The sounder base addresses are synchronized.

5. Repeat these steps for every node that has sound bases connected to it.

After all sounder bases on the network are synchronized, all troubles related to sounder base 
addresses should be cleared.

2.13 Print Active Events

You can quickly print a list of the active events to a printer connected to the panel, or to your 
laptop computer.

Note: A sounder base with no AP sensor mounted on it will reset its address to 0 
following this procedure. Install the missing AP sensor and perform this 
procedure again.

Note: To print a report to a printer or to a laptop (using Tera Term or HyperTerminal), the 
printer output must be enabled via the Configurator.

i

i
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Print the active events

1. On the main display of any node or on an annunciator for any node in the system, press 
the ENTER button.

2. Press ENTER again to print the active events to a printer or a laptop connected to the 
printer port.

2.14 Connect a Virtual Terminal Program

A virtual terminal program such as Tera Term or HyperTerminal lets you see the alarm and 
event reports, the system diagnostic reports, and the events in real time.

This section shows how to install and use Tera Term as a virtual terminal.

You need:

• Microsoft Windows 7 or 10

• Tera Term software application (available at the following link:)
• Mircom’s MGC-CONFIG-KIT4

Connect the computer to FleX-Net™

• Connect the computer to the RS-232 P9 connector on the main FleX-Net™ board. Refer 
to LT-6230, the MGC-CONFIG-KIT4 instructions for details.

Figure 17 Connect the computer to the RS-232 P9 connector on the main FleX-
Net™ board

Install Tera Term

1. Double-click the Tera Term installer.

2. Follow the instruction on the screen to install the software.

3. After the installation is complete, start the Tera Term application.

Computer UIMA4 interface Serial cableUSB A to B male cable P9 on main board

USB connector 9 pin serial connector
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The New connection window appears.

Figure 18 Tera Term New connection

4. Select Serial.

5. In the Port menu, select the COM port that the serial cable is using.

6. Click OK.

7. Click Setup, and then click Serial port.

The Serial Port Setup window appears.

Figure 19 Tera Term Serial port setup

8. Select the correct COM port.

9. Select 9600 as the Speed.

10. Click OK.
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Print the real time log

1. Click File and then click Log.

The Tera Term Log window appears.

Figure 20 Tera Term Log

2. Select Timestamp.

3. Select the location where you want the file to be stored, then click Save.

4. After you have printed the historical event logs you must end the log. When ending the 
log file, verify where the files are located, then click Pause and Close.

Figure 21 Close Tera Term Log

Print the historical alarm log or event log

1. On the main display or remote annunciator, access the Menu and select Reports.

2. Select Event log (or the desired report), then select Printer.
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The panel prints all historical events to the virtual terminal program. An example is shown 
in Figure 22.

Figure 22 Example event log printout
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3.0 Upgrading Firmware

To upgrade the firmware on a Fire Alarm Control Panel, you need the following items:

• Windows 7 or 10 computer with a USB port

• UIMA4 cable
• Registered CodeMeter key
• The latest version of the MGC Fire Detection and Mass Notification Configurator

• A copy of the latest firmware

3.1 Installing the Configurator

To broadcast firmware across the FleX-Net™ system, you need the Configurator that matches 
the firmware of the system. For example, if the system has V12.1.43 firmware, but needs to be 
updated to V12.2.XX, you will need the V12.1.43 Configurator.

1. Download the Configurator from the Mircom website.

2. Double-click the file that you downloaded.

3. Follow the instructions to install the software.

After the installation is complete, the User Preferences window appears.

4. Fill out the appropriate sections, then click OK.

Figure 23 User Preferences

3.2 Importing the Job File

You must import the job that matches the hardware in the system. You can 

Importing a database from your computer is similar to importing a job. A job is a file that 
describes one hardware setup, while a database is a library of jobs.

To import a database, select File > Restore Database, then browse your computer.

To import a single job, select Job > Import Job, then browse your computer.

Note: This chapter describes how to upgrade all the CPUs on the network by using the 
Configurator to broadcast the upgrade across the whole FleX-Net™ system. If 
you want to upgrade or downgrade the firmware on a single CPU, use the 
MGC-CONFIG-KIT4 connection kit and the FleX-Net™ MP Upgrade Wizard. The 
FleX-Net™ MP Upgrade Wizard is available at:
https://mircom.com/technical-support/documents-firmware-software-downloads/
The manual for the wizard is LT-6232, available on http://www.mircom.com

i
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3.3 Connecting to the System

Now that you have the appropriate Configurator, as well as the matching job file, you can 
connect to the panel to update the firmware.

Connect to the system

1. Insert your CodeMeter key into the computer.

2. Connect the USB cable to the UIMA4 cable.

3. Connect the 10-pin head of the UIMA4 cable to the last CPU in the CPU chain that starts 
from the main board.

Figure 24 Connect to P3 on FX-2000N Series Panels

Figure 25 Connect to P3 on ALCN-792MISO Loop Controller

Figure 26 Connect to P10 on ANC-5000

Note: The port is P3 on the FleX-Net™ main board and ALCN-792MISO, P4 on 
ALC-386S, and P10 on ANC-5000.i

Computer UIMA4 interfaceUSB A to B male cable

USB connector 10 pin connector

P3 on main board

P3

Computer USB A to B male cable UIMA4 interface P3 on ALCN-792MISO

USB connector 10 pin connector

+    -    +    - S S +    -    +    - ALARM OUT

B
A A

B
COM (-)

P3

Computer UIMA4 interfaceUSB A to B male cable P10 on ANC-5000

USB connector 10 pin connector
P10
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3.4 Upgrading Firmware

Upgrade the firmware on a system

1. Start the Configurator.

The Configurator prompts you for your PIN.

2. Type your four digit PIN.

Figure 27 Security Key Logon

3. In the Configurator, click Panel > Connect.
4. Click Panel > Upgrade Firmware.
5. Navigate to the location where the firmware file is stored, and then click Open.

The Upgrade Firmware on Panel window appears.

Figure 28 Upgrade Firmware on Panel

a. If you want to upgrade the firmware on all the CPUs, click Upgrade.

b. If you want to upgrade the firmware on only some of the CPUs, select Selected 
CPUs Only, and then hold down the Ctrl key and select the CPUs you want to 
upgrade. Then click Upgrade.

Note: To upgrade the firmware on the FACP, you must use the same ESD number as 
the organization that configured the panel, unless it is a new blank panel.i
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A window appears warning you that this procedure will erase the configuration on the 
panel.

Figure 29 Firmware upgrade warning

6. Click Yes to continue with the upgrade.

The Configurator uploads the firmware to the CPUs. This process can take up to 10 
minutes for each type of CPU. For example, if the system has one main board and two 
annunciators, it has two types of CPU, and the process will take approximately 20 
minutes.

When the upgrade is complete, the Panel firmware upgraded successfully window 
appears.

Figure 30 Panel firmware upgraded successfully

7. Click OK.

8. Follow the instructions in section 2.10.1 on page 24 to restart the system.

9. After the system has restarted, get the advanced panel information to confirm that the 
system has the latest firmware. See section 2.8 on page 21.

Each CPU displays the firmware version that it is running, as well as the configuration that it 
has stored. Make sure all these values are consistent throughout the system.

Lastly, after upgrading an existing system, the following procedures are recommended:

• Where applicable, after the system update, test all system operations which may be 
affected.

• Review the system configuration after the update to ensure that no unintended changes 
or modifications have occurred.

• Plan the update and retesting according to all applicable national and local 
requirements.
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4.0 AP Reports
AP (advanced protocol) reports are a new type of report that you can access from the main 
menu of the FleX-Net™ display. You can print reports or display them on Tera Term. The 
reports show only addresses that are configured.

Refer to LT-893 FleX-Net™ User Guide on www.mircom.com for instructions on how to see 
the reports.

4.1 AP Device Type

This report prints the type and OEM value (manufacturer ID) that the panel retrieves from the 
device. Use this report to make sure that the configured device description matches the actual 
data that is retrieved from the device. Replace the device if it is not the correct type.

In the report, the configured device description is indicated as a text string, for example 
Unsupv Output Module. The Type and OEM values are retrieved from the actual device and 
appear as numbers following the device description. The complete lists of possible values for 
Type and OEM are shown in tables 1 and 2 below.

The device description should match the Type if the job is configured correctly.

Figure 31 AP Device Type report

Table 1 OEM Values

Name Value

Mircom 3

Secutron 11

System Sensor 51

Table 2 Type Values

Name Value

Ion 10

Heat Photo 33

Photo 23

Heat 135 54

Heat ROR 56

Heat 190 55
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In Figure 31, the device at address S150 has the description Photo Detector. This matches 
the data retrieved from the actual device: the Type is 23 (Photo). This device is OEM value 11 
(Secutron).

The device at address M101 has the description Unsupervised Output Module (a relay 
module). However, the data retrieved from the device shows that the Type is 163 (Control), 
which is a supervised module. If the device really was an unsupervised output module, the 
Type would 164 (Relay).

The device at address M101 is OEM value 3 (Mircom).

4.2 AP Device Data

Generate this report when requested by technical support.

Figure 32 AP Device Data report

Acclimate 34

Fire-CO 35

Zone Monitor 162

Dual Mini Monitor 165

Mini Monitor 161

Monitor 160

Control 163

Relay 164

Sound Base (Canada, no hush switch) 170

Sound Base (US, with hush switch) 171

Sound Base Low Freq. 173

Dual Monitor 168

Ten Monitor 139

Six Relay 137

Table 2 Type Values (Continued)

Name Value
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The numbers are the analog values retrieved from sub-addresses in the device. For most 
devices, the usual value for the first sub-address is 50, which indicates that the device is in a 
normal state.

4.3 AP Group Param

Use this report to check the output group configuration (see section 19.48 on page 196). The 
report prints the output group numbers for every device. A device can be in four output groups. 
The value 0 does not indicate any particular output group.

Figure 33 AP Group Param report

In Figure 33, the photo detector is correlated to a relay base and the relay base is part of 
output group 1. This device is in only 1 output group (the remaining 3 output groups are 0).

The unsupervised output module is part of output group 2. This device is in only 1 output 
group (the remaining 3 output groups are 0).

4.4 AP Param List
Generate this report when requested by technical support.

This report prints the complete list of the internal non-volatile parameters of the devices. It 
contains the device type, OEM value, output groups, and other useful information.

Figure 34 AP Param List report

Figure 34 shows the printed report from an SLC with two configured devices.

The second and third numbers after the device’s description are the OEM value and the Type 
(as described in tables 1 and 2). The device with the Photo Detector description is Type 023 
(Photo) and OEM value 011 (Secutron).

The second device is described as a Unsupv Output Module (relay). However the actual 
device is shown as Type 163 (Control). If the device really was an unsupervised output 
module, the Type would 164 (Relay). The OEM value is 003 (Mircom).
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4.5 Multi-Addresses

This option reports devices that have the same serial number or the same address as set by 
the switches on the device.

The system uses one of two methods to scan devices. If you select “yes” on the Digital 
Method? menu, the system scans for duplicate serial numbers. If you select “no”, the system 
scans for duplicate addresses as set by the switches on the device

Figure 35 Multi-Addresses - duplicate serial number

In Figure 35, the system is scanning for duplicate serial numbers. The system prints *** 
Multiple dev address beside two devices with the same serial number. The duplicate serial 
number is 4B7D534F. The addresses of the two devices are S138 and S141.

Figure 36 Multi-Addresses - duplicate address

In Figure 36, the system is scanning for duplicate addresses. The system prints *** Multiple 
dev address beside the address that is duplicated. The duplicate address is S016. (The serial 
number is printed as 0000003 because the devices with the same address have different 
serial numbers and the system cannot show both of them.)
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5.1 FleX-Net™ System Limits

Unless otherwise noted, these limits apply to software and firmware version 12.2.33.

Table 3 FleX-Net™ System Limits

Device Maximum number

Nodes 63 per system

CPUs

15 per node: 1 on the main board + 7 local per node (quad 
loop adders and 1 audio controller) + 7 remote per node 
(annunciators)

128 CPUs in total per system

Note: The Configurator treats LED annunciators as having 
CPUs.

Remote Annunciators

7 LCD annunciators per node or 4 LED annunciators per node

A maximum of 7 annunciators in total per node

50 annunciators per system

Quad Loop Adders 7 per node

Built-in Conventional Loops
2 per node

128 per system

Addressable Loops 29 per node (7 quad loop adders with 4 loops each + 1 built-in 
loop)

Addressable Sensors 159 per loop

Addressable Input/Output Modules 159 per loop

Audio Controllers 1 per node

Amplifiers

3 adder bins per node: maximum number of amplifiers: 25

25 60-Watt amplifiers per node

or

50 30-Watt amplifiers per node

or

100 15-Watt amplifiers per node

Zone Switches 250 per system

Page Select Switches 504 per system

Telephone Select Switches 504 per system

Inputs correlated to Remote Zones 1800 per CPU

Remote Output Zones 1800 per CPU

UDACTs 1 per system
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5.2 Frames

The frame is a measure of display capacity. The LCD annunciators and the main displays 
provide frames, and the display boards (display adders) consume frames. The total number of 
frames used by all the display boards connected to an annunciator must not exceed the 
number of frames provided by that annunciator.

For example, the main display has 12 available frames, and the FDX-008WKI smoke control 
fan damper module uses 1 frame. You can connect 12 FDX-008WKIs to a main display if you 
connect no other display boards. The RAX-1048TZDS programmable zone/trouble LED uses 
3 frames, so you can connect 4 RAX-1048TZDSs to a main display. Or you can connect a 
combination of both, for instance 2 RAX-1048TZDSs (6 frames) and 6 FDX-008WKIs (6 
frames).

Custom Audio Clips 96 per system

Entries in one audio message (audio clips 
and repeat loops together) 32 per system

Custom Digital Messages 96 per system

Custom Intervals 60 per system

Custom Timers 30 per system

Output Circuits 640 per CPU

Input Zones 999 per CPU

Proving Correlations 400 per system

Manual Controls 512 per system

Equations in Input Zones 880 per CPU

Size of a Single Equation 4096 characters

Terms in an Equation 4000 per CPU

Characters in all Equation Comments 65536 per CPU

Node Groups 254 per system

Devices in an Output Group 159 per loop

Output Groups 254 per CPU

Event Log Capacity 5000

Maximum size of audio files (in total) 3 MB

Table 3 FleX-Net™ System Limits (Continued)

Device Maximum number
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Table 4 lists the number of frames used and provided by each device.

Table 4 Frame Count

Name Description Name in the 
Configurator

Frames Used Frames Available

DSPL-420 Narrow Main 
Display (4 lines by 
20 characters)

Main Display 2 12

DSPL-2440 Narrow Graphic 
Display Main Display 2 12

RAXN-LCD Remote Shared 
Display 
Annunciator

LCD Annunciator 1 39 (13 on each 
header)

RAXN-LCDG Remote Shared 
Graphical Display 
Annunciator (24 
lines)

LCD Annunciator 1 39 (13 on each 
header)

RAM-1032TZDS Remote 
Annunciator with 32 
trouble LEDs

LED Annunciator 2
You can add up to 4 
RAX-1048TZDSs 
to this device

IPS-2424DS Programmable 
Input Switches 
Module

24 Sw Adder 2 N/A

IPS-4848DS Programmable 
Input Switches 
Module

2 x 24 Sw Adder 4 N/A

RAX-1048TZDS Adder Annunciator 
with 48 bi-coloured 
LEDs and 32 
trouble LEDs

48 LED Adder 3 N/A

FDX-008W(KI) Smoke Control Fan 
Damper Module HOA Sw Adder 1 N/A

AGD-048 Adder Graphic 
Module with 48 
supervised outputs

Graphic Adder 1 N/A

MGD-32 Master Graphic 
Driver Module with 
32 supervised 
outputs

N/A 0 N/A

QAZT-5302DS Addressable 
Telephone and 
Paging Selector 
Panel

Telephone/Page 
Selector 2 N/A

QAZT-5348DS Addressable 
Telephone and 
Paging Selector 
Panel

2 x Telephone/Page 
Selector 4 N/A
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QMP-5101N(V) Network Paging 
Control Unit Master Paging 1 N/A

QMT-5302N(V) Network Telephone 
Control Unit Master Telephone 1 N/A

Table 4 Frame Count (Continued)

Name Description Name in the 
Configurator

Frames Used Frames Available
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6.0 Testing UUKL Devices
The goal of UUKL is to prevent smoke from entering other floors or zones by pressurizing 
them to evacuate the smoke from the smoked zone.

This chapter describes how to create an interval for testing UUKL devices.

6.1 Configuring a UUKL Smoke Control Test Interval

1. Create an interval for your testing time and cycle. Figure 37 shows an interval called 
UUKL Test from 11:09 am to 11:12 am every Tuesday. See section 8.2 on page 49 for 
more information.

Figure 37 Interval for UUKL testing

2. Select the input zone for the UUKL devices.

3. Click the Advanced Logic tab at the bottom, and then click Edit.

The Advanced Logic Editor appears.

4. In the Advanced Logic Editor, select the interval that you just created, and then click the 
> button to move the interval to the Equation box.

The equation should look like this:

**-**-**-IT-010

Attention: You should be familiar with advanced logic before following the 
instructions in this chapter. See chapter 6 on page 44.!
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Figure 38 Advanced logic equation for UUKL test interval

5. Click OK.
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7.0 Walk Test
The walk test allows an operator to test the system or part of the system. While the system is 
in walk test mode, devices can be tested without causing a real alarm situation.

Refer to LT-893 FleX-Net™ User Guide on www.mircom.com for instructions on how to 
perform the walk test.

7.1 Configuring Walk Test Areas

Walk test areas are areas containing devices to be tested. Walk test areas let you test devices 
in one area while leaving the other areas active. You create walk test areas in the 
Configurator. In order to use the assisted walk test, the system must have walk test areas 
configured.

Create a walk test area

1. In the Configurator, select Walk Test Areas in the Job Tree.

2. Right-click in the Details pane and select Add WalkTest Area.

Figure 39 Add WalkTest Area

3. Enter a name for the walk test area, for instance 1st Floor, and then click Add.

The walk test area appears in the Details pane.

Figure 40 New walk test area
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4. Right-click the walk test area, and then select Add Input Devices.

Figure 41 Add Input Devices

The Select items to add window appears.

Figure 42 Select items to add

5. Select the input devices that you want to add to this walk test area, and then click Add.

6. Click Close.

7. Repeat these steps for each walk test area.

7.2 Configuring the Walk Test Switch

You can configure a switch as a walk test switch. Press the walk test switch to access the walk 
test menu.

Configure the Walk Test Switch

• In the Display Adder view of the Main Display or 24 Sw Adder, set a switch to the Type 
Common Ctrl and the Assignment Walk Test Sw.

Figure 43 Walk test switch
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8.0 Custom Timers and Intervals
This chapter describes how to create custom timers and intervals with the Configurator. 
Timers and intervals let you control when and for how long a certain operation takes place.

For example, you can use a timer to delay a vent fan until the damper has had time to open, or 
to delay the activation of compressors so that they do not all activate at once and overload the 
system.

You can use an interval to change the language of announcements at certain times of day, or 
to turn on a dedicated air handling system once a week for testing.

All timers are initially un-assigned. To enable a timer, edit the Enable column to make it Y.

8.1 Custom Timers

You can create a timer to delay activation of an output, limit the time an output is active, or 
cause a delayed activation of additional outputs. You do this with the Custom Timers section 
of the Configurator, and with advanced logic.

To make a custom timer you must:

• Create the timer.

• Create a trigger to start the timer using advanced logic.
• Use the timer in an advanced logic equation to activate a zone.
• Correlate the zone with the output.

Follow the instructions below to complete these steps.

8.1.1 Creating a custom timer

Create a custom timer

1. Select Custom Timers in the job tree on the left side of the Configurator window.

The list of custom timers appears on the right.

2. In the row for the next unassigned timer, double-click in the Enable column, and then 
click Y in the pulldown menu.

3. Double-click in the Duration column, and then type the duration of the timer in seconds.

4. Double-click in the Tag column, and then type a name for the timer.

The Configurator gives each timer a number starting from 16.

Note: As per UL 864 and UL 2572 only a setting of un-assigned is permissible.i
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8.1.2 Create a trigger for the timer

Correlate the timer with an input

1. Select the timer that you just created.

2. Click Edit in the Advanced Logic window at the bottom of the Configurator window.

The Advanced Logic Editor appears.

3. Create an Advanced Logic Equation to start the timer (see Chapter 6.0 on page 44).

Note that you cannot use any input devices or circuits in this equation because only local 
(on the same node) devices or circuits are available in Advanced Logic and the timer is 
not local to any node. Input Zones and all other Advanced Logic Inputs can be used.

4. Type a description for the timer in the Description field.

5. Click OK.

The timer will start when the input activates.

8.1.3 Use the timer in Advanced Logic

Correlate a zone with the timer

1. Select Input Zones (under Base I/O or Quad Loop Adder, under the NODE where you 
want the zone that will be controlled by the timer) in the job tree on the left side of the 
Configurator window.

2. Click the Insert menu, and then click Add Zone.

The Add Devices window appears.

3. Click Add to add the zone, and then click Close.

4. Double-click in the Tag column, and then type a name for the zone. Press the Enter key.

5. Select the zone that you just created.

6. Click the Advanced Logic tab at the bottom, and then click Edit.

The Advanced Logic Editor appears.

7. Double-click the timer you created from the Inputs list on the left.

You can identify the timer by the Tag that you gave it. The ID for the timer is something 
like **-**-**-TM-016, where TM means “timer” and 016 is the number of the timer. The 
Configurator gives each timer a number starting from 16.

The timer you created appears in the Equation box.

8. Click the EQU button.

The EQU operator appears in the Equation box.

9. Select a Sys_Def to determine how the timer will be used.

To cause a delayed activation

Click the pulldown menu, click TIMER_EXPIRED, and then click the Sys_Def button.

This equation should look something like this:

**-**-**-TM-016 EQU TIMER_EXPIRED

When the timer expires, the equation becomes true and the zone activates.
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To limit the time the output is active

If you want the zone to activate while the timer is running:

• Click TIMER_RUNNING instead of TIMER_EXPIRED. The zone will remain active 
while the timer is running. When the timer expires, the zone will become inactive.

10. Type a description in the Description box, and then type a comment in the Comments 
box.

11. Click OK to close the Advanced Logic Editor.

8.1.4 Correlating the zone with an output

Correlate the zone with an output

1. Right-click the zone, then click Add Correlations.

2. Add an output, and then click Close.

You have successfully created a timer. The equation you specified in step 8.1.2 starts the 
timer. The zone you created in step 8.1.3 becomes active when the equation becomes true 
(when the timer expires or while it is active, depending on your choice in step 9). The output 
you specified in step 8.1.4 activates when the zone becomes active.

If the equation you created in step 8.1.2 involves elements that might trigger other zones that 
are correlated with outputs (for example, the activation of an Input Zone that has its own 
correlations or activation in a situation where the Common Alarm Status is active) then the 
timer will server as an additional annunciation (activating new outputs while the previously 
activated ones continue to operate). If the timer’s triggers are exclusive to it then it will server 
as either a delay or a limit on all of the annunciation.

8.2 Custom Intervals

An interval is a period of time during the day. Intervals have a start time, an end time, and an 
optional day of the week. If the day of the week is not specified, then the interval applies every 
day.

Follow the instructions below to make an equation that tells a zone to become active when the 
current time is not within a certain interval.

Create a custom interval

1. Create a trouble zone, and then tag this zone Trouble Zone 1.

2. Select Custom Intervals in the job tree.

3. Click the Insert menu, and then click Add Interval.

The interval appears in the right pane. Intervals are numbered starting from 10.

4. Double-click in each column and select a value in the pulldown menus. You must give 
the interval the following values. Define the end time first, then the start time.

Start Hour The hour that the interval starts, on the 24 hour clock.

Start Minutes The minute that the interval starts.

End Hour The hour that the interval ends, on the 24 hour clock.

End Minutes The minute that the interval ends.
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5. Select Trouble Zone 1.

6. Click the Advanced Logic tab at the bottom, and then click Edit.

The Advanced Logic Editor appears.

7. Click the NOT button.

8. Select the interval you created, and then click the > button to move the interval to the 
Equation box.

9. Click the EQU button.

10. Click the pulldown menu, click INTVL_ACTIVE, and then click the Sys_Def button.

The equation should look like this:

NOT **-**-**-IT-010 EQU INTVL_ACTIVE

11. Type a description in the Description box, and then type a comment in the Comments 
box.

12. Click OK to close the Advanced Logic Editor.

13. Right-click the zone, then click Add Correlations.

14. Add an output, and then click Close.

Trouble Zone 1 will become active when the current time is not within the interval.

If you want the zone to become active when the current time is within the interval, omit 
NOT from the equation.

DoW Day of the week. This is optional. If you leave it blank, then the 
interval applies every day.

Tag A descriptive name for the interval.
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9.0 Zone Latching
“Latching” and “non-latching” refer to the behavior of an input. When a non-latching input 
initiates an alarm, the alarm stays active until the input goes back to normal status. In contrast, 
when a latching input initiates an alarm, the alarm stays active until the system is reset.

With advanced logic, you can latch normally non-latching zones such as monitor, trouble, and 
non-latching supervisory zones. A latched zone maintains outputs or timers even if the original 
input is no longer active.

For example, you can use zone latching to delay a strobe for a period of time after a page has 
occurred. The page active status is the input that initially activates the zone. This zone is 
correlated to the output strobes that become active when the zone becomes active. You make 
the zone into a latching zone with advanced logic, so that the zone remains active even after 
the page active status has become inactive.

9.1 Zone Latching Sequence

The order of events in a zone latching sequence is as follows:

1. A switch or input becomes active.

2. This activates the latching zone, which activates the output.

3. The zone remains active until the system is reset, so that the output also remains active.

The equation for the latching zone must have more than one input, separated by OR. One of 
the inputs must be the latching zone itself.

For example, the following equation for the zone 01-00-**-IZ-011 tells the zone to become 
active either by the input 01-00-00-IN-007, or by itself. As a result, the zone initiates itself.

01-00-00-IN-007:A OR 01-00-**-IZ-011

01-00-00-IN-007 – Initiating device
01-00-**-IZ-011 – Zone

When the initiating device becomes active, the latching zone becomes active, because the 
advanced logic equation is true. If the initiating device becomes inactive or is restored, the 
latching zone remains active, because the equation is still true. Therefore, the zone is latched. 
In order to unlatch the zone, you must reset the system. This is similar to a normally latching 
zone such as an alarm zone.

Note: The zone is referenced in its own advanced logic equation. This allows the zone 
to latch itself.i
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9.2 Creating a Zone Latching Sequence

Create a zone latching sequence

1. Create an initiating device. This can be a monitor zone, input circuit, or a status such as 
All Call.

2. Create a non-latching zone such as a monitor zone. This will become a latching zone.

3. Select this zone, and click the Advanced Logic tab.

4. Create an equation that will activate the zone by the initiating zone, input, or status OR 
by the zone itself.

For example, this equation is in the monitor zone 01-00-**-IZ-011:

**-**-**-SW-017 OR 01-00-**-IZ-01

**-**-**-SW-017 – All Call common switch
01-00-**-IZ-011 – monitor zone

The zone 01-00-**-IZ-011 will become active when the All Call switch becomes active. If 
the All Call becomes inactive, the zone will remain active until the system is reset.

9.3 Creating a Latching Zone with a Timer

You can set the zone to unlatch when a timer expires. For example, this equation is for the 
zone 01-00-**-IZ-011:

01-00-00-IN-007:A OR (01-00-**-IZ-011 AND NOT **-**-**-TM-021 EQU TIMER_EXPIRED)

01-00-00-IN-007 – Initiating device
01-00-**-IZ-011 – Zone
**-**-**-TM-021 - Timer 21

The sequence of events is as follows:

1. The initiating device 01-00-00-IN-007 goes into alarm.

2. The equation is now true, and the zone 01-00-**-IZ-011 becomes active.

3. Another initiating device starts Timer 21.

4. The initiating device 01-00-00-IN-007 goes back to normal status, but the equation is still 
true because Timer 21 is not expired, so the zone remains active.

5. When Timer 21 expires, the equation is no longer true, and the zone becomes inactive.
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10.0 Relay Pulsing
Relay pulsing refers to a configuration where a relay turns on (closes) and then turns off 
(opens) after a single switch press. An example of relay pulsing is the activation of a pre-
recorded digital message with the first switch press, and then the deactivation of the message 
with the second switch press, simulating a maintained switch.

10.1 Relay Pulsing Sequence

The order of events in an example relay pulsing sequence is as follows:

1. A switch or input becomes active.

2. This activates the monitor zone Input Switch.

3. This activates the zone Latch A, which will remain latched until Latch B Timer starts 
(see chapter 9).

4. Latch A activates Latch A Timer, which is linked to the output relay by advanced logic.

5. Latch A Timer activates the output relay while Latch A Timer is running. The timer is 
usually set for a short period of time, such as 3 seconds, in order to simulate a pulse. 
This is the first pulse.

6. Latch A Timer expires, which deactivates the output relay.

7. The switch is pressed again, or the input becomes inactive.

8. This activates the zone Latch B, which will remain latched until the switch is pressed 
again or the input becomes active.

9. Latch B starts Latch B Timer, which is linked to the output relay by advanced logic.

10. Latch B Timer activates the output relay while it is running. The timer is usually set for a 
short period of time, such as 3 seconds, in order to simulate a pulse. This is the second 
pulse.

11. Latch B Timer expires, which deactivates the output relay.

10.2 Creating a Relay Pulsing Sequence

Follow this procedure to create the relay pulsing sequence described above.

Create a relay pulsing sequence

1. Create a monitor input zone. Tag the zone Input Switch.

2. Select the zone Input Switch, click the Advanced Logic tab, and then click Edit.

3. In the Advanced Logic Editor, create an equation that contains only the input or switch 
that will start the pulse.

4. Create two timers. Specify a time in seconds, for example 3 seconds. Tag them Latch A 
Timer and Latch B Timer.

5. Create another monitor input zone. Tag this zone Latch A.

6. Select the zone Latch A, click the Advanced Logic tab, and then click Edit.

7. Create the following equation:

01-00-**-IZ-007 OR (01-00-**-IZ-011 AND NOT **-**-**-TM-021 EQU 
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TIMER_EXPIRED)

01-00-**-IZ-007 – Input Switch zone
01-00-**-IZ-011 – Latch A zone
**-**-**-TM-021 – Latch B Timer

Latch B Timer is included in the equation so that Latch A will unlatch (become inactive) during 
the second pulse (when Latch B Timer starts).

8. Create another monitor input zone. Tag this zone Latch B.

9. Select the zone, click the Advanced Logic tab, and then click Edit.

10. Create the following equation:

**-**-**-TM-020 EQU TIMER_EXPIRED AND (NOT 01-00-**-IZ-007 OR 
01-00-**-IZ-012)

**-**-**-TM-020 – Latch A Timer
01-00-**-IZ-007 – Input Switch zone
01-00-**-IZ-012 – Latch B zone

This equation becomes true when the switch is pressed for the second time or the input 
becomes inactive. Latch B will remain latched until the switch becomes active or the input 
becomes active.

11. Select Latch A Timer in the Custom Timers section on the left side of the Configurator 
window.

12. Click Edit under Advanced Logic.

13. Add the Latch A zone to the equation.

When the Latch A zone becomes active, this timer will start.

14. Select Latch B Timer.

15. Click Edit under Advanced Logic.

16. Add the Latch B zone to the equation.

When the Latch B zone becomes active, this timer will start.

17. Select the output relay, click the Advanced Logic tab, and then click Edit.

18. Create an equation that will be true if either Latch A Timer or Latch B Timer is running:

**-**-**-TM-020 EQU TIMER_RUNNING OR **-**-**-TM-021 EQU TIMER_RUNNING

**-**-**-TM-020 – Latch A Timer
**-**-**-TM-021 – Latch B Timer

You have successfully created a relay pulsing sequence.

Attention: We recommend that you do not apply an equation directly to an output, 
except in special cases.!
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10.3 Relay Pulsing with Multiple Switches

If you want to use multiple switches, you can add an equation to the monitor zone to reduce 
interference between switches. Refer to the example below:

01-00-00-IN-008 AND NOT ANY 1 OF ( 01-00-**-IZ-008 , 01-00-**-IZ-009 , 
01-00-**-IZ-010 )

01-00-00-IN-008 – Input circuit 1
01-00-**-IZ-008 – Input Switch 2
01-00-**-IZ-009 – Input Switch 3
01-00-**-IZ-010 – Input Switch 4

This equation is optional. However, it will reduce interference between switches. For example, 
if the first switch is pressed, and then Input Switch 2 is pressed, issues could arise if both 
switches are turning digital messages on or off. This is because the first message would be 
overridden.
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11.0 Hardware Layouts

The FleX-Net™ Fire Alarm Control System contains two major types of nodes: Fire Nodes and 
Mass Notification Nodes. The entire system is modular and any number of combinations are 
possible when building a system.

The Fire Nodes use the BBX-1024DS(R), the BBX-1072A(R)DS, the BB-5008, and the 
BB-5014 model backboxes.

The Mass Notification Node uses the BBX-FXMNS model backbox.

The system can also include Audio-Signaling Enclosure Cabinets that can connect to either 
node and use the BBX-MSNXP backbox. Local Operating Consoles use the FX-LOC backbox 
and are used with Mass Notification Nodes.

11.1 Hardware Nomenclature

For a chassis:

• The number before the dash indicates the number of modules that the chassis holds. 
For instance, the FX-2003-12NDS can accommodate 3 modules, and the 
FX-2017-12NDS can accommodate 17 modules.

• The number after the dash indicates the output of the transformer. For example, the 
transformer on the FX-2003-12NDS has an output of 12 A.

• The N suffix indicates that the device is part of a networked fire panel.

For an annunciator:

• The number represents the number of LEDs the device has. For example, the 
RAX-1048TZDS has 48 LEDs.

• The TZ suffix indicates that the device has trouble LEDs.

• The DS suffix indicates that the device has a newer kind of switch (a dome switch).

For a backbox:

• For backboxes with the BB prefix, the number indicates the number of annunciators that 
the backbox holds. For example, the BB-1002 holds 2 annunciators.

• The DS suffix indicates that the backbox has a window that accommodates DS displays 
(with dome switches).

• B or R indicates whether the door is black or red. If there is no letter, then the door is 
white or the same colour as the cabinet.

Note: The information in this chapter is for reference only and is subject to change 
without notice. For complete details refer to the respective manual for the product 
in question.

Note: Leave at least ¼ inch (6.35 mm) between the door and any metal parts inside the 
cabinet or chassis.

i

i
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11.2 Chassis
Table 5 Chassis

Name Description Mounts in Number of 
Additional 
Displays or 
Adder Modules

Notes

FX-2003-12NDS

12 Amp 
Compact 
Main Chassis

BBX-1024DS(R) 
consisting of 
UB-1024DS 
universal backbox 
and 
DOX-1024DS(R) 
door

FNC-2000 
Network 
Controller 
Module and 2 
adder modules 
over the main 
board plus 2 
annunciator or 
programmable 
modules

Slot 3 is reserved for PR-300 
(Polarity Reversal/City Tie 
Module) or UDACT-300A 
(Dialer) if required

FNC-2000 (Fire Network 
Controller Module) goes in 
slot 2

FOM-2000-UM (Fiber Optic 
Network Module) is mounted 
over FNC-2000

FX-2003-12NXTDS

12 Amp 
Compact 
Main Chassis 
Extended 
Enclosure

BBX-1024XT(R)

FNC-2000 
Network 
Controller 
Module and 2 
adder modules 
over the main 
board plus 6 
adder boards 
and 2 
annunciator or 
programmable 
modules

FX-2017-12NDS

12 Amp Mid-
size Main 
Chassis

BBX-1072A(R)DS

FNC-2000 
Network 
Controller 
Module and 2 
adder modules 
over the main 
board plus 14 
adder boards 
and 3 
annunciator or 
programmable 
module

Slot 3 is reserved for PR-300 
or UDACT-300A if required

FNC-2000 goes in slot 2

FOM-2000-UM is mounted 
over FNC-2000
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11.3 Display Modules

Each of these display modules occupies one display position and mount to the display cutouts 
on the following chassis:

• FX-2003-12NDS Compact main chassis
• FX-2003-12NXTDS Mid-size main chassis

• FX-2017-12NDS Mid-size main chassis
• FX-2009-12NDS Large main chassis
• ECX-0012 Expander chassis for FX-2009-12NDS

These modules can also be mounted in the standard BB-5000 cutouts (with brackets), as well 
as the BB-1000 enclosures (requires RAXN-LCD as a driver).

FX-2009-12NDS

12 Amp 
Large Main 
Chassis

BB-5008 and 
BB-5014 
(occupies 4 
display positions)

FNC-2000 
Network 
Controller 
Module and 2 
adder modules 
over the main 
board plus 6 
adder boards 
and 3 
annunciator or 
programmable 
modules

Slot 3 is reserved for PR-300 
or UDACT-300A if required

FNC-2000 goes in slot 2

FOM-2000-UM is mounted 
over FNC-2000

FX-2000MNS

Main 
Network 
Board

BBX-FXMNS(R)

The main board 
is mounted on a 
backplate which 
can hold up to 9 
internal adder 
modules

ECX-0012

Expander 
Chassis for 
FX-2009-
12NDS

BB-5008 and 
BB-5014 
(occupies 2 
display positions)

2 displays

12 adder 
modules

12 adder modules or any 2 of 
the following 3 options:

• 6 adder modules

• 1 main board and 3 adder 
modules

• 1 ANC-5000 and 1 
TNC-5000

Table 5 Chassis (Continued)

Name Description Mounts in Number of 
Additional 
Displays or 
Adder Modules

Notes
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11.3.1 Main Displays

11.3.2 Display Adders

Display adders are also called programmable modules, display boards, or display modules. 
They can be installed on the door of any unit that has display adder slots.

Table 6 Main Displays

Name Description Mounts in

DSPL-420

Narrow Main Display (4 
lines by 20 characters)

BBX-1072A(R)DS

BB-5008

BB-5014

BBX-FXMNS

FX-2003-12NDS

FX-2017-12NDS

FX-2009-12NDS

ECX-0012

FX-2000MNS

DSPL-2440

Narrow Graphic Display

BBX-1072A(R)DS

BB-5008

BB-5014

BBX-FXMNS

FX-2003-12NDS

FX-2017-12NDS

FX-2009-12NDS

ECX-0012

FX-2000MNS

Table 7 Display Adders

Name Description Mounts in

IPS-2424DS

Zone Bypass, Adder 
Annunciator (48 Display 
Points)

FX-2003-12NDS

FX-2003-12NXTDS

FX-2017-12NDS

FX-2009-12NDS

ECX-0012

BB-5008

BB-5014

BB-1000 series

BBX-FXMNS



60

Hardware Layouts

11.3.3 Remote Annunciators

Remote annunciators are also called display modules or display adders.

IPS-4848DS

Zone Bypass, Adder 
Annunciator (96 Display 
Points)

FX-2003-12NDS

FX-2003-12NXTDS

FX-2017-12NDS

FX-2009-12NDS

ECX-0012

BB-5008

BB-5014

BB-1000 series

BBX-FXMNS

FDX-008W(KI)

Smoke Control Fan 
Damper Module, 8 
zones

FX-2003-12NDS

FX-2003-12NXTDS

FX-2017-12NDS

FX-2009-12NDS

ECX-0012

BB-5008

BB-5014

BB-1000 series

BBX-FXMNS

Table 8 Remote Annunciators

Name Description Mounts in

RAM-1032TZDS

Remote Annunciator with 16 bi-
coloured LEDs and 32 trouble 
LEDs

FX-2003-12NDS

FX-2003-12NXTDS

FX-2017-12NDS

FX-2009-12NDS

ECX-0012

BB-5008

BB-5014

BB-1000 series

Table 7 Display Adders (Continued)

Name Description Mounts in
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RAX-1048TZDS

Adder Annunciator with 48 bi-
coloured LEDs and 32 trouble 
LEDs

FX-2003-12NDS

FX-2003-12NXTDS

FX-2017-12NDS

FX-2009-12NDS

ECX-0012

BB-5008

BB-5014

BB-1000 series

BBX-FXMNS

RAM-1032TZDS-CC

32-circuit main annunciator 
chassis for outdoor use

BB-1001WP(R)A

BB-1002WP(R)A

RAX-1048TZDS-CC

48-circuit adder annunciator 
chassis for outdoor use BB-1002WP(R)A

RAXN-LCD

Remote Shared Display 
Annunciator

BB-1000 series

BB-5008

BB-5014

BBX-FXMNS

FX-LOC

ECX-0012

RAXN-LCDG

Remote Shared Graphical 
Display Annunciator (24-line 
display)

BB-1000 series

BB-5008

BB-5014

ECX-0012

BBX-FXMNS

Table 8 Remote Annunciators (Continued)

Name Description Mounts in
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11.4 Paging and Fire Fighter Telephone Modules

These modules can be installed on the door or inside any node with paging module slots. The 
specific number and combination of paging and fire fighter telephone modules varies 
depending on the application and requirements of the job.

These devices are also called audio controllers or audio modules. They are the same size as 
display boards, but they contain a telephone or microphone. They can be installed on the door 
or inside any unit that has paging module slots.

RAM-216

Annunciator with 16 bi-coloured 
LEDs

Mounts to a 4 gang electrical 
box.

RAM-208

Annunciator with 8 bi-coloured 
LEDs

Mounts to a 4 gang electrical 
box.

RTI-1

Remote Trouble Indicator (single 
LED and trouble buzzer)

Mounts to a single gang 
electrical box.

MGD-32 Master Graphic Driver Module 
with 32 supervised outputs

BB-5008

BB-5014

AGD-048 Adder Graphic Module with 48 
supervised outputs

BB-5008

BB-5014

Table 9 Paging and Fire Fighter Telephone Modules

Name Description Mounts in

QMP-5101N

Network Paging Control Unit

BB-5008

BB-5014

BB-1000 series

FX-LOC(R)

Table 8 Remote Annunciators (Continued)

Name Description Mounts in
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QMP-5101NV

Network Paging Control Unit 
(Vertical Mount) BBX-FXMNS

QMT-5302N

Network Telephone Control Unit

BB-5008

BB-5014

BB-1000 series

FX-LOC(R)

QMT-5302NV

Network Telephone Control Unit 
(Vertical Mount) BBX-FXMNS

QAZT-5302DS

Addressable Telephone/Paging 
Selector Panel (24 zones)

BB-5008

BB-5014

BB-1000 series

FX-LOC(R)

BBX-FXMNS

QAZT-5348DS

Addressable Telephone/Paging 
Selector Panel (48 zones)

BB-5008

BB-5014

BB-1000 series

FX-LOC(R)

BBX-FXMNS

Table 9 Paging and Fire Fighter Telephone Modules (Continued)

Name Description Mounts in



64

Hardware Layouts

11.5 Adder Modules

These modules can be installed inside any node with adder module slots. The specific number 
and combination of adder modules varies depending on the application and requirements of 
the job.

11.5.1 Network Controller Modules

Table 10 Network Controller Modules

Name Description Mounts in Notes

FNC-2000

Fire Network 
Controller Module

FX-2003-12NDS

FX-2003-12NXTDS

FX-2017-12NDS

FX-2009-12NDS

ECX-0012

FX-2000MNS

1 per node

FOM-2000-UM Single-Mode or Multi-
Mode Fiber Optic 
Network Adder 
Module (use FOM-
CONN-SM single 
mode fiber optic 
module connector or 
FOM-CONN-MM 
multi-mode fiber 
option module 
connector)

FX-2003-12NDS

FX-2009-12NDS

FX-2017-12NDS

ECX-0012

FX-2000MNS

1 per node

ANC-5000

Audio Network 
Controller Module

QMB-5000N

BB-5008 and 
BB-5014, positions 
4 - 9

FX-2009-12NDS

ECX-0012

1 per node

TNC-5000

Telephone Network 
Controller Module

QMB-5000N

BB-5008 and 
BB-5014, positions 
4 - 9

FX-2009-12NDS

ECX-0012

1 per node
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11.5.2 Adder Modules

Adder modules are circuit boards that provided added functionality. They can be installed 
inside any unit that has adder module slots.

Each of these adder modules occupy one module slot and mount inside the following chassis 
unless otherwise specified:

• FX-2003-12NDS Compact main chassis
• FX-2003-12NXTDS Mid-size main chassis

• FX-2009-12NDS Large main chassis
• FX-2017-12NDS Mid-size main chassis
• ECX-0012 Expander chassis for FX-2009-12NDS

• FX-2000MNS

Table 11 Adder Modules

Name Description Notes

ALCN-792MISO Isolated Quad Loop 
Controller Module 7 per node

ALCN-792D Quad Loop Adder 
Daughter Board

7 per node (Mounts on top of 
ALCN-792MISO)

DM-1008A 8 Initiating Circuit 
Module

8 per built-in loop

16 per node

SGM-1004A 4 Notification 
Appliance Circuit 
Module

8 per built-in loop

16 per node

RM-1008A 8 Relay Circuit 
Module

8 per built-in loop

16 per node

UDACT-300A Digital Alarm 
Communicator 
Module

1 per system

PR-300 Polarity Reversal/City 
Tie Module 1 per node
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11.6 Booster Power Supplies

11.7 Backboxes

Backboxes, also called enclosures, are large steel cabinets that hold chassis, displays, and 
adder modules.

11.7.1 BBX-1024DS(R) Fire Node Backbox

The BBX-1024DS(R) is the smallest backbox available. It consists of the UB-1024DS 
universal backbox and DOX-1024DS(R) door. It holds the FX-2003-12NDS Compact Main 
Chassis along with batteries for emergency operation. The FX-2003-12NDS Compact Main 
Chassis contains the main display, mother board, adder modules and the transformer. It fits 
directly into the BBX-1024DS(R) backbox. The outer dimensions of the BBX-1024DS(R) fit 
within 26.3” X 14.8” X 4.6”.

Figure 44 FX-2003-12NDS mounts in the BBX-1024DS(R) enclosure

Table 12 Booster Power Supplies

Name Description Mounts in

INX-10AC

Addressable Booster Power 
Supply

BB-5008

BB-5014

BBX-FXMNS

Main Board

Exterior View Interior View

Slot is reserved for PR-300A. 
If none is required, this slot
can be used to mount any of
the adder modules. 

Supports 3 
Adder Modules.

123



Hardware Layouts

67

11.7.2 BBX-1024XT(R)

Table 13 BBX-1024DS(R)

Name Description Holds Dimensions

BBX-1024DS(R)

Consists of UB-1024DS 
universal backbox and 
DOX-1024DS(R) white 
or red door

FX-2003-12NDS

17 Ah battery pack
26.3” H x 14.8” W x 
4.6” D

Table 14 BBX-1024XT(R)

Name Description Holds Dimensions

BBX-1024XT(R)

Extended chassis FX-2003-12NXTDS 14.76” wide by 35.8” 
long by 5.45”
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11.7.3 BBX-1072A(R)DS Fire Node Backbox

The BBX-1072A(R)DS backbox is larger than the BBX-1024DS(R). It contains the FX-2017-
12NDS Mid-Size Main Chassis along with the batteries for emergency operation. The FX-
2017-12NDS Mid-Size Main Chassis contains the main display, mother board, adder modules 
and the transformer. It fits directly into the BBX-1072A(R)DS backbox. The outer dimensions 
of the BBX-1072A(R)DS fit within 33.9” X 26.4” X 6.5”.

Figure 45 FX-2017-12NDS mounts in the BBX-1072A(R)DS Backbox

Table 15 BBX-1072A(R)DS

Name Description Holds Dimensions

BBX-1072A(R)DS

Black backbox, white or 
red door

FX-2017-12NDS

DSPL-420

DSPL-2440

24 Ah battery pack

33.9” H x 26.4” W x 
6.5” D

Cutout to mount
display module

Cutout to mount
display module

Cutout to mount
display module

Slot is reserved for PR-300A.  If none is required, this slot
can be used to mount any of the adder modules.

.seludoM reddA 71 stroppuS.seludoM yalpsiD 3 stroppuS

weiV roiretnIweiV roiretxE
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11.7.4 BB-5008 Fire Node Backbox

The BB-5008 backbox is larger than the BBX-1072A(R)DS. It can use the FX-2009-12NDS 
Large Main Chassis combined with ECX-0012 Expander Chassis (see section 11.7.6 on 
page 71) for additional display modules and the CCH-5008ANNUNKIT/PANELKIT and CCH-
5014ANNUNKIT/PANELKIT Custom Mounting Kits for paging and fire fighter telephone 
modules. The FX-2009-12NDS Large Main Chassis can be substituted for two ECX-0012 
Expander Chassis with the main display being replaced by the DSPL-420 Narrow Main 
Display module. The outer dimensions of the BB-5008 fit within 38.0” X 32.5” X 7.5”. See 
Figure 46 and Table 16.

Table 16 BB-5008 Backbox

Name Description Holds Number of 
Displays and 
Remote 
Annunciators

Dimensions

BB-5008

Lobby Control 
Backbox

1 FX-2009-
12NDS or 2 
ECX-0012s

DSPL-420

DSPL-2440

RAXN-LCD

RAXN-LCDG

QMT-5302N

QMP-5101N

QAZT-5302DS

QAZT-5348DS

INX-10AC

24 Ah battery 
pack

8 (the FX-2009-
12NDS uses 4, 
the ECX-0012 
uses 2)

38.0” H x 32.5” W 
x 7.5” D
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11.7.5 BB-5014 Fire Node Backbox

The BB-5014 backbox is the largest available backbox. It can use the FX-2009-12NDS Large 
Main Chassis combined with ECX-0012 Expander Chassis for additional display modules and 
the CCH-5008ANNUNKIT/PANELKIT and CCH-5014ANNUNKIT/PANELKIT Custom 
Mounting Kits for paging and fire fighter telephone modules. The FX-2009-12NDS Large Main 
Chassis can be substituted for two ECX-0012 Expander Chassis with the main display being 
replaced by the DSPL-420 Narrow Main Display module. The outer dimensions of the 
BB-5014 fit within 61.5” X 32.5” X 7.5”. See Figure 46 and Table 17.

Figure 46 The FX-2009-12NDS mounts and occupies 4 display positions in 
BB-5008 and BB-5014

Table 17 BB-5014 Backbox

Name Description Holds Number of 
Displays and 
Remote 
Annunciators

Dimensions

BB-5014

Lobby Control 
Backbox

1 FX-2009-
12NDS

2 ECX-0012s

DSPL-420

DSPL-2440

INX-10AC

RAXN-LCD

RAXN-LCDG

QMT-5302N

QMP-5101N

QAZT-5302DS

QAZT-5348DS

24 Ah battery 
pack

14 (the FX-2009-
12NDS uses 4, 
the ECX-0012 
uses 2)

61.5” H x 32.5” W 
x 7.5” D

Cutout to mount
display module

Cutout to mount
display module

Exterior View Interior View
Slot is reserved for PR-300A.  If none is required, this slot
can be used to mount any of the adder modules.

Supports 2 Display Modules. Supports 9 Adder Modules.

4
23 1

56

789

Main Board
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11.7.6 ECX-0012 Expander chassis for FX-2009-12NDS

The backplate can support 12 adder modules or any 2 of the following 3 options: 

• 6 adder modules
• 1 main board and 3 adder modules

• 1 telephone network module and 1 audio network module.

Figure 47 ECX-0012 mounts and occupies 2 display positions in BB-5008 or 
BB-5014

11.7.7 Mounting of paging and firefighter telephone modules in the BB-5008 or 
BB-5014

The paging and firefighter telephone modules mount in the BB-1000 or BB-5000 series 
enclosures. These modules require brackets for mounting. The brackets are attached to the 
backplates of the enclosures. The FX-2017-12NDS mid-size main chassis does not have 
provisions for these brackets since adder modules are mounted to the backplate. In order to 
mount the paging and firefighter telephone modules, order the CCH-5008 or CCH-5014 
custom mounting kits which will provide the proper deadfront door as well as the brackets on 
the backplate. These modules can also be mounted in the BB-1000 enclosures.

Figure 48 Mounting of paging and fire fighter telephone modules in the BB-5008 
or BB-5014

.seludoM reddA 21 stroppuS.seludoM yalpsiD 2 stroppuS

Cutout to mount 
display module

Cutout to mount 
display module

weiV roiretnIweiV roiretxE
123456

789101112

Exterior View Interior View
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11.7.8 BB-5008 and BB-5014 sample layouts

The modular nature of a fire node allows for many different configurations and combinations of 
modules depending on the requirements of the job. The figures below show sample layouts for 
the BB-5008 and BB-5014, but many other layouts are possible.

Figure 49 BB-5008 sample layout

Figure 50 BB-5014 sample layout

Exterior View

Cutout to mount
any display module

Cutout to mount
any display module

Cutout to mount
any display module

Cutout to mount
any display module

Cutout to mount
any display or
paging module

Cutout to mount
any display or
paging module

Interior View

Cutout to mount 
any display or 
paging module 

Cutout to mount 
any display or 
paging module 

Cutout to mount 
any display or 
paging module 

Cutout to mount 
any display or 
paging module 

Cutout to mount 
any display or 
paging module 

Cutout to mount 
any display or 
paging module 

Cutout to mount 
any display 

module 

Cutout to mount 
any display 

module 

Cutout to mount 
any display 

module 

Cutout to mount 
any display 

module 

Cutout to mount 
any display 

module 

Cutout to mount 
any display 

module 

Exterior View Interior View
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11.7.9 Backboxes for the RAXN-LCD and RAXN-LCDG

11.7.10 Weather-Protected Boxes

Table 18 Backboxes for the RAXN-LCD(G)

Name Number of 
annunciators and 
audio modules it 
holds

Dimensions Horizontal 
distance 
between 
mounting 
screws

Vertical 
distance 
between 
mounting 
screws

BB-1001D(R/S) 1 9”H x 12.75”W x 1.85”D 9.95” 7.50”

BB-1002D(R/S) 2 18”H x 12.75”W x 1.85”D 9.95” 16.5”

BB-1003D(R/S) 3 26.4”H x 12.75”W x 
1.85”D 9.95” 24.90”

BB-1008D(R/S) 8 33”H x 22.5”W x 1.85”D 20.9” 35.2”

BB-1012D(R/S) 12 45”H x 22.5”W x 1.85”D 20.9” 52.0”

Table 19 Weather-Protected Boxes

Name Annunciators it 
holds

Dimensions Horizontal 
distance 
between 
mounting 
screws

Vertical 
distance 
between 
mounting 
screws

BB-1001WP(R)A 1 RAM-1032TZDS-
CC

11 1/8”H x 12 15/16”W 
x 3 1/2”D 11” 9 1/2”

BB-1002WP(R)A 2 (RAM-1032TZDS-
CC and RAX-
1048TZDS-CC)

17 15/16”H x 12 15/16”W 
x 3 1/2”D 11” 16 5/16”
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11.8 BBX-FXMNS Mass Notification Node Backbox

The BBX-FXMNS backbox is used for the mass notification node. It can hold 2 paging 
modules, 9 adder modules and 7 display modules as shown in Figure 51. It also supports the 
addition of 4 audio amplifiers along with audio and telephone networking modules. The outer 
dimensions of the BBX-FXMNS fit within 63.5” X 22.5” X 9.5”.

Figure 51 BBX-FXMNS sample layout

Cutout to mount 
any display 

module 

Cutout to mount 
any display 

module 

Cutout to mount 
any display 

module 

Cutout to mount 
any display 

module 

Cutout to mount 
any display 

module 

Cutout to mount 
any display 

module 

Cutout to mount 
any display 

module 

Exterior View Interior View

Audio and Telephone 
Network Cards and 

Main Board and 9 
Adder Modules

Transformer

Batteries
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11.9 BBX-MNSXP Multi-Purpose Backbox

This backbox can provide additional audio amplification for speakers and strobes. It can hold 
up to 7 amplifier boards and 3 INX-10AC Intelligent NAC Expander/Power Supplies. The outer 
dimensions are 62.75” X 27.5” X 9”.

Figure 52 Audio system installation into BBX-MNSXP with CH-993B internal 
chassis

Note: Leave bottom of box conduit free for batteries.

QBC-5000N

QMB-5000B

QPS-5000N

INX-10AC
(RB-MD-950)

BATTERIES

Rail for mounting 
up to 9 Addressable 
Modules

10 AWG Tinned Copper 
Ground Strap

i
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Figure 53 NAC expander installation into BBX-MNSXP with CH-994B internal 
chassis

Batteries

INX-10AC

IM-10A and/or
CR-6A and/or CZ-6A 
(up to 6 total )
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11.10 FX-LOC(R) Local Operating Console

These operating consoles are intended for use in mass notification. They can mount 3 
modules on the deadfront door. These modules are usually a RAXN-LCD annunciator and a 
QMP-5101N paging microphone in conjunction with either a QAZT-5302DS or QAZT-5348DS 
selector panel or a FDS-008 switch module and IM-10 input module combination. The paging 
microphone is for broadcasting announcements, while pre-recorded digital messages can be 
played using the selector panel or the switch/input module combination. The figure below 
shows the setup with the switch/input module combination.

Note that the deadfront door and enclosure door can be installed such that they open either to 
the left or to the right as required. The outer dimensions of the FX-LOC(R) fit within 25.0” X 
15.0” X 7.0”.

Figure 54 FX-LOC(R)

IM-10
Input Module

RAXN-LCD
LCD Network
Annunciator

QMP-5101N
Network Paging

Microphone

FDS-008
Fan/Damper 

Switching Module
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11.10.1 Audio Cabinets

Table 20 Audio Cabinets

Name Description Holds Dimensions

QBB-5001(R)

Expansion Audio 
Cabinet

1 QMB-5000B (space 
for 1 ANC-5000, 1 
TNC-5000, and 7 
amplifier boards)

1 QPS-5000N power 
supply

1 QBC-5000N battery 
charger

24.25” H x 41” W x 8” D

BBX-FXMNS

Integrated Fire and 
Audio Backbox

1 FX-2000MNS

2 paging modules 
(QMT-5302NV, 
QMP-5101NV)

9 adder modules

7 displays

QMB-5000N (space 
for 1 ANC-5000, 1 
TNC-5000, and 4 
amplifier boards)

1 PS-2040 power 
supply

See section 11.8 
on page 74

63.5” H x 22.5” W x 9.5” D

FX-LOC(R)

Local Operating 
Console

3 modules: RAXN-
LCD, QMP-5101N, 
and QAZT-5302DS 
or QAZT-5348DS

See section 11.10 
on page 77

25.0” H x 15.0” W x 7.0” D



Hardware Layouts

79

11.10.2 Amplifier Bins

An amplifier bin, also called a card cage, holds amplifier boards and the ANC-5000 Audio 
Controller board. It is mounted inside an audio cabinet.

You need an ANC-5000 Audio Controller only in the first bin.

Because of power limitations, you can have only 4 bins per node: 3 QMB-5000Bs and 1 
QMB-5000N.

11.10.3 Amplifiers
• Maximum number of bins per node: 4
• Maximum number of amplifiers per node:

• 25 60-Watt amplifiers
or

• 50 30-Watt amplifiers
or

• 100 15-Watt amplifiers
You have 2 options for arranging the amplifiers in each bin:

BBX-MNSXP(R)

MNS Expansion 
Enclosure

QMB-5000B

1 QPS-5000N power 
supply

1 QBC-5000N battery 
charger

1 INX-10AC

62.7” H x 27.4” W x 9” D

BBX-MNSXPI(R) MNS Expansion 
Enclosure

QMB-5000B

3 INX-10AC
62.7” H x 27.4” W x 9” D

Table 21 Amplifier Bins

Name Description Amplifier Modules Notes

QMB-5000N 4 amplifier bin 4 amplifier boards + 
1 ANC-5000 1 per node

QMB-5000B 7 amplifier bin 7 amplifier boards + 
1 ANC-5000 3 per node

Bin 0 Bin 1 Bin 2 Bin 3
Option 1 4 amplifiers 7 amplifiers 7 amplifiers 7 amplifiers
Option 2 7 amplifiers 7 amplifiers 7 amplifiers 4 amplifiers

Table 20 Audio Cabinets (Continued)

Name Description Holds Dimensions
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Table 22 Amplifier Cards

Name Description Mounts in

QAA-5230-70/25 Two 30 W speaker outputs, 70 V 
or 25 V

QBB-5001

BBX-FXMNS

QAA-5230S-70/25 Two 30 W split into four 15 W 
speaker outputs, 70 V or 25 V

QBB-5001

BBX-FXMNS

QAA-5415-70 Four 15 W speaker outputs, 
70 V

QBB-5001

BBX-FXMNS

QAA-5415-25 Four 15 W speaker outputs, 
25 V

QBB-5001

BBX-FXMNS

QAA-5160-70/25 One 60 W speaker output, 70 V 
or 25 V

QBB-5001

BBX-FXMNS
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11.11 Main Display and Remote Annunciator Switch Locations

This section shows how the switch numbers are mapped from the Configurator to the main 
displays and annunciators. This section also shows the default switch assignments in the 
Configurator.

For instructions on changing the main display and adding annunciators, see section 19.8 on 
page 149.

11.11.1 Switch Layout and Assignments for DSPL-420-16TZDS

Figure 55 Switch layout on the DSPL-420-16TZDS

Figure 56 Default switch assignments for the DSPL-420-16TZDS
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11.11.2 Default Switch Assignments for DSPL-420(DS)

Figure 57 Switch layout on the DSPL-420(DS)

Figure 58 Default switch assignments for the DSPL-420(DS)
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11.11.3 Default Switch Assignments for DSPL-2440

Figure 59 Switch layout on the DSPL-2440

Figure 60 Default switch assignments for the DSPL-2440

Note: If you configure switches 3 or 7 on the DSPL-2440, the panel will show an 
“Invalid Spare Button” trouble.i
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11.11.4 Default Switch Assignments for RAXN-LCD and RAXN-LCDG

Figure 61 Switch layout on the RAXN-LCD

Figure 62 Switch layout on the RAXN-LCDG

Figure 63 Default switch assignments in the Configurator for the RAXN-LCD(G)
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12.0 Cables
12.1 Maximum Recommended Cable Lengths

There is a physical limit on the length of the cable between 2 transponder units. Table 23 lists 
the maximum recommended lengths per segment for various brands of fire alarm cable.

Exceeding these limits per segment can result in signal distortion or signal loss, which can 
affect the network as a whole.

When planning an installation or performing an onsite inspection, take the maximum length 
per cable segment into account. Refer to Table 23 for recommended lengths per cable 
segment. If the cable you are using is not listed in Table 23, refer to section 12.1.1 on page 86 
to calculate the maximum recommended length for a cable segment based on brand of cable.

If you are experiencing signal loss or degradation, contact Mircom Technical Support for 
assistance:

Toll Free 1-888-647-3665 (North America Only)
Local 905-695-3535
Email techsupport@mircomgroup.com

Attention: Do not mix gauges and brands of cables on a network. Use the same 
cable gauge and brand throughout the network.

Table 23 Maximum Recommended Cable Lengths

Manufacturer Model Type Recommended 
maximum length per 
cable segment (point-to-
point)

Metres Feet

Belden 5320UJ 18 AWG, 2 conductors, 
twisted, non-shielded 820 2690

Belden 5320UM 18 AWG, 2 conductors, 
twisted, non-shielded 625 2060

Belden 6320UJ 18 AWG, 2 conductors, 
twisted, non-shielded 410 1345

Belden 9572 16 AWG, 2 conductors, 
twisted, non-shielded 380 1250

Belden 9575 16 AWG, 2 conductors, 
twisted, shielded 185 610

Draka Lifeline FAS-2C/18NS 18 AWG, 2 conductors, 
twisted, non-shielded 750 2460

Draka Lifeline FAS-2C/18OS 18 AWG, 2 conductors, 
twisted, shielded 410 1345

!
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12.1.1 How to Calculate the Maximum Recommended Length

For cables not in Table 23, you can determine the maximum length of cable between 
transponders using the cable’s mutual capacitance, which is provided by the cable 
manufacturer.

Capacitance

Capacitance is the ability of a system to store an electric charge when a potential difference 
exists between its conductors. Capacitance is measured in farads (F). A system that is 
charged with 1 coulomb of energy and that has a potential difference of 1 volt between its 
conductors has a capacitance of 1 farad.

Draka Lifeline FAS-2C/16NS 16 AWG, 2 conductors, 
twisted, non-shielded 625 2050

Draka Lifeline FAS-2C/16OS 16 AWG, 2 conductors, 
twisted, shielded 360 1180

Electro Cables 7241802BFT4 18 AWG, 2 conductors, 
twisted, shielded 190 620

Electro Cables 7241803BFT4 18 AWG, 3 conductors, 
twisted, shielded 195 640

Honeywell Genesis 
Series 4106 18 AWG, 2 conductors, 

non-shielded 535 1750

Honeywell Genesis 
Series 4602 18 AWG, 2 conductors, 

shielded 160 515

Pentair Pyrotenax 2/18-215T 18 AWG, 2 conductors, 
twisted, non-shielded 225 745

Provo Ltd. PP5052-21 18 AWG, 2 conductors, 
twisted, non-shielded 600 1970

Provo Ltd. PP5883-21 18 AWG, 2 conductors, 
twisted, shielded 180 590

West Penn Wire 980 18 AWG, 2 conductors, 
twisted, non-shielded 460 1520

West Penn Wire 990 16 AWG, 2 conductors, 
twisted, son-shielded 460 1520

West Penn Wire 975 18 AWG, 2 conductors, 
twisted, shielded 265 875

West Penn Wire 991 16 AWG, 2 conductors, 
twisted, shielded 230 760

Table 23 Maximum Recommended Cable Lengths (Continued)

Manufacturer Model Type Recommended 
maximum length per 
cable segment (point-to-
point)

Metres Feet
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A cable, like any electrically charged object, has capacitance. The capacitance between the 
conductors of a cable is called mutual capacitance.

A cable’s mutual capacitance depends on many factors, including the length of the cable, the 
distance between the conductors, and the type of dielectric (the insulation between the 
conductors). Different brands of cables can have different capacitances, even if their gauge 
and length are the same.

A capacitance higher than 35 nF can lead to signal distortion

If the capacitance of the cable is too high, signal distortion results at high frequencies, 
including the frequencies used for communication between transponders. A cable with a 
capacitance higher than 35 nF (nanofarads) can lead to signal distortion. Mircom has looked 
at different brands of cables and calculated the length of each cable at 35 nF. This is the 
maximum recommended length for each brand of cable. Table 23 lists these lengths.

Using capacitance to determine maximum recommended length

The manufacturer’s specifications for a cable usually lists the capacitance for a certain length. 
From this information you can calculate the length of cable that has a capacitance of 35 nF.

For example, consider a cable that has a capacitance of 47 pF/ft (picofarads per foot). That is, 
1 foot of this cable has a capacitance of 47 pF. You can calculate the length at which this cable 
has a capacitance of 35 nF.

Calculate the maximum recommended length of a cable

1. Convert the capacitance to nanofarads. 1 pF equals 0.001 nF.

For example, 47 pF equal 0.047 nF.

2. Create an equation where one side is the known capacitance per foot, and the other side 
is 35 nF per x feet.

3. Solve for x.

The capacitance of this cable is 35 nF per 744.68 feet. Therefore, the maximum 
recommended point-to-point length for this cable is 744.68 feet.

If you know the nanofarads per foot, you can divide 35 by this number to get the 
maximum recommended length in feet.

12.2 Fiber Optic Cables
FleX-Net™ supports two kinds of fiber optic cables:

• 50/125 μm

• 62.5/125 μm

The numbers represent the diameter of the core/cladding in micrometers (microns).

0.047
1

------------- 35
x
------=

0.047( ) x( ) 35( ) 1( )=

0.047( ) x( )
0.047

-------------------------- 35( ) 1( )
0.047
-------------------=

x 744.68=
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12.3 Typical Optical Power Budget

• 50/125 μm: 9.6 dB
• 62.5/125 μm: 15 dB

12.3.1 Connecting Fiber Optic Cables

For instructions on wiring the FOM-2000-UM, see LT-6907 FOM-2000-UM Installation and 
Operation Manual.

12.4 Ground Fault Reporting

The FleX-Net™ system reports ground faults as required by UL, ULC, and FM. Mircom has 
enhanced ground fault reporting to aid the technician in identifying which lead of a pair of wires 
is in contact with the ground. To this end, the ground fault report on the panel includes 
information about polarity (positive or negative).

• SLC (signaling line circuits) wires and IDC (input detection circuits) wires: The 
positive ground fault or negative ground fault report on the panel points the technician to 
the fault directly.

• NAC circuits: The polarity of the ground fault is reversed in the panel report because in 
normal supervisory condition, the NAC circuits are driven in the opposite polarity.

• Annunciator and network connections that use electrical industry standard RS-
485 connections: The panel reports a ground fault on either lead of these connections 
as negative. This is a result of the low voltage circuitry used for such signaling. Neither 
the positive lead nor the negative lead of the RS-485 line is of a high enough voltage 
level to accurately differentiate between a positive or negative ground fault, so in the 
case of a ground fault on either lead of the RS-485 line, only a negative ground fault is 
reported.

12.5 Ground Fault Detection

In certain applications, a large number of wires connected to the same panel can cause a high 
capacitance to ground, which can cause the FleX-Net™ system to report false intermittent 
ground faults.

If the system reports intermittent ground faults when there is no ground fault, turn on Alternate 
Ground Fault Detection in the Configurator. This compensates for the errors caused by high 
capacitance to ground in cables.

Turn on Alternate Ground Fault Detection

1. In the Configurator, open the version of the job that is active on the panel.

2. Select the node that is reporting ground faults.

3. Check Alternate Ground Fault Detection at the bottom of the window.

4. Click Panel > Send Job to send the job to the Fire Alarm Control Panel.
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13.0 Addressable Loop Interference on 
Phone Handset Lines
Addressable loops can cause noise on the phone handsets connected to the FACP, especially 
on handsets connected to System Sensor addressable modules. Mircom has several 
recommendations for reducing this noise. Keep these recommendations in mind before you 
start a job.

13.1 Use the Quad Loop Adder

Connect loops to the quad loop adder main board (ALCN-792MISO) instead of to loop 2 (the 
loop that is hardwired on the Fire Alarm Control Panel). Each quad loop adder main board 
supports 2 addressable loops.

Contact Mircom Technical Support for assistance:

Toll Free 1-888-647-3665 (North America Only)
Local 905-695-3535
Email techsupport@mircomgroup.com

13.2 Avoid Sources of Electrical Interference

Avoid running phone cables near sources of electrical interference or noise, such as:

• Other cables, especially cables for addressable loops.
• Motors (for example, fans and dampers).

• Fluorescent lamps.

13.3 Use the TNC-5000 Telephone Bus Terminals

There are two ways that telephones can communicate:

• Over the cables (either twisted pair or fiber optic) that connect the nodes to each other. 
The nodes communicate over the ARCNet protocol (a protocol for communication 
between computers). If you check Digital Phone in Job Details in the Configurator, then 
the phones communicate over these wires. (See section 19.5 on page 134.)

• Over the telephone bus terminals on the TNC-5000 (telephone network controller) 
boards. If you uncheck Digital Phone in Job Details in the Configurator, then the phones 
communicate over the telephone bus terminals.

To reduce interference, use the telephone bus terminals for telephone communication instead 
of the ARCNet wires.

If you decide to use the ARCNet wiring for telephone communication, connect the telephone 
bus terminals as well. If you experience too much interference on the phones over the 
ARCNet wiring, you can easily switch to the telephone bus terminals instead.

13.4 Use Shielded Wiring

• Use 18 gauge shielded twisted pair cables for the connections between TNC-5000 
telephone bus terminals, and for the connections between the addressable modules.
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• Use shielded cables for the connections between the addressable modules and the 
telephone handsets, if possible.

Connect the TNC-5000 telephone bus terminals with shielded wiring

1. Wire the TNC-5000 boards as explained in LT-894 FleX-Net™ Installation and Operation 
Manual.

Each board has 2 buses: 1 IN bus and 1 OUT bus.

Each bus has 3 terminals: positive (+), negative ( ), and shield (S).

2. Connect the positive, negative, and shield wires of one end of the cable to the Tel. Bus 
OUT of the previous board.

3. Connect the positive, negative, and shield wires of the other end of the cable to the Tel. 
Bus IN of the next board.

Terminate both ends of the shield.

Figure 64 Wiring of the TNC-5000 boards

Connect the M500 addressable modules with shielded wiring

1. Wire the addressable modules as explained in LT-894 FleX-Net™ Installation and 
Operation Manual.

2. Connect the shields to each other with twist-on wire connectors (marettes).

Terminate only one end of the shield.

• For class A wiring, leave the shield unconnected at the end of the loop (where the 
wires return to the module).
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• For class B wiring, leave the shield unconnected at the end of the line.

Figure 65 Telephones and addressable modules showing shielded wiring 
(Class A)

Figure 66 Telephones and addressable modules showing shielded wiring 
(Class B)
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13.5 Keep Modules Close to the Handsets

• Install the handsets as close as possible to the modules. A shorter cable will reduce 
interference.

• If you cannot install the handsets close to the modules, use shielded cables between the 
telephone modules and the handsets.

13.6 Large Systems and Retrofits

When there is a large number of cables connected to a single node, or when the amount and 
location of wiring is not known, keep the following in mind:

• Make a cost provision for connecting loops to the quad loop adder main board 
(ALCN-792MISO) instead of loop 2 (the loop that is hardwired on the Fire Alarm Control 
Panel).
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14.0 Mass Notification System 
Introduction
The FleX-Net™ Mass Notification System (MNS) allows announcements and notifications 
outside of regular fire announcements. For example, MNS can be used for weather warnings 
or toxic chemical alerts, and these announcements have a higher priority than fire 
announcements. The fire control system can also override the MNS.

The MNS comes with a fire control and monitoring system. A single MNS panel can display 
both MNS and fire events, but each type of event appears separately on different annunciator 
displays. The fire and mass notification modules on the MNS panel are arranged 
independently of each other and are accessed by two separate doors. Refer to Figure 67.

Figure 67 The FleX-Net™ Mass Notification System
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14.1 Virtual Zones

A virtual zone is a zone that is not associated with any physical devices but instead monitors 
inputs across groups and activates outputs across groups using advanced logic.

Even though the MNS has a fire monitoring component, it cannot control fire devices. 
Governing bodies such as UL/ULC require that MNS and fire control systems be grouped 
separately in the software. The input and output devices for fire and MNS must be in different 
zones and these zones must be in different groups. Since an input zone cannot activate 
outputs in a different group, the MNS input zones will not activate fire output signals and fire 
input zones will not activate MNS output signals.

However, sometimes inputs from one group require the use of hardware present in a different 
group. For example, the fire group may have inputs that require the use of amplifiers in the 
MNS panel. You can use virtual zones to make inputs activate outputs across groups.

Chapter 6 outlines how to use advanced logic with virtual zones.

14.1.1 Conflicts with virtual zones

Sometimes conflicts can occur. For example, two inputs may try to activate the same output 
simultaneously. To prevent this, you can give priority to either MNS or fire.

For example, if MNS has a higher priority and a fire input activates:

1. The fire output remains active until an MNS input activates.

2. When an MNS input activates, the MNS output takes over and silences the fire output.

3. When the MNS output is finished, the fire output resumes.

Figure 68 Virtual Zone Priorities
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14.2 Setting priorities for zones and switches

You set the priority of zones and switches in the Configurator.

To set priority for a zone or a switch

1. In the Configurator, double-click in the Priority column for the zone or zone switch.

2. Click a priority in the pulldown menu.

This number is the priority given to digital messages that are correlated with this zone or 
switch. The priority ranges from 19 (lowest) through Normal (default) to +19 (highest).
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15.0 Autonomous Control Unit and Local 
Operating Consoles
The Autonomous Control Unit (ACU) and the FleX-Net™ Local Operating Consoles (FX-
LOCs) connect to the FleX-Net™ Mass Notification System (MNS) remotely. The MNS uses 
the ACU and the FX-LOCs to broadcast live announcements and pre-recorded digital 
messages to multiple locations in a building.

15.1 ACU and FX-LOC Configuration

The ACU has a paging microphone that connects directly to the main board through a ribbon 
cable connection. The microphone has priority over the FX-LOC paging microphones and all 
digital messages. The ACU contains an IPS switch adder module that broadcasts pre-
recorded digital messages. Each button on the switch adder module can be configured as a 
zone switch in the Configurator. For each zone switch, a priority level can be assigned and a 
digital message can be attached.

The FX-LOC contains a switching and input module combination that broadcasts pre-recorded 
digital messages.

Both the ACU and the FX-LOC contain a paging module that broadcasts announcements and 
a display that monitors MNS events.

15.2 Setting priorities for zones and switches

You set the priority of zones and switches in the Configurator.

To set priority for a zone or a switch

1. In the Configurator, double-click in the Priority column for the zone or switch.

2. Click a priority in the pulldown menu.

This number is the priority given to digital messages that are correlated with this zone or 
switch. The priority ranges from 19 (lowest) through Normal (default) to +19 (highest).

15.3 Broadcast Priority
Announcements or digital messages from an ACU override broadcasts already in progress 
from an FX-LOC. The broadcast of announcements or digital messages from an FX-LOC 
occurs on a first come first serve basis. If one FX-LOC is broadcasting, another FX-LOC 
cannot broadcast until the first FX-LOC has stopped broadcasting. The following list identifies 
broadcast priorities from highest (1) to lowest (6).

1. ACU announcement by paging microphone

2. ACU highest priority digital messages (priority is set in the Configurator)

3. ACU lowest priority digital messages (priority is set in the Configurator)

4. FX-LOC announcement by paging microphone

5. FX-LOC highest priority digital messages (priority is set in the Configurator)

6. FX-LOC lowest priority digital messages (priority is set in the Configurator)
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For example, a priority of -1 assigned to a zone switch on the ACU’s IPS switch adder module 
has a higher priority than a priority of +9 assigned to a zone correlated to the input module 
used by the FX-LOC. Refer to Figure 69.

Figure 69 ACU and LOC Configuration

The FX-LOC paging microphones are hardwired to the board belonging to the ACU paging 
microphone. They have a lower priority than the IPS switch adder module messages used by 
the ACU but a higher priority than the FDS switching module messages used by the FX-LOC.

The FX-LOC broadcasts digital messages using an FDS switching module. Each switch on 
this switching module is hardwired to inputs on an input module that are correlated to input 
zones in the configuration. Each input is correlated to its own input zone with a digital 
message attached to each zone. Priority for FX-LOC digital messages is set between the input 
zones. For example, an input zone with an assigned priority of 70% will override an input zone 
with an assigned priority of 50%. Refer to the figure below.
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Figure 70 Zone Priorities

15.4 ACU Operation

To broadcast a pre-recorded digital message:

• Press a button on the selector with the appropriate message.

Buttons should be labelled to indicate the content of the message. The message will be 
broadcasted and will loop continuously until the system is reset or a higher priority 
operation is performed.

To broadcast an announcement:

1. Remove the microphone from its holder and press the button on the microphone.

2. Speak into the microphone.

The Page Ready LED turns on when the microphone is keyed.

The ACU paging microphone has the highest priority and will override all other 
operations.

15.5 LOC Operation

To broadcast a pre-recorded digital message:

• Move a switch with the appropriate message to the ON position.

Switches should be labelled to indicate the message that they will play. The message will 
be broadcasted and will loop continuously until the system is reset or a higher priority 
operation is performed.

To broadcast an announcement:

1. Remove the microphone from its holder and press the button on the microphone.

2. Speak into the microphone.
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Only one microphone can be used at a time.

If the Page Ready LED is on before the microphone is removed from the receiver, then 
another microphone is in use.

If the LED is off then there is no microphone in use.

If the LED turns on only after the paging microphone is removed, then that microphone is now 
active.
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16.0 Digital Messages
A digital message is a pre-recorded announcement or alarm tone. You compose a digital 
message by combining audio clips (audio files) into a composition.

16.1 Creating a Digital Message

Create a digital message

1. In the Job Details window of the Configurator, click the Set up button under Audio.

Figure 71 Job Details showing Audio Setup

Note: You can have up to 96 digital messages used in correlations per job.i
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The Audio Setup window appears.

Figure 72 Audio Setup

2. Click the Manage Messages button.

The Manage Messages window appears.

Figure 73 Manage Messages

The Manage Messages window lists the compositions that are currently in the system. 
You can add a new composition, or edit or remove an existing composition.
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3. Click the Add button to create a new composition.

The Audio Message Composer window appears. The left side of the window lists the 
available audio clips (audio files that you can combine into compositions). Several audio 
clips are included by default; they are listed as Built-In. The right side of the window 
shows the current composition.

Figure 74 Audio Message Composer

4. Click the Import button, and then select an audio file to import.

The imported file appears on the left under Audio Clips.

All audio files must be in one of the following formats:

• Voice messages: .wav format sampled at 11.025 kHz, 16-bit mono, ADPCM 4-bit

• Non-voice messages such as a whoop signal or sweep: .wav format PCM (RAW) 
16-bit mono

5. Click the >> button to move an audio clip to the Audio Message list.

The built-in audio clips are composed of one or more sounds in a loop. When you move 
a built-in audio clip to the Audio Message list, it is expanded and shown with its included 
audio clips and loops.

6. When you are finished composing your message, click OK.

Your new composition appears in the Manage Messages window.

7. Click Close in the Manage Messages window.

Note: Audacity (available as freeware from http://audacity.sourceforge.net/) can 
convert most audio file formats into .wav format.i
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16.2 Audio Clips and Nested Loops

Each audio clip is part of a loop. The loop is marked by the words Repeat Count and the 
curved arrow. Audio clips are marked by a speaker icon.

The Audio Message Composer lets you create nested loops. If one loop is nested inside 
another, then the inside loop will play a specified number of times for every time the outside 
loop plays.

You can make up to 4 levels of nesting.

You can move an audio clip up or down within a loop, but you cannot move an audio clip 
outside a loop. For this reason, create the loop first, then import the audio clip into the loop.

Figure 75 Audio clips and nested loops

Create a loop

1. Select the loop that you want the new loop to be part of. If the new loop is not part of 
another loop, select Composition.

2. Click Add Loop.

Import an audio clip into a loop

1. Select the loop that you want to import the audio clip into.

2. Select the audio clip in the Audio Clips list and click the >> button to move the audio clip 
to the Audio Message list.

Specify the number of times a loop should play

• Select the loop, and then type the number of times to repeat it in the Repeat Count 
field.

Note: When you move a audio clip to the Audio Message list, it is placed into the 
selected loop.

Loop
Audio clip

Loop
Loop
Audio clip
Loop

Audio clip

i
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Reorder audio clips within a loop

• Select the audio clip, and then click the Up and Down buttons.

Reorder loops

• Select the loop, and then click the Up and Down buttons.

Delete an audio clip in the Composition list

• Select the audio clip, and then click the Del button. Deleting an audio clip does not 
delete the loop.

Delete a loop in the Composition list

• Select the loop, and then click the Del button. Deleting a loops also deletes the 
audio clips in that loop.

Make an audio clip repeat

• Select the loop that the audio clip is part of, and then type the number of times to 
repeat it in the Repeat Count field.

Make an audio clip repeat indefinitely

• Select the loop that the audio clip is part of, and then type 0 in the Repeat Count 
field. If an audio clip repeats indefinitely, any following audio clips are not played.

Play the whole message

• Click the Play  button.

16.3 Nested Loop Example

Figure 76 shows a composition with nested loops. In this composition, audio clip A plays twice 
(Loop 3), then audio clip B plays 3 times (Loop 4). These audio clips form a loop which repeats 

Note: You can move an audio clip up or down within a loop, but you cannot move it 
outside a loop.

Note: You can move a loop up or down within its containing loop, but you cannot move 
it outside its containing loop.

i

i
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4 times (Loop 2). Then audio clip C plays 3 times (Loop 5). The entire composition plays twice 
(Loop 1).

Figure 76 Nested loop example

16.3.1 Procedure for creating a nested loop

This procedure shows how to create the composition in Figure 76.

Create a nested loop

1. Click the Add Loop button.

A loop appears with a repeat count of 1.

2. Select the loop and type 2 in the Repeat count field. This is Loop 1.

3. Select Loop 1 and click Add Loop.

A second loop appears inside the outermost loop.

4. Select the second loop and type 4 in the Repeat count field. This is Loop 2.

5. Select Loop 2 and click Add Loop.

A third loop appears inside the second loop.

6. Select the third loop and type 2 in the Repeat count field. This is Loop 3.

7. Select Loop 3, then select audio clip A in the Audio Clips list, then click the >> button to 
move audio clip A to the Composition list.

Audio clip A appears inside Loop 3.

8. Select Loop 2 and click Add Loop.

The new loop appears above Loop 3 but still inside Loop 2.

9. Select the new loop and type 3 in the Repeat count field. This is Loop 4.

10. Select Loop 4, then select audio clip B in the Audio Clips list, then click the >> button to 
move audio clip B to the Composition list.

Audio clip B appears inside Loop 4.

11. Select Loop 1 and click Add Loop.

12. Select the new loop and type 3 in the Repeat count field. This is Loop 5.

13. Select Loop 5, then select audio clip C in the Audio Clips list, then click the >> button to 
move audio clip A to the Composition list.

Audio clip A appears inside Loop 5.

Loop 1
Loop 2

Loop 3

Loop 4

Loop 5

Audio clip

Audio clip

Audio clip
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14. The composition should look like this (Figure 77):

Figure 77 Nested loop example

15. Select Loop 2 (not the audio clip) and click the Up button to move it above Loop 5.

16. Select Loop 3 and click the Up button to move it above Loop 4.

The composition should now look like Figure 76.

16.4 Configuring FleX-Net™ to use your new composition
1. In the Audio Setup window (Figure 72), click the ... button beside Alert 1 or Evac.

The Choose a Message window appears.

2. Select your composition, and then click OK.

The FleX-Net™ system will use your new composition as the Alert 1 or Evac message, 
depending on which one you selected.

• Select Sound pre-announce tone when paging to make a 900 Hz pre-announce tone 
play for 2 seconds before the paging audio source is applied. If Smart Speakers are 
installed, this special tone will un-silence speakers that are currently silenced.

16.5 Correlating Digital Messages to a Zone or Switch
You can correlate compositions that you create to a zone or switch. The message will play 
when the zone or switch becomes active.

Correlate a digital message

1. Right-click the zone or switch that you want to associate with the digital message, and 
then click Add Correlations.

2. Click the Digitized Msgs tab.

A list of the digital messages that you have created appears.

3. Click the message that you want to correlate, and then click Add.

Loop 1
Loop 5

Loop 2
Loop 4

Loop 3
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17.0 Connecting to a BACnet system
BACnet stands for Building Automation and Control Networks (http://www.bacnet.org). It is a 
communication protocol for monitoring and controlling different building regulation systems, 
which include heating, ventilation, lighting control, access control, and fire detection systems. 
The BACnet protocol uses a common communication format to let these different systems 
communicate with each other. A tutorial is available at http://www.bacnet.org.

BACnet uses a peer-to-peer architecture where any device can send service requests to any 
other device. Protocol services include Who-Is, I-Am, Who-Has and I-Have. Any BACnet 
object can perform these service requests. BACnet services can provide event notifications 
such as troubles or input activations.

The FleX-Net™ system can interface with other systems that communicate through BACnet. 
FleX-Net™ does not query other BACnet systems. Instead, other BACnet systems can 
request current values from the FleX-Net™ system. FleX-Net™ only replies to requests or 
sends out notifications of new events.

17.1 BACnet Objects

A BACnet object is “a collection of information related to a particular function that can be 
uniquely identified and accessed over a network in a standardized way”. Each object has an 
object ID and a set of properties.

A confusion of terminology can arise when describing FleX-Net™ under the BACnet model. In 
the fire alarm industry, the term device refers to things such as detectors, strobes, and alarms. 
With BACnet, the entire FleX-Net™ system is a device with many objects. Object refers to all 
the fire devices, system statuses and switches connected to the FleX-Net™ system.

Figure 78 BACnet objects

BACnet classifies objects into different types. For example, fire devices are divided into 
categories such as binary inputs, binary outputs, analog inputs and analog outputs. Every 
object has an object identifier, an object name, and other properties. Some properties are 
required and some are optional.
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OBJECTS
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Switches 
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17.2 Setting up BACnet

To set up the BACnet server you must:

• Connect the Ethernet cable.
• Configure the Fire Alarm Control Panel.
• Ping the Fire Alarm Control Panel to verify the connection.

Follow the instructions below to complete these steps.

17.2.1 Connecting the Ethernet cable

Connect the Ethernet cable

1. Connect an Ethernet cable to the Ethernet port on the main board (MD-871A) of the 
node. The port is labelled P7 and is in the bottom left corner of the mounted board.

2. Connect the other end of the Ethernet cable to a computer, a router, or a switch.

17.2.2 Configuring the Fire Alarm Control Panel

You need to follow this procedure only for the node that is connected by Ethernet.

Configure the Fire Alarm Control Panel for BACnet

1. Connect your computer to the Fire Alarm Control Panel, and then open the Configurator. 
See chapter 2 for details.

2. In the Configurator, open the version of the job that is active on the panel.

3. Create a new version of that job so that you can make changes.

4. Select the Node that you connected the Ethernet cable to.

Note: You must purchase a BACnet license in order to use FleX-Net™ with BACnet. 
You must purchase one license for each job.

Note: Connect FleX-Net™ only over secure networks.

i

i
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The Network node information appears on the right.

Figure 79 Network node information - BACnet

5. Type the static IP address, subnet mask and default gateway. Each node on the TCP/IP 
network requires its own IP (Internet Protocol) address. The IP address must be unique 
to the node and it must not be used by any other device on the TCP/IP network.

If you need assistance, contact your network administrator.

6. Click Enable under BACnet.

7. Click the Activate BACnet button. You must have a CodeMeter key inserted in the 
computer.

8. Click Yes to transfer a BACnet license from your CodeMeter key to the Configurator, and 
then click OK in the BACnet Services Licence Imported window, and then click OK in 
the UnitCounter window.

9. Type a Device ID and a Base ID in the appropriate fields. The Device ID must be a 
lower number than the Base ID.

The Base ID determines where the object ID values will start from. FleX-Net™ assigns 
every device a BACnet object ID starting from the Base ID.

The Device ID determines the ID of the Fire Alarm Control Panel. The Device ID must be 
lower than the Base ID so that it is outside the range of possible object IDs.

10. Check Supervise Ethernet Connection if necessary. This creates a trouble event if the 
node does not detect an Ethernet connection.

Note: Your organization has a certain number of BACnet Services licenses. You can 
use only one BACnet Services license per job.i
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11. Click Panel > Send Job to send the job to the Fire Alarm Control Panel.

17.2.3 Configuring the BACnet Computer

Communication between the panel and the computer running the BACnet software will be 
more reliable if the computer is assigned a static IP address. The following procedure 
describes how to do this in Windows 7.

Set a Static IP Address on Computer

1. Click Start, then click Control Panel.

2. Click Network and Sharing Center.

3. Double-click Local Area Connection.

The Local Area Connection Status window appears.

4. Click Properties.

The Local Area Connection Properties window appears.

5. Double-click Internet Protocol Version 4 (TCP/IPv4).

The Internet Protocol Version 4 (TCP/IPv4) Properties window appears.

6. Click on the Use the following IP address radio button.

Set the IP Address to match the Default Gateway of the node where the computer is 
connected.

Set the Subnet Mask to match the Subnet Mask of the node where the computer is 
connected.

Set the Default Gateway to match the IP Address of the node where the computer is 
connected.

Click on Okay and close the other windows.

17.2.4 Pinging the Fire Alarm Control Panel

Before attempting to connect BACnet software to the FleX-Net™ system, ensure that there is 
a network connection between the computer with the BACnet software and the Fire Alarm 
Control Panel.

Ping the Fire Alarm Control Panel

1. Click the Start button, click Run, type cmd.exe, and then press Enter.

2. In the command prompt window, type ping followed by the IP address of the node that is 
connected by Ethernet. For example, if the IP address is 10.10.0.1, then type:

ping 10.10.0.1
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• If the ping is successful, then the computer can communicate with the node.

Figure 80 Successful ping

• If you see the message Request timed out, then the ping was not successful, and 
the computer cannot communicate with the node. Check the network connection 
and make sure that the computer and the node are on the same subnet and have 
different IP addresses.

Figure 81 Unsuccessful ping

17.3 Generating Reports

The Configurator can generate a BACnet report that includes the object ID of each object, and 
other identifying information such as node, CPU and loop number.

Generate a report

1. In the Configurator, click Job > Export Job.

The Export Current Job to a File window appears.

2. Choose a location to save the report, and type a name for the report.

3. Select BACnet Report - Excel (*.xml) under the Save as type pulldown menu. 

4. Click Save.
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The Select Firmware Version window appears.

5. In the Select Firmware Version window, make sure that the numbers in the first two 
fields match the firmware version of the panel that is running the job.

6. Click OK.

Figure 82 shows the report.

Figure 82 BACnet report

The first column lists the BACnet ID of each object in the FleX-Net™ system.

• The NodeNo, CPUNo, and LoopNo columns describe which Node, CPU and Loop 
each object is on. 

• The Node Tag and CPU Tag columns describe the Node and CPU respectively. 

• The Address column is the fire device address.

• The Tag column describes the object.

• The CktType, CktTypeTag, and CktNo columns contain information that FleX-Net™ 
uses internally to identify the object.
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17.4 Object Types

Table 24 shows how FleX-Net™ classifies its devices according to the BACnet object types.

17.5 Object Type Properties

Each of these object types has a set of properties, which identify the object and its state. Table 
25 lists the properties associated with each BACnet object that FleX-Net™ uses. Some of the 
properties are static (they do not change), while others are dynamic (they change depending 
on the state the object is in). The dynamic properties are bold.

Table 24 Object Types

Object Type Fire Device Types

 Binary Input Conventional Input, System Status, Page Select Switches, Manual 
Control Switches, Miscellaneous Input Circuits

Analog Input and
Multi-State Input

Ion Detector, Photo Detector, Heat Detector, Laser Detector, 
COPTIR, 4-20mA Module, Acclimate Detector

Life Safety Point Fire Phone, Telephone Line, Generic Input

Binary Output Amplifier, Addressable Relay, Conventional Relay, Conventional 
Signal, Control

Table 25 Object Type Properties

Object 
Type

Binary Input Analog Input Multi-State 
Input

Life Safety Point Binary Output

Object 
Properties

Object 
Identifier
Object Name
Object Type
Present Value
Status Flags
Event State
Out of Service
Polarity
Description

Object 
Identifier
Object Name
Object Type
Present Value
Status Flags
Event State
Out of Service
Units
Description

Object 
Identifier
Object Name
Object Type
Present Value
Status Flags
Event State
Out of Service
Number of 
States
Description
State Text

Object Identifier
Object Name
Object Type
Present Value
Status Flags
Event State
Out of Service
Reliability
Mode
Accepted Modes
Silenced
Operation 
Expected
Description

Object Identifier
Object Name
Object Type
Present Value
Status Flags
Event State
Out of Service
Polarity
Priority Array
Relinquish 
Default
Description
Active Text
Inactive Text
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17.5.1 Dynamic Properties

Each dynamic property uses different types of information as the values. The values also vary 
depending on the kind of object.

Binary Input

Analog Input

Multi-state Input

Life Safety Point

Property Value
Present Value active or inactive
Status Flags a Boolean array [_,_,_,_] - each value in the array represents the 

presence (1) or absence (0) of an Alarm, Fault, Override or Out of 
Service respectively

Event State normal, fault or off normal

Property Value
Present Value an analog value in the form of a pulse width PW4 signal
Status Flags a Boolean array [_,_,_,_] - each value in the array represents the 

presence (1) or absence (0) of an Alarm, Fault, Override or Out of 
Service respectively

Event State normal, fault or off normal

Property Value
Present Value 0-7
Status Flags a Boolean array [_,_,_,_] - each value in the array represents the 

presence (1) or absence (0) of an Alarm, Fault, Override or Out of 
Service respectively

Event State normal, fault or off normal

Property Value
Present Value quiet, fault or alarm
Status Flags a Boolean array [_,_,_,_] - each value in the array represents the 

presence (1) or absence (0) of an Alarm, Fault, Override or Out of 
Service respectively

Event State normal, fault or off normal
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Binary Output

17.6 CAS BACnet Explorer

CAS BACnet Explorer is useful for testing, debugging and discovering BACnet networks and 
devices. The program can be downloaded from the Internet from: http://www.chipkin.com/cas-
BACnet-explorer but it requires a license to use. The license comes in the form of a USB key 
which must be plugged into the computer the software is being used on. When installing the 
software the installer will prompt for the installation of WinPcap. Allow this to install as it is part 
of the CAS BACnet Explorer package.

Figure 83 CAS BACnet Explorer

Once CAS BACnet Explorer is installed start the program. Some settings require 
configuration: 

1. Press the Settings button and a Settings dialogue box will appear. 

2. In the Settings dialogue box press the Network tab on the left and check the BACnet IP 
and the BACnet Ethernet check boxes. 

3. Select the network card being used and then press OK.

The Discover function of the program identifies all objects associated with the FleX-Net™ 
system. These objects include inputs, outputs, switches and system statuses. This function is 
useful for confirming the presence and availability of all the objects associated with the FACP 
and it must be performed before any FACP devices can be monitored.

Property Value
Present Value active or inactive
Status Flags a Boolean array [_,_,_,_] - each value in the array represents the 

presence (1) or absence (0) of an Alarm, Fault, Override or Out of 
Service respectively

Event State normal, fault or off normal
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1. Press the Discover button and a Discover dialogue box will appear. 

2. Ensure that all check boxes on the left are selected. Select the All check box beside the 
Network field. 

3. In the Low Device Instance field enter the Device ID of the FACP that was set in the 
configuration. 

4. In the High Device Instance field enter a value one greater than the Device ID. Setting 
this range ensures that only objects associated with the FACP will be discovered. 

5. Press Send to begin the discovery process. 

Note that sometimes the software will report errors while discovering, this will not affect the 
outcome of the discovery. Once the discovery is complete the main window should display a 
populated tree consisting of all the objects associated with the FACP. If the list does not 
appear or is incomplete repeat the discovery process with all options selected.

The CAS BACnet explorer can also be used to monitor any changes in the properties of any of 
the objects associated with the FACP. Once objects have been discovered the populated tree 
can be expanded and individual objects can be selected. Each object can be expanded to 
view its parameters and properties. To monitor an object right click on it and select “Add this 
object to monitor list”. Repeat this for each object that needs to be monitored.

Objects will be monitored using default properties however the list of default properties may 
not included all required properties. To set properties to be monitored click on the settings icon 
and the Settings window appears. Use the Add and Remove buttons to select properties. 
Press OK to confirm the settings.

Once objects and properties to be monitored are selected press the Monitor button in the main 
window. All the objects to be monitored will be displayed in a new window titled Monitor List. 
This window will display any changes in properties as they happen in real time.

17.7 Visual Test Shell

Visual Test Shell (VTS) is an application that is able to monitor BACnet objects and 
communicate with BACnet devices to acknowledge alarms. It is freeware and can be 
downloaded from: http://sourceforge.net/projects/vts/. Once the zip file package has been 
downloaded extract the files and launch the application using the executable VTS.exe. Note 
that WinPcap must be installed in order for the VTS application to launch.

Figure 84 Visual Test Shell
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17.7.1 Configuring Device, Port and Name Settings
1. From the taskbar select Edit then select Device. The Device Configuration window 

appears. 

2. Enter a name for the BACnet device in the Name field and its Device ID in the Instance 
field. 

3. Press OK to confirm your settings.

4. From the task bar select Edit then select Ports. The Port Configuration window appears. 

5. Press the New button and in the Name field enter a name for the port. 

6. Select the Enable check box and use the Network drop down box to select the device 
that was configured in the Device Configuration window. 

7. Press the IP tab and ensure that the Interface drop down box displays the correct 
network adapter. 

8. Press OK to confirm your settings.

9. From the task bar select Edit then select Names. The Names window appears. 

10. Press the New button and set the Address Type to Local Station if the FACP is on the 
same subnet. 

11. Use the Port drop down box to select the port created using the Ports menu. Enter a 
name for the FACP. Enter the IP address assigned to the FACP in the configuration in 
the Address field along with the port number. 

12. Press OK to confirm your settings.

17.7.2 Setting up Filters

Navigate to the Edit menu and select either Capture Filter or Display Filter. The setup for each 
filter type is the same, the difference being that the display filter changes what is displayed and 
does not affect the log file while the capture filter directly affects what appears in the log file. To 
create a new filter: 

1. Click the New button in the Filters window. 

2. Select options for accepting or rejecting packets and set the Port, Address and Address 
Type as before in section 17.7.1. 

3. Press OK to confirm your settings.

17.7.3 Acknowledging Alarms
1. Navigate to the menu bar and select Send. From the drop down menu navigate to Alarm 

and Event then Acknowledge Alarm. The Acknowledge Alarm dialogue box will appear. 

2. The majority of information to be filled in under the Acknowledge Alarm tab is only for log 
file purposes and can be replaced with placeholder information. For the Acknowledging 
Process Identifier, Event Object Identifier and Acknowledgment Source fields enter 
placeholder text such as “1”. 

3. Press both Time Stamp buttons and the Time Stamp window appears, enter placeholder 
text such as “1” in the Time field for both windows and press OK. 

4. For the Event State Acknowledged drop down select normal. 

5. Select the IP tab in the Acknowledge Alarm window and select the destination FACP 
using the Destination drop down menu. 

6. Press Send to Acknowledge the alarm.
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17.7.4 Monitoring Objects

Objects can be monitored by retrieving the current value of any property associated with an 
object. This is accomplished by sending read property commands. To send a read property to 
the FACP:

1. Navigate to the menu bar and select Send. From the drop down menu navigate to Object 
Access then Read Property. The Read Property dialogue box will appear. 

2. Under the Read Property tab press the ID button beside the Object ID field. The Object 
ID dialogue box appears. 

3. In this dialogue box select the Object Type using the drop down menu and enter the 
object’s BACnet ID under the Instance field. This is the ID described by the expression in 
section 17.2.2. 

4. Press OK and switch to the IP tab in the Read Property dialogue box. 

5. Select the destination FACP using the Destination drop down menu. 

6. Press Send to send the read property request. The request should be responded to by 
the FACP with information about the object in the main VTS window.

17.8 BACnet Discovery Tool

The BACnet Discovery Tool (BDT) is a tool for discovering and verifying objects on a BACnet 
server. The BDT can connect remotely and scan the system for all BACnet object. Object 
properties can also be discovery and, in some cases, changed through the BDT. The software 
is free and can be downloaded from http://www.ccontrols.com/sd/bdt.htm.

To install, unzip the downloaded package and run the BDT 2.03.00.exe program. If you are 
using Windows 7 or later the program must be run as Administrator to install correctly. When 
you start up the program it may warn you that the file has no valid digital signature. It is safe to 
ignore this warning and proceed.

If the BACnet network uses several subnets then you will need to input the IP address of the 
central BACnet/IP Broadcast Management Device (BBMD) to ensure that you see the entire 
network and all objects.

Figure 85 BBMD Address

To create a database of the objects in the BACnet network, press the “Search” button.

When the search is complete the main window will display all of the discovered objects with 
the following information,

• The Device Instance Number

Attention: The BACnet Discovery Tool using a BACnet/IP Who-is command and 
thus will not discovery any objects that that support only BACnet/
Ethernet identification.!
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• The Device Name
• The IP Address and UDP Port number
• The MS-TP Network number and MAC Address (for some devices)

Figure 86 BACnet Discovery Tool

Double click any discovered device to see a list of objects contained in that device. The Device 
name will appear at the top of the objects list and can be double clicked to display the Device 
Objects Properties window with more detailed information on the device. Any of the contained 
objects may be double clicked to open up the Object Properties window with more detailed 
information on the object. If the Write button is not greyed out you may set a Write Value and a 
Priority value for this object.

The “Scan” button starts a continuous scan of all devices and objects in the database, 
reporting their present values or logging errors if they fail to reply.
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18.0 Using the Web Server
The FleX-Net™ Web Server allows remote monitoring from any computer on the same 
network as the Fire Alarm Control Panel. The Web Server displays much of the same 
information that appears on any annunciator connected to the Fire Alarm Control Panel.

18.1 Setting up the Web Server

To set up the Web Server you must:

• Connect the Ethernet cable.

• Configure the Fire Alarm Control Panel.
• Ping the Fire Alarm Control Panel to verify the connection.
• Configure the web browser.

• Access the Web Server in the browser.

Follow the instructions below to complete these steps.

18.1.1 Connecting the Ethernet cable

Connect the Ethernet cable

1. Connect an Ethernet cable to the Ethernet port on the main board (MD-871A) of the 
node. The port is labelled P7 and is in the bottom left corner of the mounted board.

2. Connect the other end of the Ethernet cable to a computer, a router, or a switch.

18.1.2 Configuring the Fire Alarm Control Panel

You need to follow this procedure only for the node that is connected by Ethernet.

Configure the Fire Alarm Control Panel for the Web Server

1. Connect your computer to the Fire Alarm Control Panel, and then open the Configurator. 
See chapter 2 for details.

2. In the Configurator, open the version of the job that is active on the panel.

3. Select the Node that you connected the Ethernet cable to.

Note: You must purchase a Web Server license in order to use the Web Server. You 
must purchase a license for each job.

Note: Connect FleX-Net™ only over secure networks.

i

i
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The network node information appears on the right.

Figure 87 Web Services

4. Type the static IP address, subnet mask and default gateway. Each node on the TCP/IP 
network requires its own IP (Internet Protocol) address. The IP address must be unique 
to the node and it must not be used by any other device on the TCP/IP network.

If you need assistance, contact your network administrator.

5. Type a Username and Password in the appropriate fields.

6. Click Enable under Web Services.

7. Click the Activate Web Services button. You must have a CodeMeter key inserted in 
the computer.

8. Click Yes to transfer a Web Services license from your CodeMeter key to the 
Configurator, and then click OK in the Web Services Licence Imported window, and 
then click OK in the UnitCounter window.

9. Check Supervise Ethernet Connection if necessary. This will create a trouble event if 
the node does not detect an Ethernet connection.

10. Click Panel > Send Job to send the job to the Fire Alarm Control Panel.

Note: Your organization has a certain number of Web Services licenses. You can use 
only one Web Services license per job.i
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18.1.3 Pinging the Fire Alarm Control Panel

Before attempting to access the Web Server, ensure that there is a network connection 
between the computer and the Fire Alarm Control Panel.

Ping the Fire Alarm Control Panel

1. Click the Start button, click Run, type cmd.exe, and then press Enter.

2. In the command prompt window, type ping followed by the IP address of the node that is 
connected by Ethernet. For example, if the IP address is 10.10.0.1, then type:

ping 10.10.0.1

• If the ping is successful, then the computer can communicate with the node.

Figure 88 Successful ping

• If you see the message Request timed out, then the ping was not successful, and 
the computer cannot communicate with the node. Check the network connection 
and make sure that the computer and the node are on the same subnet and have 
different IP addresses.

Figure 89 Unsuccessful ping
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18.1.4 Web Browser Setup

Internet Explorer version 6 or later is recommended. You must configure it to not cache web 
pages.

Set up the web browser

1. In the Internet Explorer 6 menu bar, click Tools, then click Internet Options.

The Internet Options window appears. 

2. In the Browsing History section, click Settings.

The Temporary Internet Files and History Settings window appears. 

3. Select Every time I visit the webpage, and then click OK.

18.1.5 Accessing the Web Server

Access the Web Server

1. In the browser’s address bar, type the IP address of the node, followed by /index.html. 
For example, if the IP address is 192.168.0.1, then type

192.168.0.1/index.html

2. Press Enter.

A prompt to enter the user name and password appears.

3. Type the user name and password that you set up in section 18.1.2, and then press 
Enter.

You can now use the Web Server to monitor the Fire Alarm Control Panel remotely.

18.2 Using the Web Server

The Web Server displays information about the function and operation of the FleX-Net™ 
system. It allows you to access the FleX-Net™ system remotely for monitoring and 
troubleshooting.
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18.2.1 Queue Status

The Display Queue Status page shows the alarm, supervisory, trouble and monitor queues. 
To browse through these queues, click the corresponding button.

To view the Queue Status:

• Click Panel Information, and then click Queue Status.

Figure 90 Queue Status

18.2.2 Advanced Panel Info

The Advanced Panel Info page shows information about the CPUs connected to each node 
in the system, including the firmware version and the current job. For more information, see 
section 2.8 on page 21.

To view the Advanced Panel Info:

• Click Panel Information, and then click Panel Info.

Figure 91 Advanced Panel Info
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18.2.3 Configuration Status

The Configuration Status page shows a list of the nodes that comprise the FleX-Net™ 
system. The CPUs that are in use have a CPU number beside their associated node.

To view the Configuration Status:

• Click Panel Information, and then click Configuration Status.

Figure 92 Configuration Status
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18.2.4 Alarm Log

The Alarm Log page displays the list of all Alarms, including network and system restarts. You 
can save or print this log with the buttons at the top of the page. Note that there is a delay of a 
few minutes before the logs update. They are not updated in real time.

To view the Alarm Log:

• Click System Logs, and then click Alarm Logs.

Figure 93 Alarm Log
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18.2.5 Event Log

The Event Log page displays a list of all events, including troubles and alarms. You can save 
or print this log with the buttons at the top of the page. Note that there is a delay of a few 
minutes before the logs update. They are not updated in real time.

To view the Event Log:

• Click System Logs, and then click General Logs.

Figure 94 Event Log

18.2.6 TCP Socket Table

The TCP Socket Table page displays a list containing all the connections currently being 
made to the Web Server from remote locations. Each entry after the first represents a unique 
connection to the Web Server.

To view the TCP Socket Table:

• Click Network Status, and then click TCP.

Figure 95 TCP Socket Table
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18.2.7 UDP Socket Table

The UDP Socket Table page displays a list containing all the BACnet applications currently 
connecting to the FleX-Net™ system from remote locations. Each entry after the first 
represents a unique connection to the Web Server.

To view the UDP Socket Table:

• Click Network Status, and then click UDP.

Figure 96 UDP Socket Table

18.2.8 ARP, Routing and Device Tables

The ARP Table, Routing Table and Device Table contain information that aids network 
administrators in remotely monitoring, troubleshooting and configuring the network connection 
of the FleX-Net™ system.

To view the ARP Table:

• Click Network Status, and then click ARP.

Figure 97 ARP Table
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To view the Routing Table:

• Click Network Status, and then click ROUTE.

Figure 98 Routing Table

To view the Device Table:

• Click Network Status, and then click DEVICES.

Figure 99 Device Table

18.2.9 Current Level

The Current Level page monitors individual devices.

To view the Current Level:

• Click Current Level.

To add a device for current level monitoring:

1. Click the line for the device to be placed on in the Display Line No. pulldown menu.

2. Type the values for the node the device is on, the loop that it is on, and the device 
address in the Node No, Loop No, and Device Address fields.

3. Do one of the following:
• Click Add, and then type information for a second device.

Or
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• Click Start to begin monitoring. 

The Device Info window shows the current level readings and the percentage that the 
current level is at before it reaches alarm level at or beyond 100%.

Figure 100 Devices Info



131

19.0 Using the Configurator
19.1 Overview

The MGC Fire Detection and Mass Notification Configurator 2018 (the Configurator) is an 
application that lets you create and manage jobs. A job is a set of configuration data that 
uniquely describes and controls a set of Fire Alarm Control Panel hardware. The Configurator 
also allows you to send firmware to a panel and all its related nodes and CPUs.

You usually run the Configurator on a portable laptop computer that you take to the job site 
and connect to the panel. You prepare a job with the Configurator, then you send the job to the 
panel. Later, you or another authorised technician can retrieve the job from the panel, modify 
it, and send it back to the panel.

The Configurator stores jobs in a Microsoft Access relational database. Jobs can be imported 
or merged from another database, copied, deleted, and archived in various formats. A job can 
be printed, or two versions of a job can be compared.

19.2 User Preferences

The first time the Configurator starts, the User Preferences window appears.

Figure 101 User Preferences

User Name The creator of all new jobs and job versions.
Serial Port The serial port or USB port that the Configurator uses to 

connect to the panel.

Database Folder The folder where the main database file is stored. This is 
usually the folder where the configurator is installed.

Backup Folder The folder where backup database files are stored.
Job Edit Folder The folder where the job files are stored.
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19.3 Major Components of the Configurator Window

The Configurator window is divided into three panes.

Figure 102 Configurator

19.3.1 Job Tree

In the left pane, the job appears as a tree. At the highest level in the tree are the nodes and 
CPUs. Under each node are its components, for example annunciators and loop controllers. 
Some items are divided into other items. For example, an annunciator is divided into display 
adders and a loop controller is divided into loops.

Some items in the tree do not represent physical components. For example, items exist for 
input and output summaries, timers, and intervals.

19.3.2 Details Pane

The top right pane displays the details of the selected item in the tree.

19.3.3 Correlations Pane

The third pane displays correlations for the item selected in the Details pane. For example, 
when a loop is selected in the Job Tree, the Details pane shows all of its devices or circuits. 

Job Build Folder The folder where the C output files are stored.
Show Tools Menu Displays or hides a Tools menu. This menu contains trace 

and debug functions and features that are helpful to 
Technical Support.

Keep Only Latest Versions 
After Backup

If this option is selected, only the latest versions of all jobs 
will be kept after a successful Backup Database 
command. All older versions will be deleted.

Show Advanced Features If this option is disabled, some of the more advanced 
features are hidden.
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When one or more input circuits are selected in the Details pane, then the Correlations pane 
shows the output circuits they are correlated to.

19.4 Job Tree

The Job Tree lists the following items:

• Job Details

• Base I/O and associated Loops
• Main Display and associated Display Adders
• Common System Status

• Walk Test Areas
• Custom Timers
• Custom Intervals

• Equation Summary
• Input Summary

• Output Summary
• Node Grouping

Items representing the network nodes (for networkable products) and CPUs (for instance, 
main display, loop controllers, and annunciators) are at the highest level. You can expand 
these to show their sub-components, for instance, individual loops and display adders.

You can copy and paste items, and also drag and drop items, in the tree.
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19.5 Job Details

This section explains the options in the Job Details.

Figure 103 Job Details

See the Job Details

• Select the Job Details node (the highest node) in the Job Tree.

Job Info

The Job Info section shows details of the job's name, number, creation date and author, and 
any comments. Text in the Version field becomes part of the job’s version history.



Using the Configurator

135

Options

Two stage Select this check box to configure the system as a two 
stage system. If you do not select this, then the system is 
single stage.

As per UL 864 and UL 2572 only a setting of Single Stage 
(disabled) is permissible.

Fire drill Select this check box to enable the panel's Fire Drill 
switch.

Manual signal silence Select this check box to enable the panel's Signal Silence 
switch.

Style D (Class A) Conv 
Inputs

Select this check box to indicate that the panel has Style 
D (Class A) conventional inputs.

Style D (Class A) Input 
Modules

Select this check box to indicate that input modules' field 
wiring is Style D (Class A).

Style 6 and 7 (Class A) Loop Select this check box to indicate that the panel has Style 6 
and 7 (Class A) addressable loops.

Style Z (Class A) Fire Phone Select this check box to indicate that the wiring from an 
addressable fire phone module and the handset is Style Z 
(Class A).

Style 7 (Class A) Network Select this check box to indicate that the wiring between 
Network Nodes is Style 7 (Class A).

Digital Audio Select this check box to indicate that the audio signals 
use the ARCNet wiring between network nodes. If this 
option is not selected, then the audio runs over a separate 
pair of wires.

Digital Phone Select this check box to indicate that the fire phones use 
the ARCNet wiring between network nodes. If this option 
is not selected, then the phones communicate over the 
telephone bus terminals.

Single Trouble Bypass Setting this option will suppress troubles for ALL signal 
output circuits. Only the Signal Bypass switch active 
trouble will be generated by bypassing from a switch on a 
DSPL or IPS-2424 or IPS-4848DS.

Silence NAC Audibles Only If this check box is selected, all Alarm, Supervisory, 
Trouble, and Monitor zones with the NS flag will silence 
only audible signals when signal silence is activated.

Disable Waterflow Retard If this check box is selected, the retard timer for waterflow 
devices is disabled. The purpose of this check box is to 
accommodate sprinkler systems that already have a built-
in waterflow retard timer.

Subsequent Alarms: ONLY 
in Separate Zones

If this check box is not selected, then upon activation of a 
subsequent alarm for any device in any zone, the signals 
will re-sound. If this check box is selected, then upon 
activation of a subsequent alarm for only a device in a 
different zone, the signals will re-sound.

Monitor alert Select this check box to make an alert sound play when a 
monitor input activates.



136

Using the Configurator

Second stage alarm relay Select this check box to set the alarm relay to operate on 
a stage two alarm. This option is disabled unless Two 
stage is selected. As per UL 864 and UL 2572 only a 
setting of Disabled is permissible.

Relay follows node alarm Select this check box to set the alarm relay to activate on 
a node level alarm. If this option is not selected, the alarm 
relay activates on a system level alarm.

Relay follows node supv Select this check box to set the supervisory relay to 
activate on node level supervisory. If it is not selected, the 
supervisory relay activates on a system level supervisory.

Relay follows node trbl Select this check box to set the trouble relay to activate on 
node level trouble. If it is not selected, the trouble relay 
activates on system level trouble.

Drift compensation Select this check box to set the system to compensate for 
drift (buildup of dust in the detectors that can lead to 
inaccurate readings).

As per UL 864 and UL 2572 only a setting of Enable is 
permissible.

Device leds flash when 
polled

Select this check box to make the LEDs of addressable 
devices on the Base I/O's loop flash when polled.

Alarm Transmit Silence Select this check box to cause the Alarm Transmit and 
Auxiliary Alarm Relay to reset on Signal Silence rather 
than on the Reset switch.

Disable auto test Select this check box to disable the automatic testing of 
System Sensor addressable devices.

Auto All Call Select this check box to enable automatic all call when 
Press To Talk or a digital message switch is pressed.

Auto Page to Evac Select this check box to enable automatic page to evac 
when a microphone is keyed. This means that the page 
goes only to the amplifiers in the evac zone. If there is no 
alarm, then keying the microphone generates all call 
instead.

Enable Page Sw. Evac 
Annun.

Select this check box to enable Amplifier Evac/Alert 
Channel LED annunciation via the correlated Page Select 
Switch.

System Type Indicates the system type (compact or large) of the 
current Job.

Agency Select ULI Standard or ULC Standard.
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Signal Coding

Signal Rates

Node Control

Coded System Select this check box to enable coded system features. In 
a coded system, each input zone can be associated with 
a code, which is played on the signal and speaker circuits. 
The code indicates where the alarm has occurred.

Extended Code Select this check box to set the code pulse duration to 1/2 
second. If this is not selected, the code pulse duration is 
1/4 second.

Delay Code Select this check box to set the time between codes to 10 
seconds. If this is not selected, the time between codes is 
3 seconds.

Sound Evac after code Select this check box to make the system enter general 
alarm after the coded signals have finished playing.

Evac Choose the evacuation signal rate.
Alert Choose the alert signal rate.

Node Control Enable Setting this option enables the Node Control feature and 
makes available Control Transfer options (radio buttons), 
to allow the user to select which method of node control is 
desired. The default selection is Standalone/Degraded 
Mode. Controls that are to be restricted have the CR flag 
set in column F4. Controls without this flag set can be 
used on any node, regardless of control.

Standalone/Degraded Mode Restricted controls can be used freely on any node 
designated as a Primary node.

There may be multiple Primary nodes active at the same 
time.

Restricted controls become available to non-Primary 
nodes if they lose communication with all Primary nodes 
on the network.

Node Ctrl Switch Restricted controls can be used only on the in control 
node.

Only one node can be in control at a time.

Control is acquired, requested, and passed using node 
control switches on each node.
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Audio

Timers

Manual Key Enable Primary nodes can use restricted controls freely until 
control is passed to the Secondary node.

There can be any number of Primary nodes but only one 
Secondary node (which must be present).

The Secondary node can take control of the system with a 
switch, which disables access to restricted controls on all 
other nodes.

Restricted controls become available to non-Primary/
Secondary nodes if they lose communication with all 
Primary/Secondary nodes on the network.

Key Operation Momentary / Maintained key - defines a type of key switch 
for the Manual Key Enable feature.

Audio Set up Click Set up to determine how the Audio system will 
operate. See section 19.5.2 on page 141.

Auto GA On a two stage system, the stage one alarm (alert) will 
change to the stage two alarm (general alarm) after this 
amount of time.

Auto GA must be shorter than Auto Signal Silence.

Choose from 0-30 minutes or Disabled. To use this 
option, you must select Two stage above.

Auto Signal Silence This is the amount of time after which the alarm is 
automatically silenced. In a two stage system, the stage 
two alarm counts as a new alarm. For example, if Auto 
GA is set to 30 seconds and Auto Signal Silence is set 
to 1 minute, then the stage two alarm will be automatically 
silenced 1 minute after it starts (1.5 minutes after the 
stage one alarm started).

Auto Signal Silence must be longer than Signal Silence 
Inhibit and Auto GA.

Choose from 0-30 minutes or Disabled.
Signal Silence Inhibit While this timer is running, you cannot silence the alarm 

or reset the system.

Signal Silence Inhibit must be shorter than Auto Signal 
Silence.

Choose from 0-3 minutes.

As per UL 864 and UL 2572 only a Signal Silence Inhibit 
setting of 0 is permissible. See section 19.53 on 
page 208.
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New Alarm This feature is for suite silence configurations. This is the 
amount of time that the alarm plays on outputs correlated 
with the New Alarm Active Common System Status. 
After this amount of time, the alarm plays only on the 
outputs correlated with the zone or input that started the 
alarm.

For example, if you correlate the New Alarm Active 
Common System Status with all the suites in the building, 
then a new alarm will play in all the suites for this amount 
of time. After this time, the alarm with continue to play only 
in the suite that started the alarm (as well as outputs 
correlated with the Common Alarm Common System 
Status).

In a two stage system, suite silence is canceled when the 
stage two alarm starts.

As per UL 864 and UL 2572 the New Alarm Active 
Common System Status must not be correlated.

Choose from 10-120 seconds.

For more information, see section 19.53 on page 208.
Page Inhibit This timer is started by the first active alarm. Paging is 

inhibited while this timer is running. As per UL 864 and 
UL 2572 only a setting of 0 is permissible.

Choose from 10-120 seconds.

Powerfail Send Delay If the only trouble is an AC power failure, this is the 
amount of time after the power failure that the system 
delays transmission of status to the monitoring station. 
The default is 3 hours. The maximum time is 18 hours. 
See section 19.11 on page 155.

Proving Circuit Delay This timer is used for fan dampers. If the monitor inputs do 
not activate within the specified time (indicating that the 
fan has not started running, or the damper has not moved 
to its commanded position), then a trouble will be reported 
and LEDs associated with the fan damper switch will 
flash.

Choose from 5-90 seconds.
Auto Resound This timer specifies the time, in minutes, after which the 

signals will resound if an alarm remains un-
acknowledged. The default is 10 minutes. See section 
19.53 on page 208.

Choose from 5-12 minutes.

Node Ctrl active timeout This timer specifies the length of time, in minutes, that an 
in control node may be inactive before the network 
defaults back to the idle state.
Choose from 5-10 minutes.

Node Ctrl request timeout This timer specifies the length of time, in seconds, that a 
request for control remains active if it is not granted.

Choose from 30-60 seconds.
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Date and Time 

19.5.1 Sync Enable

This feature provides a way to synchronize the time on FleX-Net™ once a day. It requires an 8 
input adder (DM-1008A) installed on Loop 0. The Type of one of the inputs must be configured 
as Sync Input as shown in Figure 104.

Figure 104 8 input adder with the first input configured as Sync Input

When this input is activated, the time on FleX-Net™ is set to the time specified in the Sync 
Enable section of the Job Details window. Only the hours and minutes can be set.

The signal must be a momentary dry contact closure of at least 3 seconds duration.

Daily clock adjustment The number of seconds (positive or negative) by which 
the system adjusts the panel's clock every 24 hours. The 
adjustment happens at 01:55 every day.

Enable Daylight Saving Enables automatic change to and from daylight saving 
time.

Enable Auto After Hours Specifies when the system automatically goes into After 
Hours mode. If After Hours mode is enabled, then you can 
change the detector sensitivity for the times designated as 
After Hours (because there will be fewer people in the 
facility, the sensitivity might need to be higher).

Holidays A list of the defined holidays, when the system will go into 
After Hours mode.

Reprogram Holiday Trouble Select this check box to put the system into trouble when 
there are no future holidays programmed. Specify the 
date after which there are no programmed holidays. The 
system will be in trouble until more holidays are added, or 
until the check box is unselected.

Sync Enable See section 19.5.1.
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19.5.2  Audio Setup

This section explains the options in the Audio Setup window, which lets you choose how the 
audio components of the network will operate.

See the Audio Setup window

• In the Audio section of the Job Details window, click Set up.

The Audio Setup window appears.

Figure 105 Audio Setup

Signal Tones and Messages

The Signal Tone and Messages section allows you to set the tone or message that will be 
played under different event conditions. The Manage Messages button takes you to the 
Manage Messages screen (section 19.5.3 on page 142) where you can work with the 
catalogue of digital messages available for selection here.

Alert Click on the ellipsis to bring up the Choose a Message 
version of the Manage Messages window. Select the 
tone or message that you want played when the system is 
in the Alert (Stage 1) state. (The Built In message 
Temporal is selected by default.)

Evac Click on the ellipsis to bring up the Choose a Message 
version of the Manage Messages window. Select the 
tone or message that you want played when the system is 
in the Total Evacuation (Stage 2) state. (The Built In 
message Evac is selected by default.)

Manage Messages Click on the Manage Messages button to open the 
Manage Messages window, where you can manage your 
catalogue of digital messages. See section 19.5.3 on 
page 142.
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General Settings

The settings between the Signal Tones and Messages section and the Push to Talk Priority
section allow you to customize different aspects of the system’s behaviour when paging.

19.5.3 Manage Messages

This section explains the options in the Manage Messages window, which lets you manage 
your catalogue of digital messages.

See the Manage Messages window

• In the Signal Tones and Messages section of the Audio Setup window, click Manage 
Messages.

Sound pre-announce tone 
when paging

When checked, a 900Hz pre-announce tone sounds 
(using the Page channel) for 2 seconds before the paging 
source is applied. This special tone will un-silence 
speakers that are currently silenced.

Disable Audio 
Synchronization

When checked, audio synchronization between nodes is 
disabled. When unchecked audio is synchronized 
between the nodes.

Paging has priority over 
automatic alarm

When checked, a page will be heard over an active Alarm. 
When unchecked, Alarms will block Pages.

Splitter Circuit Operation When checked, the Configurator supports the advanced 
features of class D amplifiers.

PTT Released Delay If strobes are correlated to the Page Ready status, such 
that they operate when PTT is pressed, they will continue 
to operate for the specified number of seconds after PTT 
is released, if a non-zero delay is configured.

Digitized Message Delay This will cause a delay (in seconds) on the deactivation of 
the node and common Page Ready status when PTT is 
released or when a message playing on the paging 
channel ends. The statuses can be used to delay strobe 
de-activation.

Push to Talk Priority This section contains 2 radio buttons. Choose between 
None (first come, first served) and Lowest Node ID, where 
the PTT on the lowest addressed network node has 
priority over all others.
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The Manage Message window appears.

Figure 106 Manage Messages

The columns in the Manage Messages window are described below.

The buttons in the Manage Messages window are described below.

Msg No This column shows a number for each digital message. 
There are 8 Built-in messages that are uneditable, 
unremovable, and have their Message Numbers 
preassigned. Custom Messages are assigned numbers 
from 0 to 95 as you create them.

Description This column shows the label assigned to the message in 
the Tag box of the Audio Message Composer window. 
See section 16.0 on page 100.

Type This column shows whether the message is a Built-in or a 
Custom message. You can create up to 96 Custom 
Messages. Built-in messages cannot be edited or 
removed.

Add Click this button to open the Audio Message Composer. 
See section 16.0 on page 100.

Edit / View If the current job is writable, this button is labeled Edit. 
Click this button to edit the selected Custom Message in 
the Audio Message Composer.

If the current job is not writable, this button is labeled 
View. Click this button to view the selected Custom 
Message in the Audio Message Composer. You cannot 
edit the Custom Message, but you can click the Play 
button to listen to it.

This button is disabled when a Built-in message is 
selected.
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19.5.4 Holidays

During a holiday, the system goes into After Hours mode. You can add and remove holiday 
definitions.

Add a new holiday

1. Click Enable Auto After Hours at the bottom of the Job Details.

2. Click Modify.

The Holidays window appears.

Figure 107 Holidays

3. Compose a new holiday definition in the YYYY MM DD edit boxes.

4. If the holiday lasts longer than one day, type the number of days in the Duration field.

5. Click Add Holiday.

The holiday appears in the Holidays defined list.

Remove Click this button to delete the selected digital message. A 
window appears, asking if you are sure you want to delete 
this digital message. Click Yes to permanently delete the 
selected message. Be sure that you have the correct 
message selected.

This button is disabled when a Built-in message is 
selected.

Copy Click this button to copy the selected digital message. A 
window appears, asking for a name for the copied file. 
Enter the name and click OK. A new custom Message 
appears in the list with the new name. The new message 
is a copy of the selected digital message.

This button is disabled when a Built-in message is 
selected.

Close Click this button to close the Manage Messages window.
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Specify a holiday that recurs once a year

• Type 9999 in the YYYY field.

For example, type 9999 01 01 for New Years Day. 

Specify a holiday that recurs once a month or once a day

• Type 99 in the MM or DD field.

For example, type 9999 99 01 to specify that the first of every month is a holiday.

Type 9999 07 99 to specify that the plant is shut down every day in July for summer 
vacation.

Change the duration of a holiday

By default the holiday has a Duration of 1 day. Change this to specify a longer holiday.

• Type 9999-12-25 2 to specify a two day break beginning on December 25th.

Remove a holiday

• Select the date in the Holidays defined list, and then click Delete Selected Holiday.

19.6 Network Node

Add a network node

1. Click Insert in the menu bar, then click Add Network Nodes.

The Add Network Node window appears.

Figure 108 Add Network Node

2. Type the number of nodes that you want to add in the Number to add field.

3. Type a description for the new node or nodes in the Tag field.

4. Click Add, and then click Close.

Note: Make sure that your holidays do not overlap.i
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See the Network Node Details

• Select a node in the Job Tree.

Figure 109 Network Node Details

Alternate Ground Fault 
Detection

If you select this check box, the system will use alternate 
ground fault detection settings to compensate for the 
capacitance and resistance of long audio cable runs. See 
section 12.5 on page 88.

Two Stage Check to enable two stage.

As per UL 864 and UL 2572 only a setting of Single Stage 
(disabled) is permissible.

Day Light Savings Daylight savings is configured on the Job Details screen 
(section 19.5 on page 134).
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Primary Node If you select this check box, this node is the Primary Node 
in a transfer of control application.

Default Priority Ctrl If you select this check box, this node is in control by 
default at system startup. Primary Node must also be 
selected. The feature is available only in the Node Ctrl 
Switch mode of transfer of control.

Secondary Node If you select this check box, this node is the Secondary 
Node in the Manual Key Enabled mode of transfer of 
control. A node cannot be both a Primary Node and a 
Secondary Node.

Tag A description of the node. This appears in the Job Tree.
Node Address The node address.
IP Address The IP (Internet Protocol) address of this node's Ethernet 

connection.

Subnet mask Identifies which network segment the node is on.
Default gateway The address of the local IP router that forwards traffic 

outside of the local network.

Supervise Ethernet 
Connection

If you select this check box, then a trouble is reported if no 
Ethernet cable is connected to the node.

Graphics Workstation Select Enable to allow FleX-Net™ to communicate with 
OpenGN.

If Supervise Connection is selected, then FleX-Net™ 
reports a loss of connection with OpenGN as a trouble on 
the annunciators.

Web Services Select Enable and click Activate Web Services to turn on 
the Web Server. This allows you to access the system 
with a browser. See section 18.0 on page 120.
Enter the User Name and Password required to access 
the node's web server. The default username is admin 
and the default password is mircom.
If the username and password are changed, the changes 
will be applied to all nodes in the job. If new nodes are 
added or copied from this node, they will have the same 
username and password as the existing nodes.

BACnet Select Enable and click Activate BACNet to allow the 
node to run a BACNet (Building Automation and Control 
Networks) Server. See section 17.0 on page 107.
Model Name: BACNet Model Name.
Description: BACNet Description.
Location: BACnet location. This is the first 25 characters 
of the Job Name. You can change it.
Device Name: BACnet Device Name.
Device ID: The BACnet ID for the entire fire alarm system.
Base ID: The starting ID for all BACnet objects. These are 
the circuits, switches and system statuses of the 
configured job.
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19.7 Base I/O

See the Base I/O

Select Base I/O in the Job Tree under Node.

These items override the attributes on the Job Details page.

Figure 110 Base I/O

Style D (Class A) Conv 
Inputs

Select this box to indicate that the Base IO has Style D 
(Class A) conventional inputs.

Style D (Class A) Input 
Modules

Select this box to indicate that the Base IO's input 
modules' field wiring is Style D (Class A).

Style 6 and 7 (Class A) Loop Select this box to indicate that the Base IO has Style 6 
and 7 (Class A) addressable loop(s). 

Style Z (Class A) Fire Phone Select this box to indicate that the wiring from an 
addressable fire phone module and the handset is Style Z 
(Class A).

Second stage alarm relay Select this box to set the alarm relay to operate on second 
stage alarm. Disabled unless Two Stage checked.

Common alarm relay 
follows node alarm

Select this box to set the alarm relay on this node to 
activate on node level alarm. Mutually exclusive with 
Second stage alarm relay.

Common supv. relay follows 
node supv

Select this box to set the Supervisory relay on this node to 
activate on node level supervisory.
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19.8 Main Display / LCD Annunciator

Add an annunciator

1. Select the node that you want to add an annunciator to.

2. Click Insert in the menu bar, then click Add Annunciators.

The Add Annunciator window appears.

Figure 111 Add Annunciator

3. Select the type of annunciator that you want to add from the Type pulldown menu.

4. Type the number of annunciators that you want to add in the Number to add field.

5. Type a description for the new annunciators or annunciators in the Tag field.

6. Click Add.

The Configurator adds the annuciators.

If the number of annunciators that you selected exceeds the maximum number of 
annunciators allowed on this node, a message appears saying that the Configurator 
cannot add some of the CPUs.

7. Click Close.

Common trouble relay 
follows node trbl

Select this box to set the Trouble relay on this node to 
activate on node level trouble.

Device LEDs flash when 
polled 

Select this box to indicate that the LEDs of the 
addressable devices on this loop flash when polled.

Strobe Choose the brand or manufacturer of the strobes that are 
installed on this node. This ensures that the correct 
synchronization sequences are sent to the strobe.

CLIP/Advanced Protocol 
Address Space 

Defines the address boundary between CLIP devices and 
Advanced Protocol devices.

• AP Start: Enter the starting address of the AP 
devices on the loop. The addresses below this entry 
are allocated for CLIP devices and the addresses 
above and including this entry are allocated for AP 
devices. Valid AP Start values are 001 to 100. See 
section 19.14 on page 161.
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See the main display or LCD annunciator details

• Select a main display or annunciator in the Job Tree.

Figure 112 Main Display

Options

Supervise Printer Select this check box to make the system report a trouble 
if the printer is disconnected.

Report Form Feed
Manual Enable on Menu Select this check box to add a Manual Control Enable 

option in the display’s menu. Manual Control Enable lets 
you enable manual control on a node. When manual 
control is enabled on a node, then the master microphone 
or master telephone work for that node only. This lets you 
limit the use of the master microphone and master 
telephone to one node.

Node Control on Menu Select this check box to unlock control switches at non-
primary nodes. This option can be password-protected 
with the Node Control option under Access Levels 
(section 19.8.3 on page 152).
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System Messages

There are three 20 character text fields for the System Normal Message, and three 20 
character text fields for the After Hours Message.

Locale

Low Power Lamptest Select this check box to turn the LEDs on in groups rather 
than all at the same time when you perform a lamp test.

Ring Telephone Buzzer Select this check box to make the buzzer on this CPU ring 
for incoming calls.

Ring buzzer on this CPU Select this check box to allow you to configure (enable/
disable) the buzzer on Network masters and Rem. 
Annunciators.

Print Colour Select the colour to print log items in. Make sure that the 
printer can print in colour.

• Black

• Red for alarms only

• Multi colour (a different colour for alarm, supervisory, 
monitor, and trouble events)

The Configurator cannot verify that the printer can support 
the selected option.

Language Select the language for this annunciator. The system uses 
this language for any messages. The Main Display's 
language is the default language for other annunciators 
that are added to the job. You can have a mix of English 
and French annunciators.

For Eng/Arabic and Eng/Hebrew, the language before 
the slash is the language for the messages, and the 
language after the slash is the language for the tags, 
which are set in the list view for the device.

The main display does not support either Arabic or 
Hebrew. If you want the system to show only Arabic or 
Hebrew, either delete the main display, or physically hide 
it from view, and use a remote annunciator (with Arabic or 
Hebrew tags) in it place.

Time Format Select the time and date format. The system uses this 
format for all time reporting for this annunciator.

Use alternate tags Select this check box to have the display use the alternate 
(secondary) tags. You can use this feature to show tags in 
a different language on designated displays. Alternate 
tags can be entered in the list view for the device. The 
tags can be in a different language from the primary tags, 
but must use characters from the same code page.
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19.8.1 Passcodes
This section appears on the main display only.

Figure 113 Passcodes

Set or change the passcodes

• Type the passcodes for three levels of access. Passcodes must consist of the digits 0, 1, 
2, and 3 only.

On the main display, the queue buttons function as passcode buttons:

• ALARM: 0
• SUPV: 1
• TROUBLE: 2

• MONITOR: 3

Enter a passcode on the main display

1. Press the queue buttons corresponding to the numbers. For example, to enter the 
passcode 2222, press the TROUBLE QUEUE button 4 times.

2. Press the ENTER button.

19.8.2 Main Display

There are three types of Main Display supported on the FleX-Net™ panel.

Change the type of main display

1. Select the type of main display in the Type menu.

2. Click Yes.

19.8.3 Access Levels

Specify the level of access for various panel actions. 

• 0 means that the panel operator does not need to enter a passcode.

Table 26 Displays

Name Name in the Configurator

DSPL-420-16TZDS 4x20 C/W 16 LED

DSPL-420 or DSPL-420DS 4x20 (Default)

DSPL-2440 24x40 Graphic
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• 1 means the operator must enter the code specified for Level 1, in the Passcodes 
section.

• 2 means the operator must enter the code specified for Level 2, in the Passcodes 
section.

• 3 means the operator must enter the code specified for Level 3, in the Passcodes 
section.

The permissions given to each passcode apply to the levels under it. For example, an operator 
who has the Level 3 passcode has access to the actions assigned to Levels 2 and 1.

19.9 Remote CPU

This section appears on remote annunciators only.

Figure 114 Remote CPU

19.10 Display Adder

Add a display adder

1. Select the annunciator or display adder that you want to add a display adder to.

2. Click Insert in the menu bar, then click Add Display Adder.

The Add Display Adder window appears.

Figure 115 Add Display Adder

3. Select the type of display adder that you want to add from the Select Adder Type 
pulldown menu.

4. Select the header (connector) in the Select Header pulldown menu.

Tag Type a tag for the annunciator. The tag appears in the Job 
Tree.

CPU Address Select the remote CPU number for the remote 
annunciator.
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5. Click Add.

The Configurator adds the display adder.

If the frame limit for the annunciator you are adding to is exceeded, an error message 
appears. A frame is a measure of display capacity. See LT-894 FleX-Net™ Installation 
and Operation Manual for information about how many frames each annunciator has 
available, and how many frames each display adder uses.

6. Click Close.

View the display adder

• Select Display Adder in the Job Tree.

Table 27 describes the columns in the display adder view.

Table 27 Display Adders

Name Description

Idx The zero based position of the item on the adder.

Unnamed

Linked Item - contains an asterisk if the item shares the same LedGrp with 
other items. This means that correlations to one such item are added to all 
linked items. Linked Items can be created when Paste Special is used. The 
linked items can be viewed with the Linked Items dialog.

Type The type of display item.

Assignment Dependent on the Type.

Node Group

Applies only to common control switches. The column displays the Node 
Group to which the common control operation is to be limited. Global 
means that the operation is system wide and is the default. If the user has 
created Node Groups, then one of those groups can be chosen. The 
common control then applies only to the member nodes of that group.

Priority

Specifies the priority to be given to digitized messages correlated to 
correlatable switches. Choose from a range or priorities. 19 (lowest) 
through Normal (default) to +19 (Highest). Activation of a switch with a 
higher priority will cause its message to be played, and any lower priority 
message will cease to play.

In a combined fire and Mass Notification System (MNS) installation, 
choose appropriate priorities. For example, if risk analysis has determined 
that MNS has priority over fire, assign a higher priority to all MNS digitized 
message switches. Within MNS relative priorities can be set, so that higher 
priority messages will have precedence over lower priority messages.

Code If the Type is Zone Switch and Coded System is specified, then Code is 
displayed and editable as for an Input Circuit. 

F1 If the item is a switch, then this column can be set to ER (enable required), 
meaning that it requires a passcode.

F2 For bypass and manual switches, this column can be set to AR (Aux Reset 
Required). For correlatable switches it can be set to NS (non-silenceable) 

F3
For correlatable switches this column can contain GA (stage two, general 
alarm device). For bypass and manual push switches, it can be set to SR 
(System Reset Required).



Using the Configurator

155

19.11 UDACT

A UDACT (Universal Digital Alarm Communicator/Transmitter) is a device that communicates 
alarms to a central monitoring station using the Contact ID or SIA communication formats.

The dialer can dial out on two phone lines. You must configure an account and specify the line 
attributes for both. Line 2 can dial a cell phone. If this is the case the auto test can be reduced 
from daily to monthly.

Add a UDACT

1. Select the node that you want to add a UDACT to.

2. Click Insert in the menu bar, then click Add UDACT.

The Add UDACT window appears.

Figure 116 Add UDACT

3. Select Contact ID, SIA300 or SIA110 in the Report Format menu.
4. Select Auto Assign if you want to assign a UDACT group of the correct type to every 

input zone and output circuit.
5. Click Add.

F4

The CR flag lets you define which switches are locked when Node Control 
Enable is selected. If the CR flag is not set, then the switch is always 
unlocked.

The CR flag on a switch with the Type Common Ctrl is propagated to all 
other occurrences of the same switch in the network. For example, if you 
set the CR flag on the System Reset switch on one display adder, all 
System Reset switches in the network automatically have the CR flag.

Switches that are not Common Ctrl switches are not propagated. For 
example, a paging switch or a bypass switch can be configured to require 
control on one node, but to always allow operation on a different node, 
regardless of which node has control.

Tag 1
Except for Common Controls, System Status and Man Ena, a 20 character 
tag can be entered. It will be used to identify the control in messages. For 
some Type/Assignment combinations the tag cannot be edited.

Tag 2 Correlatable Switches (being analogous to Input Zones) accept a second 
line of 20 characters.

Table 27 Display Adders (Continued)

Name Description
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View the dialer

• Select Dialer in the Job Tree.

Figure 117 Dialer

Get the configuration information

• Click Get.

The Sent/received field will tell you if the configuration is out of date.

Automatically assign a UDACT group to every unassigned zone and output circuit

• Click Auto-Assign.

Account

Note: If you use advanced addressing, then you do not need to use Auto-Assign.

Account ID Six digit decimal for the SIA report formats and four digit 
hexadecimal for Contact ID.

Telephone The telephone number.
Report format Choose SIA110, SIA300, or Contact ID.

i
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Line

Attached Fire Alarm

Report Priority

Timers

Dial Using Select Tone or Pulse.

Wait for dial tone before 
dialing

Select this check box if you want the dialer to wait for a 
dial tone before dialing.

Communication Protocol Level 0, Level 1, Level 2 or Level 1G. Only Level 2 
(FX2000) is appropriate.

Checksum 8 Bit / 16 Bit. For FX2000 16 bit is appropriate.

Event Specifies whether the internal Ckt No or a combination of 
Loop and Address is sent to the monitoring station.

Output 0-9999. This value is added to outputs to differentiate 
them from inputs with the same Ckt No.

Alarm Select the account that will report alarms.
Supervisory Select the account that will report supervisory alerts.
Trouble Select the account that will report trouble alerts.

AC loss delay If there is a loss of AC power, the dialer waits this amount 
of time before calling the monitoring station.

Line 2 cellular test If this check box is unselected, then there is no test 
reporting for a cell phone, or the phone line is a regular 
line. Select this check box to set the test report date for 
the cell phone setup. Set the Day of month from 01 to 28 
to schedule a test for Line 2 on a certain day of the month. 
See section 19.11.1 on page 159 for more information.

When a cell phone service is employed for the panel, it 
should only be connected to telephone line #2 CO 
interface. Also, the dial tone detection feature of Line 2 
should be disabled for cell phone application.



158

Using the Configurator

Dialer

Configure the dialer with the Configurator

1. Remove the UIMA4 cable from the FX-2000N panel and plug it directly to the dialer.

2. Short the jumper marked JW2 on the dialer.

Auto test Use this function to set the time for the automatic test. 
When this test is performed, the test report is sent to the 
monitoring station. This test must be performed at least 
once a day.

The Auto test time can be configured to:

12:00 a.m. to 5:59 a.m.: test every 24 hours

6:00 a.m. to 11:59 a.m.: test every 6 hours

12:00 p.m. to 23:59 p.m.: test every 12 hours

If Line 2 cellular test is unselected, then the test 
alternates between Line 1 and Line 2. See section 
19.11.1 on page 159 for more information.

To minimize receiver congestion, do not use the 
following test times: 12:00 a.m., 01:55 a.m., 02:00 a.m. 
and 03:00 a.m.

Line retries Select the number of retries that you want the dialer to 
make.

Rings You can program the dialer remotely over a phone line. 
Select the number of rings before the dialer answers 
when you call it.

Warning: If this is set to zero the next dial-in session will 
not connect.

Mode Select DACT or UDACT. The UDACT mode includes 
information about the zone when the dialer calls the 
monitoring station.

Enable Unselect this check box if you want to set the dialer to the 
disabled state when you send the job to the panel. The 
dialer is enabled by default.

Aux disconnect The dialer blocks the alarm and supervisory events from 
being reported after the auxiliary disconnect button is 
pressed.

Advanced Addressing Enables the use of a conversion formula to transmit Node, 
Loop and Device Address information in Contact ID 
protocol. The receiver must also have conversion 
software to properly display the additional information.

Advanced CID Report If Advanced Addressing is selected, click this button and 
select a location to save a report of all the points on the 
system. This report can be used to inform the Central 
Station of the Node, Loop, Absolute Address, CID String, 
and Tag for each point.

The file name is JobName_JN-JV.csv where JN is the 
job number and JV is the job version.
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3. Edit the dialer parameters, described above, and press the Send button.

4. Type your password.

19.11.1 Line 2 Cellular Test and Auto Test

If Line 2 cellular test is unselected, then the dialer alternates between Lines 1 and 2 when 
performing the automatic test. If Line 2 cellular test is selected, then the automatic test is 
performed on Line 1 except on the Day of month specified under Line 2 cellular test, when it 
is performed on Line 2. See examples in Table 28.

19.12 Addressing Formats for Devices

The Configurator uses different kinds of addresses for different devices to avoid conflicts. The 
different types of addresses are described below.

• nn – a two digit number is the legacy addressing format for a CLIP sensor.
• 1nn – a two digit number with a 1 in front of it is the legacy addressing scheme for a 

CLIP module. The two digits after the 1 represent the address physically set on the 
device’s dials.

• nn.1nn – a two digit number followed by a dot followed by a number starting with 1 is the 
new addressing scheme for the virtual device of a dual address CLIP module (like the 
Dual COPTIR). The two digits after the 1 represent the address physically set on the 
device’s dials.

Table 28 Line 2 Cellular Test and Auto Test

Line 2 Cellular 
Test

Day of month Auto Test Line 1 Tested Line 2 Tested

unselected NA 12:30 a.m.

12:30 a.m. every 
other day 
(alternates with 
Line 2)

12:30 a.m. every 
other day 
(alternates with 
Line 1)

unselected NA 6:00 a.m. 6:00 a.m. and 6:00 
p.m.

12:00 p.m. and 
12:00 a.m.

unselected NA 12:00 p.m. 12:00 p.m. 12:00 a.m.

selected 15 12:30 a.m.
12:30 a.m. every 
day except on the 
15th of the month

12:30 a.m. on the 
15th of the month

selected 15 6:00 a.m.

6:00 a.m., 12:00 
p.m., 6:00 p.m., 
and 12:00 a.m. 
every day except 
on the 15th of the 
month

6:00 a.m., 12:00 
p.m., 6:00 p.m., 
and 12:00 a.m. on 
the 15th of the 
month

selected 15 12:00 p.m.

12:00 p.m. and 
12:00 a.m. every 
day except on the 
15th of the month

12:00 p.m. and 
12:00 a.m. on the 
15th of the month
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For example, a Dual COPTIR at address 1 has 2 entries:

1 COPTIR

1.101 COPTIR “B”

1.101 represents the address of the virtual device.
• Snnn – a three digit number with an S in front of it is the addressing scheme for an AP 

sensor. The three digits after the S represent the address physically set on the device’s 
dials.

• Bnnn – a three digit number with an B in front of it is the addressing scheme for a 
sounder base or relay base attached to an AP sensor. The three digits after the B 
represent the address physically set on the device’s dials.

• Mnnn – a three digit number with an M in front of it is the addressing scheme for an AP 
module. The three digits after the M represent the address physically set on the device’s 
dials.

• Vnnn – a three digit number with a V in front is the addressing scheme for a virtual 
device attached to an AP sensor. The three digits after the V represent the address 
physically set on the device’s dials.

• Wnnn – a three digit number with a W in front is the addressing scheme for a virtual 
device attached to an AP module. The three digits after the W represent the address 
physically set on the device’s dials.

• Wnnnn – a four digit number with a W in front is the addressing scheme for virtual 
devices attached to an AP module that requires more than one virtual device. The first 
three digits after the W represent the address physically set on the device’s dials and the 
fourth digit represents the virtual device’s sub address.

19.13 Adding a Device

You can add input devices (for example, manual stations or smoke detectors) to a device loop.

Add a device

1. Select the loop that you want to add a device to.

2. Click Insert in the menu bar, then click Add Device.

The Add Device window appears.

Figure 118 Add Device
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3. Select the type of device from the Type menu.

4. Select the subtype of device from the SubType menu. The subtype is used by OpenGN.

5. Select the address for the device in the Address field. The default is the lowest available 
address for the selected type.

6. Type the number of devices to add in the Number to add field. The Configurator will 
give addresses to the devices sequentially, starting with the address you selected.

7. Click Add.

If there are not enough addresses, a message appears giving you three options.

• Click Yes to continue. The Configurator will add the remaining devices where empty 
addresses exist.

• Click No to stop. The Configurator will stop adding devices. A second message will 
appear saying how many devices were successfully added.

• Click Cancel to cancel the whole procedure. The Configurator will not add any 
devices at all.

8. Click Close.

19.14 Setting the Start of AP Address Space

By default, the addresses 1 to 99 are reserved for CLIP devices, and the addresses 100 to 
159 are reserved for AP devices. The beginning of AP space can be lowered. For example, if 
you are planning to use only AP devices, then you can change these settings so that the 
addresses 1 to 159 are reserved for AP devices and no addresses are available for CLIP. The 
values reserved for each type of device can be set differently for each loop.

Change the start of AP space on loop 2

1. Select Base I/O in the job tree.

The CLIP/Advanced Protocol Address Space section appears (Figure 119).

2. Change the start of the AP addresses in the AP Start menu.

The addresses below this number are allocated for CLIP devices and the addresses 
above and including this number are allocated for AP devices.

The 2 columns to the left show the available range of addresses for CLIP sensors and 
modules. The 2 columns to the right show the available range of addresses for AP 
devices, which depends on the number in the AP Start menu.

Figure 119 CLIP/Advanced Protocol Address Space
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Change the start of AP space on another loop

1. In the Job Tree, select the Quad Loop Adder that contains the loop that you want to 
change.

The CLIP/Advanced Protocol Address Space section appears (Figure 120). There are 
four rows, one for each loop on the Quad Loop Adder. If there is no daughter card on this 
Quad Loop Adder, then the last two rows are greyed out.

2. Change the start of the AP addresses in the AP Start menu.

The addresses below this number are allocated for CLIP devices and the addresses 
above and including this number are allocated for AP devices.

The 2 columns to the left show the available range of addresses for CLIP sensors and 
modules. The 2 columns to the right show the available range of addresses for AP 
devices, which depends on the number in the AP Start menu.

Figure 120 CLIP/Advanced Protocol Address Space for a quad loop adder

19.15 Adding an AP Detector

The procedure for adding an AP detector is the same as adding any other device, as 
described in section 19.13 on page 160, with the following differences.

When you add some AP detectors (for example the Photo (AP)), you have the option to add a 
special base to the sensor head. The Configurator supports sounder bases and relay bases as 
alternatives to a standard base.

• To add a standard base, select NAB (Non-Addr. Base) from the Options menu.
• To add a sounder base, select ASB (Addr. Sounder Base) from the Options menu.

• To add a relay base, select ARB (Addr. Relay Base) from the Options menu.
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Figure 121 AP base selection

When you add an AP detector, the default address is the lowest available address for AP 
devices. The address has the prefix S. If there is an associated relay base or sounder base, 
the base has the same address with a B prefix. For example, a Photo (AP) at address S100 
has a sounder base at address B100.

Figure 122 Photo (AP) device with the address 100

19.15.1 Removing a Sounder Base from an AP Device

If AP devices are being used without sounder bases, you can remove the virtual device 
sounder base that was automatically added with the AP device.

Remove a sounder base

1. Select the sounder base in the Configurator.

2. Press Delete on the keyboard.

3. Click Yes to confirm.

4. Repeat these steps for every sounder base that you want to delete.

Note: Only AP devices that are branded as Mircom, Secutron, or System Sensor will 
work properly with a FleX-Net™ system. Other brands of sensor will not work 
consistently or at all.

Note: If you remove a sounder base from an AP device, it cannot be restored. In order 
to restore the sounder base, you must delete the whole device and add it again.

i

i
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19.16 Adding a Dual Sensor Device

The procedure for adding a dual sensor device is the same as adding any other device, as 
described in section 19.13 on page 160. Dual sensor devices can be used with a relay base or 
a sounder base, as described in section 19.15 on page 162.

When you add a dual sensor device, a second virtual address is automatically created for the 
additional sensor. The virtual device has the same address as the primary sensor, but with a V 
prefix.

For example, a Fire-CO (AP) device with the address 100 has the following entries:

• Fire-CO (AP): S100
• Fire-CO “B” (AP): V100

• Sounder Base (AP) or Relay Base (AP) if selected: B100

Figure 123 A Fire-CO (AP) device with the address 100

19.17 Adding a Dual Heat Photo Sensor with 90 °F and 135 °F 
Thresholds

When you add a Dual Heat Photo (AP) to the Configurator, it is added as 1 real device and two 
virtual devices. All the devices have the same number for their address, but the real device’s 
address has the prefix S. The virtual devices have the prefix V and a numeric suffix after the 
address, starting at 1.

For example, a Dual Heat Photo with the address 100 has the following entries.

• Dual Heat Photo (AP): S100 (active on smoke only)
• Dual Heat Photo “B” (AP): V1001 (active when the temperature 90 °F or higher but 

lower than 135 °F)
• Dual Heat Photo “C” (AP): V1002 (active when the temperature is 135 °F or higher)

Figure 124 A Dual Heat Photo device with the address 100

19.18 Adding a Dual Module Device

Some AP devices (for example, the Dual Monitor (AP)) have an additional input. When you 
add a dual input device to the Configurator, it is added as 1 real device and 1 virtual device. 
The primary and secondary devices have the same number for their address, but the primary 
device’s address has the prefix M and the secondary device’s address has the prefix W.

For example, a Dual Monitor (AP) device with the address 100 has the following entries:
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• Dual Monitor (AP): M100 (primary input)
• Dual Monitor “B” (AP): W100 (secondary input)

Figure 125 A Dual Monitor (AP) device with the address 100

19.19 Adding a Multiple Module Device

Some AP devices (for example, the Six Relay (AP) and the Ten Monitor (AP)) have multiple 
additional modules. When you add a multiple module device to the Configurator, it is added as 
1 real device and a number of virtual devices. All the devices have the same number for their 
address, but the primary device’s address has the prefix M. The virtual devices have the prefix 
W and a numeric suffix after the address, starting at 1.

For example, a Six Relay (AP) device with the address 100 has the following entries:

• Six Relay (AP): M100 (primary relay)
• Six Relay “B” (AP): W1001 (second relay)
• Six Relay “B” (AP): W1002 (third relay)

• Six Relay “B” (AP): W1003 (fourth relay)
• Six Relay “B” (AP): W1004 (fifth relay)
• Six Relay “B” (AP): W1005 (sixth relay)

Figure 126 A Six Relay (AP) device with the address 100

19.20 Adding a Circuit Adder

You can add a circuit adder to a conventional hardwired loop.

Add a circuit adder

1. Select the conventional hardwired loop that you want to add a circuit adder to.

2. Click Insert in the menu bar, then click Add Ckt Adder.
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The Add circuit adders window appears.

Figure 127 Add circuit adders

3. In the Adder Type menu, click the type of adder you want to add. For example:

• 8 Input Adder - 8 Ckts: a DM-1008A input module with 8 class B (4 class A) input 
circuits.

• Supv Opt. Adder - 4 Ckts: a SGM-1004A signal module with 4 supervised output 
circuits.

• Relay Opt. Adder - 8 Ckts: an RM-1008A relay module with 8 relay circuits.

4. Click Add.

5. Click Close.

19.21 Adding a Loop Controller

Add a loop controller

1. Select the node that you want to add a loop controller to.

2. Click Insert in the menu bar, then click Add Loop Controllers.

The Add Loop Controller window appears.

Figure 128 Add Loop Controller

3. Select the type of loop controller that you want to add from the Type pulldown menu.

4. Type the number of loop controllers that you want to add in the Number to add field.

5. Type a description for the new loop controller in the Tag field.

6. Click Add.

The Configurator adds the loop controllers.
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If the number of loop controllers that you selected exceeds the maximum number of loop 
controllers allowed on this node, an error message appears saying that the Configurator 
cannot add some of the CPUs.

7. Click Close.

See the loop controller

1. Click the loop controller in the Job Tree.

Figure 129 Loop Controller

Type Conventional Adder or Loop Adder.
Daughter board installed Select this check box if the quad loop adder’s daughter 

board is installed.

Tag Type a description for the loop controller.
CPU Number Select the CPU address for the loop controller.
Overrides These options override the options on the Job Details 

page.

CLIP/Advanced Protocol 
Address Space 

Defines the address boundary between CLIP devices and 
Advanced Protocol devices.

• AP Start: Enter the starting address of the AP 
devices on the loop. The address space below this 
entry is allocated for CLIP devices and the address 
space above and including this entry is allocated for 
AP devices. Valid AP Start values are 001 to 100.
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19.22 Correlations

Programming a Fire Alarm Control Panel consists of correlating inputs to outputs. For 
example, you might correlate all the smoke detectors on the first floor to the speakers on the 
first and second floors, and smoke detectors on the second floor to the speakers on the first, 
second, and third floors, and so on.

Add correlations

1. Select the device or zone that you want to add correlations to.

2. Click Insert in the menu bar, then click Add Correlations.

The Select items to add window appears.

Figure 130 Select items to add

This window has a tab for every category of circuit or display item that can be correlated 
to the selected device or zone.

3. Select the item that you want to correlate. To select more than one item, hold down the 
Ctrl key and left-click the items.

4. Click Add.

5. Repeat steps 3 and 4 for each tab, if necessary.

6. Click Close.

19.22.1 Viewing Correlations

You use the information in the Details Pane in combination with the Correlations Pane. Each 
tab in the Correlations Pane shows a different category of circuit, display LED, etc.

Figure 131 Correlations pane
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Add a correlation to an item

1. Right-click the item in the Details Pane.

2. Click Add Correlations.

The Select items to add window appears.

3. Double-click the correlations that you want to add, and then click Close.

Output Circuit Correlations

If the selected circuits are outputs, then the Correlations Pane usually has tabs for:

• Alarm Zones

• Supervisory Zones
• Trouble Zones 
• Monitor Zones 

• Display Points (Output Zones, Bypass LEDs, etc.)

Input Circuit Correlations

If the selected circuits are inputs, then the Correlations Pane has a tab for input zones only. 
You must correlate inputs with input zones before they can be correlated to outputs or LEDs.

When you select an item and then click Add Correlations, only the items that are eligible to 
be correlated are shown.

If you select multiple items and then click Add Correlations, only the possible correlations 
common to all the items are shown.

Advanced Logic

You can assign individual outputs or input zones to an equation. If an equation is associated 
with an output, there must be no other inputs or outputs correlated to the output. If an equation 
is associated with an input zone, there must be no input circuits correlated to the input zone.

19.23 Custom Messages

Custom messages are messages that you can correlate with a zone or zone switch. The 
messages appear on a remote annunciator.

For example, for a facility with a main display in the Exhibit Hall and a remote annunciator in 
the East Wing:

• The devices are displayed individually on the main display.
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• The devices are correlated with zones, and the zones are correlated with the custom 
message Exhibit Hall. When any device becomes active, the custom message is 
displayed on the remote annunciator.

Figure 132 Custom Messages

The ND (No Display) flag can be set for input message types. When set, no message will be 
shown on the target CPU's LCD. This feature can used to suppress fire related activations on 
a Mass Notification System node and vice versa.

Create a custom message

1. Select Custom Messages under the remote LCD Annunciator in the Job Tree.

2. Click Insert in the menu bar, then click Add Message.

The Add Messages window appears.

Figure 133 Add Messages

3. In the Type menu, click either Input or Output. Input messages can be correlated with 
input zones and zone switches. Output messages can be correlated with signals and 
relays.

4. Type your message. The message can be up to 40 characters long. Each field holds 20 
characters.

5. Click Add, then click Close.

The message appears in the Details Pane.
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Correlate a custom message with an input or output

1. Right-click your custom message, and then click Add Correlations.

For input messages, the possible correlations are separated into Alarm, Supervisory, 
Trouble and Monitor.

For output messages, the possible correlations are separated into Signal and Relay.

2. Select the input or output that you want to correlate with the message, and then click 
Add.

For an input message, the message is displayed in the corresponding queue when the 
zone becomes active.

You can correlate an input or output with only one custom message at a time.

You cannot correlate inputs of different types with the same message. For example, if you 
correlate a message with a monitor zone, you cannot also correlate it with an alarm zone.

19.24 Audio Controller

Add an audio controller

1. Select the node that you want to add the audio controller to.

2. Click Insert in the menu bar, then click Add Audio Controller.

The audio controller is added.

Note: Your organization needs audio systems training in order to add an audio 
controller to a job. To check whether you have this training, see section 2.9 on 
page 22.i
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See the Audio Controller Details

• Select an audio controller in the Job Tree.

Figure 134 Audio Controller Information

Tag Type a description for the audio controller. This will appear 
in the Job Tree.

CPU Address Select the CPU address for the audio controller.
Audio Controller installed in 
a QX-5000

Select this check box if the amplifier bin arrangement is 
that of the QMB-5000B. The legacy QMB-5000B has 
seven amplifier slots. If the box is not selected, the QMB-
5000N is assumed. It has only four amplifier slots. During 
conversion from QMB-5000N to QMB-5000B any existing 
amplifiers in expansion bins are re-arranged to first fill the 
additional bins of the QMB-5000B. During conversion 
from QMB-5000B to QMB-5000N any existing amplifiers 
in the base unit's extra slots are moved to the expansion 
bins.

QBC-5000 charger 
supervision cable installed

Select this check box if the amplifier battery charger is a 
legacy QBC-5000B. Leave the box unselected if a QBC-
5000N charger is in use. The WX-518 cable is required for 
the QBC-5000N operation (charger supervision). 
Selecting the wrong charger can affect battery supervision 
and charging.
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Microphone present Select this check box if there is a microphone connected 
to this audio controller. If there are two or more 
microphones, then one must be designated as the master 
microphone and the Control enable required for mic 
press to talk check box must be selected on every audio 
controller with a microphone.

Master microphone Select this check box if you want the microphone 
connected to this audio controller to be the master 
microphone. If there are two or microphones, then one 
(and only one) must be designated as master.

Control enable required for 
mic press to talk

Select this check box if you want the operator to enable 
the use of the microphone (through the menu or a key 
switch). This option must be selected if there is a 
microphone connected to this node and there is at least 
one other microphone on another audio controller.

Disable AGC Select this check box if you want to disable Automatic 
Gain Control.

Pre-Tone Select the Play Pre-Tone Before Alarm Tone check box 
if you want a Pre-Tone to be played before the Alarm 
Tone.

Click the ... button to select which audio tone or digitized 
message to use as the pre-tone. You can select the 
standard, built in pre-tone, or you can select an existing 
custom message, or you can create a new message. See 
section 19.5.3 on page 142 for more information.

Telephone Handset Present Select this check box if you want the telephone to be the 
master handset. If you specify a master handset, the first 
telephone line is used for that purpose. The line will be 
hidden and cannot be used for anything else.

If line 0 is currently in use (either as a voice line serving 
addressable phone modules, or as a conventional phone) 
and you select this box you will be asked for confirmation 
before the line is removed.

If you remove the master handset, line 0 will become 
available. If there is a correlation from a telephone 
selector switch to Call Control at this network node, you 
will be asked for confirmation before the master handset 
is removed. You must delete the Master Telephone Adder 
(if present) before unselecting the Master Handset.

Control enable required for 
master handset

Select this check box if you want the operator to enable 
use of the master handset (through the Manual Control 
Enable menu or a key switch).
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19.25 Panel Information

This window displays a summary of panel and the Configurator information.

View configuration information from the Configurator

1. In the Configurator, click Panel > Connect.

2. Click Panel > Panel Information.

The Panel Information window appears.

Figure 135 Panel Information

Master Bus Supervision 
Controller

Select this checkbox if you want this audio controller to 
power the telephone bus. This checkbox must be selected 
on one of the audio controllers.

Note: only one audio controller can be designated as the 
master bus supervision controller per job.

An audio controller can be specified as having master bus 
supervision only if:

• The audio node contains a master telephone handset

• The Telephone Handset Present checkbox is 
selected

If this checkbox is not selected on any of the nodes, then 
there will be a “Tel. Bus Trouble” reported on the system.

Alternate Bus Supervision 
Controller

Select this checkbox to designate this audio controller as 
the back-up power for the telephone bus. The alternate 
bus supervision controller is optional and is used for 
redundancy (should the master bus supervision controller 
go offline).

Job Name The name of the job that is currently active on the FACP.

Version The version number of the job that is currently active on the FACP.

Date The date and time when the job was sent to the FACP.
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19.26 Advanced Panel Information

This window displays detailed information about the panel.

View Advanced Panel Information

1. Click Panel > Connect.

2. Click Panel > Panel Information.

3. Click Advanced.

ESD The ESD (Electronic Systems Distributor) number of the organization 
that sent the job. Each organization has a unique ESD number, so 
that one organization cannot modify systems that another 
organization has configured.

Technician The number of the technician who sent the job.

Config The version of the Configurator that sent the job to the FACP.

Last changed The date and time the FACP was last changed.

Panel Time The date and time on the FACP.

Node The number assigned to each node.

CPU The number for each CPU on the node.

Type The type of CPU, for example a Main CPU, LCD Annuciator, Loop 
Controller, or Audio Controller.

Version The version of the firmware on the CPU.

Language The language that the display uses for messages and menus.

System Type One of the following:

• Compact Build

• Large Build

HW Type Currently always BF_Base

HW Vers. Currently always V1.0.0

Status One of the following:

• Online

• Not responding

• Wrong type

• Unconfigured CPU

• Firmware version mismatch

• Address mismatch

• Offline trouble

Config Version 
GUID A number that uniquely identifies the active job on the FACP.
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19.27 Backing up the Database

You can make a backup of the Configurator database. Back up your database often and store 
it on a CD in a safe place.

Back up the database

1. Click File > Backup Database.

2. Click Save to save the backup in the Backup folder. The name of the backup file is in 
the form YYYY-MM-DD-V12-01-xx.mdb.

You can change the backup folder in User Preferences. See section 19.2 on page 131.

If the Keep Only Latest Versions After Backup option is selected in User Preferences, only 
the latest versions of all jobs will be kept after a successful Backup Database command. All 
older versions will be deleted.

19.28 Restoring the Database

Restoring the database means replacing the current database with a copy from a backup. You 
can do this if you are having a problem with your current database.

Restore the database from a backup

1. Click File > Restore Database.

A window appears warning you that this operation will erase all the data in the current 
database.

2. Click Yes to continue restoring the database.

The Specify database to restore window appears.

3. Select the database that you want to restore, and then click Open.

The Configurator erases the current database and restores the backup.

19.29 Compacting the Database

A database that has been the subject of many deletions and additions can become 
fragmented and use a lot of disk space. You can compact the database to recover the space 
and improve performance.

Compact the database

• Click File > Compact Database.

This may take several minutes for a large database.

Attention: This procedure erases all the data in the current database. Any changes 
made since you made the backup will be lost.!
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19.30 Comparing Jobs

You can compare two jobs. The Configurator displays which elements have been added, 
removed, or changed.

Compare jobs

1. Click Job > Open Job and open the first job. This is the primary job.

2. Click Job > Compare Job Versions.

The Select Job to Compare window appears.

Figure 136 Select Job to Compare

3. Select the second job. This is the secondary job.
• Select Show Identical Items if you want to see not only changes, but also those items 

that stayed the same.

4. Click OK.

The Configurator displays a comparison of the two jobs. See section 19.30.2 on 
page 179.
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19.30.1 Advanced Compare Options

The Select Job to Compare window has some advanced options. They are selected by 
default.

See the Advanced Compare Options

• In the Select Job to Compare window, click Advanced Options.

Figure 137 Advanced Compare Options

The Present only in Secondary and Present only in Primary options do not apply to the Job 
Tree. The entire Job Tree is shown, regardless of these options. These options are applied 
only to the details of devices.

If you select Present only in Secondary Job or Present only in Primary Job, but you do not 
select Modified, then circuits that have had only correlation changes will not be shown as 
different.

Modified Select this check box to include any item that has been 
modified (it is the same adder, circuit, or switch but some 
attribute has been changed).

Present only in Secondary Select this check box to include items that are only 
present in the secondary job. For example, loop adders, 
annunciators, and display adders that are not in the 
primary job will be included.

Present only in Primary Select this check box to include items that are only 
present in the primary job. For example, loop adders, 
annunciators, and display adders that are only in the 
primary job will be included.
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19.30.2 Interpreting the results

The comparison appears as one job tree.

Figure 138 Job comparison

For example, in Figure 139, the Main Display did not change, so it is marked with a green 
check mark. However, some changes were made to its Base Control/Annunciator, so that item 
is marked with a magnifying glass.

Figure 139 Comparison example

A magnifying glass indicates items that have been modified. Click the item to see 
the change.

A green check mark indicates items that are the same.

If you unselect Modified in the Advanced Compare Options, then a green check 
mark appears next to items that have been modified, but that have no deletions or 
additions.
A red arrow indicates items that have been removed (they are present in the primary 
job, but not present in the secondary job).
A blue arrow indicates items that have been added (they are not present in the 
primary job, but are present in the secondary job).
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Where a minor modification to a form, device, LED, or switch has been made, two adjacent 
rows appear. The attributes that remained the same are represented by an ellipsis (...) in the 
second row.

Figure 140 Minor modifications

19.30.3 Printing the comparison

You can print the differences of the entire job, a single node, or a node and its sub-nodes. In 
addition to choosing how much of the job to print, you can also decide whether to print outputs 
with input correlations, inputs with output correlations or display correlations.

Print the job comparison

• See section 19.37 on page 187.

If you did not select Show Identical Items when you made the comparison, then any node in 
the tree that is marked with a green check mark will not be printed.

On the printout, the symbols - - > and < - - are used in place of the blue and red check marks.

• - - > An item has been added (it is not present in the primary job, but is present in the 
secondary job).

• < - - An item has been removed (it is present in the primary job, but not present in the 
secondary job).

 The same symbols are used on pairs of lines to indicate which line indicates the primary ( < - 
- ) and which line indicates the secondary ( - - > ).

If the print range of the job is Complete Job, then you may decide to choose only one of Input 
or Output Correlations, since every input has a corresponding output somewhere on the job.

If the print range of the job is not Complete Job, then selecting only Input or Output might not 
include all the correlations.

The Input and Output summaries will list any changes to the UDACT numbers to be reported 
to the authorities.

Print Preview works best if you maximize the Preview window and zoom in and out so that a 
complete page fits in the window.

19.30.4 How does the Configurator decide what is added, removed, or changed?

For a base annunciator or loop controller, the node number is the key. If you change the tag or 
add display adders, the item is still the same, because the node number has not changed.

If you remove and add annunciators so that the node numbers change, then they are 
changed.

For a circuit or device, the combination of loop number and device address is the key. The 
internal circuit or UDACT number is not considered a change. Because of additions and 
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deletions, a circuit at the same loop or device address may receive a different UDACT number. 
This is a modification.

For display items such as LEDs and switches, the key is a combination of node number, their 
relative position on the adder, and their type and assignment. Minor changes to an LED’s 
assignment (for example, from Alarm Status to Mixed Ipt) are treated as though the LED was 
deleted and re-added. This makes the handling of correlations more meaningful. Very often 
there is only a small subset of correlation types that are common to two different LED or switch 
assignments. By treating the type and assignment as key, the Configurator shows the 
complete before and after correlations.

19.31 Creating a Job

Create a job

1. Click Job > New Job.

The Create Job window appears.

Figure 141 Create Job

2. Type a name for the job in the first field. This name should be unique. It will identify the 
job throughout its lifetime.

3. Type a comment in the Comments field. This is required. This will become part of the 
job's version history.

4. Select the model of panel in the Panel Model menu.

5. Select a template.

There are two copies of most template jobs, one for ULI and one for ULC. You can 
change the template later.

Note: In a multi-product environment, the same job name cannot be used for jobs of 
different products, even if you do not currently have access to all possible 
products.i
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There might be templates for more than one language. For panels with multiple CPUs, 
this is the language of the main CPU.

6. Click Copy current job data to copy the current open job, and use this copy for the new 
job.

7. Click OK.

19.32 Opening a Job

Open a job

1. Click Job > Open Job.

The Select Job and Version window appears.

Figure 142 Select Job and Version

This window shows all the jobs in the database.

2. Click on the column heading to sort the jobs by:

• Job Number

• Job Description

• Product (where more than one product is supported)

3. Select a job and version to open.

4. Click OK.

19.33 Importing a Job

You can import a job that has been created on another computer or by another technician. You 
can import .mdb or .fx2Job files.

Import a job

1. Click Job > Import Job.

2. Browse to the file you want to import, then click Open.
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If the same job is already on the database, then the Configurator gives the imported job the 
next highest version number.

19.34 Display Structure

The Display Structure feature lets you view the contents of a panel data structure.

Display a structure

1. Connect to the panel.

2. Click Tools > Display Structure.

If you do not see the Tools menu, you must enable it. See section 19.2 on page 131.

The Display Firmware Data Structure window appears.

Figure 143 Display Firmware Data Structure

3. In the pulldown menus, select the node and CPU that you want to display.

4. In the Structure pulldown menu, select the structure that you want to display.

Loop structures are qualified with a loop number, for example gLCUPollData - Loop 2.

5. Choose the entry (for poll data there is one entry per device, other structures may be 
organised differently).

6. Choose the Number of Entries to display.

7. Select a refresh rate, and then click Start.

8. To save the display to a file, select the Log to File check box.

You can adjust the refresh rate, the start entry and the number of entries while the display is 
running.
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19.35 Version Control

The Configurator prevents accidental editing of jobs in order to keep the job in its database 
identical to the job on the Fire Alarm Control Panel.

19.35.1 Editing a job

When you open a job, whether by getting it from the panel or opening it from the database, it is 
locked by default, and you must unlock it in order to edit it.

Edit a job

• Click Job > Edit Job.

If the job has been sent to a panel, a message appears warning you that you should 
create a new version first. See section 19.35.2 on page 184.

If you try to edit a locked job that has not been sent to a panel, a message appears asking if 
you want to make it editable.

Figure 144 This job is protected against unintentional edits

• Click Yes to unlock the job.

19.35.2 Creating a new version

If you try to edit a job that has been sent to a panel, a message appears saying that you must 
create a new version.

Figure 145 This job version has already been built or downloaded to the panel

Note: Jobs that have more than one node cannot be unlocked. You must create a new 
version.i
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Create a new version of a job

1. Click Job > New Version.

The New Job Version Information window appears.

Figure 146 New Job Version Information

2. Type a comment in the Comments field. This is required.

3. Click OK.

19.36 Paste Special

You can use the Paste Special command to paste circuits, conventional adders, or entire 
loops.

Figure 147 Paste Special for loops

Number of copies Select the number of copies to make.
Copy I/O correlations Select this check box if you want the copied devices to 

have the same I/O correlations as the original.
Copy display correlations Select this check box if you want the copied devices to 

have the same display correlations as the original.

Retain Address Select this check box to keep the same addresses on the 
copied devices.
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You can use Paste Special to paste display items, display adders, or annunciators.

Figure 148 Paste Special for annunciators

A regular copy is defined as follows:

• The LEDs and switches are copied and become separate entities from the original LEDs 
and switches.

• Common Control Status LEDS are an exception. All similar types operate in parallel. For 
example, a copied and pasted Signal Silence would retain the internal LED group of the 
source.

• All attributes (tags and flags) are copied.

• If Copy I/O correlations is selected, then the I/O correlations are assigned to the new 
copy.

• If Copy I/O correlations is not selected, then the I/O correlations are not copied.

A reference copy is defined as follows:

• New LEDs and switches are defined, but they are linked closely to the original source.
• If any 3 POSITION SLIDE SWITCH is encountered while attempting a "Reference Copy" 

of individual items, a complete adder or an entire annunciator, an error message is 
displayed and a roll back of the operation occurs.

• Both the new copy and the source (and any subsequent reference copies) will be 
marked with an asterisk to warn the user that the items are linked or cross referenced. A 
change to one (for example, addition of correlations) affects the others.

Number of copies Select the number of copies to make.
Make new copy Click this button to make an unrelated copy of the source.

Copy correlations Select this check box if you want the copied devices to 
have the same correlations as the original.

Make reference copy Click this button to make a reference copy of the source.
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19.37 Print

Print a job

1. Click File > Print.

The Print window appears.

Figure 149 Print

If you need to repeat part of a print job (because the printer jammed part way through a job, for 
example), then you must note the start page and the end page - up to the maximum number of 
calculated pages - and enter them in the From and To fields.

Complete Job Prints the complete job, and prints each major item of the 
Job Tree on a new page.

Current Item Prints only the currently selected item. No details of 
contained loops are printed.

Current Item and Sub Items Prints only the currently selected item and any items 
contained in it.

Outputs with Input Corrs Prints the inputs correlated to outputs. Does not print an 
item if it has no correlations.

Inputs with Output Corrs Prints the outputs correlated to inputs, including status 
correlations. Does not print an item if it has no 
correlations.

Display Corrs Prints the display correlations. Does not print an item if it 
has no correlations.
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19.38 Security Key Logon

This window appears if the CodeMeter key is inserted when you start the Configurator. It also 
appears if the key is inserted later.

Figure 150 Security Key Logon

• Type your PIN and click OK.

19.39 Upgrade Firmware

This window appears when you select the Upgrade Firmware command, after you have 
selected a firmware archive.

Figure 151 Upgrade Firmware on Panel

View Archive The Firmware Archive Contents window appears, which 
lists all of the files in the archive.

View Panel Info The Advanced Panel Information window appears, 
which lists all of the CPUs present on the panel.

Selected CPUs Only Select this check box, and then select the CPUs you wish 
to upgrade. If this check box is not selected, all of the 
CPUs will be upgraded.

To select multiple rows:

• Hold down the Ctrl key and left-click in the row.
Upgrade Starts the firmware upgrade.
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19.40 Update Panel Time

Update the panel time

1. Click Panel > Panel Information.

The Panel Information window appears. See section 19.25 on page 174.

2. Click Update.

The Update Panel Time window appears.

Figure 152 Update Panel Time

3. Adjust the time, if necessary, and then click OK.

19.41 Version History

See the version history of the open job

1. Click Job > Version History.

The Version History window appears.

Figure 153 Version History

Number The version number.

Date The date and time the version was created.
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19.42 System/Node/CPU Status

The System Status, Node Status, or CPU Status appear in the Details Pane when you select 
the Common System Status, Node & CPU Status, or Annun Status items in the Job Tree.

System Statuses are inputs that can be correlated to outputs. For example:

• Correlate a signal circuit to operate as a power supply (using Init Done).
• Customize the Fire Drill operation.

• Correlate a relay to operate on Reset Command (using Sys Reset).

System Statuses are can also be correlated to LEDs.

System statuses can have three different scopes.

• Common System Status: These statuses have a system wide scope. Examples are 
Common Alarm, Fire Drill and Signals Active.

• Node Status: Node Active and AC On are examples of Node Status. When you choose 
a Node Status and correlate something to it, you are specifying, for example, the AC On 
status of the selected node. The Scope column specifies which node the status is on.

• CPU Status: These fall into two categories.

• The list view containing the special Annunciator Statuses, Control Enabled, and 
Control Disabled appears in the job tree for every CPU that has an LCD (Main Display 
and LCD Annunciators).

• The list view containing the other CPU statuses appears in the Job Tree for each 
network node and is combined with the Node Statuses. These CPU Statuses are 
associated with the main CPU of the node.

Changed by The technician who created the version.
Description The description that was entered when the new job 

version was created.
Type • Uploaded: The new job version was a result of a Get 

Job.

• New Job: The user created a new version manually.

Status • Locked: The job has been sent to the panel and is 
locked against editing.

• Editable: The job is not locked.
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The Scope column specifies the Node and CPU of the status. You must have defined a 
suitable LED to accept the correlation from the Node or Node/CPU specific status.

Figure 154 System Status

Table 29 describes the columns in the System Status view.

Some System Statuses can also be correlated to switches. Examples are Signal Silence, 
Fire Drill, Aux Disc, Total Evacuation. When one of these items is selected, the Correlations 
Pane shows any display adder switches that are correlated to the item. This does not include 
remote switches (input circuits or devices of type Input Module that are assigned to a 
Common System Status).

Table 29 System Status

Name Description

F/W Status The firmware status number.

Scope Either Common for system wide statuses or the Node name, or Node CPU 
combination of the status.

Status A short description of the status.

F1 Flag field: NS for Non-Silenceable or blank.

F2

On a two stage system, select GA if you want the outputs correlated to a 
Common System Status to sound at the Evac rate. If this column is blank, 
the outputs sound at the Alert rate.

You can specify the tones for Evac and Alert in the Audio Setup window. 
See chapter 16.
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19.43 Custom Intervals

A custom interval is a period of time during the day. Intervals have a start time, an end time, 
and an optional day of the week. If the day of the week is not specified, then the interval 
applies every day.

You can use a custom interval to change the language of announcements at certain times of 
day, or to turn on a dedicated air handling system once a week for testing.

View custom intervals

• Select Custom Intervals in the Job Tree.

You can use custom intervals in equations. See section 8.2 on page 49.

Use more than one interval

1. Connect the intervals in an equation with OR.

For example, consider these two intervals:
**-**-**-IT-010: 06:00 to 09:00 "Kitchen in use - breakfast."
**-**-**-IT-011: 11:00 to 13:00 "Kitchen in use - lunch."

The following equation is true when the time is within either of these intervals:

**-**-**-IT-010 OR **-**-**-IT-011

Table 30 describes the columns in the Custom Intervals view.

19.44 Custom Timers

A custom timer is a length of time. You can make an operation occur after a timer has expired, 
or while a timer is running. For example, you can use a timer to delay a vent fan until the 
damper has had time to open, or to delay the activation of compressors so that they do not all 

Table 30 Customer Intervals

Name Description

CktNo The number assigned to the interval.

Start Hour The hour (0-23) when the interval starts.

Start Min The minute (0-59) when the interval starts 

End Hour The hour (0-23) when the interval ends.

End Min The minute (0-59) when the interval ends.

DoW The day of the week, if the interval period is restricted to one day. Leave 
this column blank if you want the interval to occur every day.

Tag A 20 character description of the interval. The tag helps to identify the 
interval in the Advanced Logic Editor.
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activate at once and overload the system.All timers are initially un-assigned. To enable a timer, 
edit the Enable column to make it Y.

View custom timers

• Select Custom Timers in the Job Tree.

Create a timer

• Double-click in the Enable column, and then click Y in the menu.

You can use custom timers in equations. An equation can start a timer, test whether a timer 
has expired, or can test whether it is still running. See section 8.1 on page 47.

Table 31 describes the columns in the Custom Timers view.

19.45 Input / Output Circuit Summary

The Job Tree contains Input Summary and Output Summary items. Select either of these 
items to see a list of all of the circuits on the job.

On products that support them, this list may include Correlatable Switches. These will not 
have a value in the Loop and Address columns.

19.46 Node Grouping

Node grouping is a way of isolating nodes from each other. Nodes that belong to one group 
are isolated from nodes that belong to another group. Alarms and troubles that occur in one 
group are not annunciated on the nodes of another group.

For example, in a facility consisting of two towers, you can place the DGP (data gathering 
panel) nodes of the North Tower in the North group and the DGP nodes of the South Tower in 
South group. If there is a CACF (central alarm control facility) node in a common area (for 
example, a lobby), you can place it in both groups. Alarms or fire drill activation in the North 
Tower will not be transmitted to the South Tower, and vice versa. The CACF node, because it 
is a member of both groups, will annunciate events from both towers.

Note: As per UL 864 and UL 2572 only a setting of un-assigned is permissible.

Table 31 Customer Timers

Name Description

Address The number assigned to the timer.

Enable Double-click in this column, and then click Y to create a timer.

Duration The duration of the timer in seconds.

Tag A 20 character description of the timer. The tag helps to identify the timer 
in the Advanced Logic Editor.

i
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In a combined fire and MNS (Mass Notification System) installation, Node Grouping is used to 
separate the MNS nodes from the fire nodes.

Create node groups and add nodes to groups

1. Create two nodes, and give them appropriate tags, for example Fire Panel and MNS 
Panel.

2. In the left pane, select Node Grouping.

3. Click Insert - Add Group.

4. Type a name for the group, for example Fire Group, and then click OK.

5. Double-click under Fire Panel and select the X to add Fire Panel to the Fire Group.

Figure 155 Node grouping for the fire panel

6. Click Insert - Add Group.

7. Type a name for the second group, for example MNS Group, and then click OK.

8. Double-click under MSN Panel and select the X to add MNS Panel to the MNS Group.

Figure 156 Node grouping for the MNS panel

Rename a group

1. Right-click the group, then select Edit Group.

2. Type a new name for the group, and then click OK.
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Delete a group

1. Right-click the group, then select Delete Group.

2. Click OK.

If the group has no member nodes, it is deleted.

The group is not deleted if it has member nodes.

Remove a node from a group

• Double-click the X under the node and select the blank line in the pull-down menu.

Figure 157 Remove a node from a group

The node is no longer a member of this group.

19.47 Input Zones

See the input zones

• Click Input Zones in the Job Tree under Base I/O.

You use Input Zones to combine multiple input circuits into zones which can then be correlated 
to signals and other outputs.

Table 32 Input Zones

Name Description

Device Input Zone.

Type Double-click in this column to change the process type of the zone.

Priority

Specifies the priority given to digitized messages correlated to this input 
zone: 19 (lowest) through Normal (default) to +19 (Highest). Activation of 
a zone with a higher priority will cause its message to be played, and any 
lower priority message will cease to play.

In a combined fire and Mass Notification System (MNS) installation, 
choose appropriate priorities. For example, if risk analysis has determined 
that fire has priority over MNS, assign a higher priority to all fire input 
zones – higher than those of MNS digitized message switches.

Code

In a coded system, you can associate devices with a code that sounds on 
the signal circuits to indicate where the alarm has occurred. The code 
consists of 1 to 4 digits, each digit consisting of 1-15 pulses on the signals. 
Each coded circuit can be configured to sound the complete code 1 - 15 
times after which the signals will either go silent or revert to the 
programmed General Alarm rate.

Tag 1 and 2 A description, in two 20 character fields, which appears on the front panel 
when an alarm occurs.
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Flag Columns

There are up to 5 Flag columns (F1, F2, F3, F4, and F5) for flags of various types.

NS: Non Silenceable - used on inputs and supervised outputs.

GA: Stage two alarm - in a two stage system.

ND: No Display - This zone will not appear in the alarm queue.

CO: CO Alarm - This indicates a carbon monoxide detection zone. Sounder bases correlated 
to this zone will sound the corresponding CO pattern. It can be set for zone Type Supv. or 
Alarm.

SA: Zone activation - This is equivalent to cancelling Signal Silence. It can be set only for zone 
Type Supv. or Mon.

19.48 Output Groups

Output groups let you specify a group of Advanced Protocol relay modules, control modules, 
and sounder bases that you want to activate simultaneously.

FleX-Net™ uses the Advanced Protocol broadcast command to simultaneously activate all 
relay modules, control modules, and sounder bases that are in the same output group when 
there is a general alarm or fire drill.

In order to configure output devices so that they activate simultaneously when they are 
triggered by an input, you must correlate the output devices to an input zone in addition to 
adding the output devices to an output group.

19.48.1 Add Output Devices to an Output Group
1. Click Output Groups in the Job Tree under Base I/O.

2. Click Insert in the menu bar, then click Add Groups.

Figure 158 Add Output Group

3. In the Device menu, select Output Group.

Note: You can only add devices that are on the same CPU to an output group. For 
example, you cannot add devices from both Node 1 and Node 2 to the same 
output group. However, you can add devices from more than one loop on a quad 
loop adder to the same output group.

i
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4. In the Type menu, select Sounder Base, Relay Base, or Output Module.

5. Click Add.

The new output group appears in the top pane.

6. Select the new output group.

7. Click Insert in the menu bar, then click Add Correlations.

The Select items to add window appears.

Figure 159 Select items to add to output group

8. Select the output devices that you want to add. To select more than one device, hold 
down the Ctrl key and click the devices.

9. Click Add.

10. Click Close.

Note: If you selected Sounder Base in the Type menu, then you can add only Sounder 
Base (AP) devices. If you selected Relay Base in the Type menu, then you can 
add only Relay Base (AP) devices. If you selected Output Module in the Type 
menu, then you can add only Control (AP), Six Relay Control (AP), and Relay 
(AP) devices.

i
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19.48.2 Correlate Output Devices to an Input Zone

In order to configure output devices so that they activate simultaneously when they are 
triggered by an input, you must also correlate the output devices to an input zone.

1. Select the input zone that you want to add the output devices to.

2. Click Insert in the menu bar, then click Add Correlations.

The Select items to add window appears.

Figure 160 Select items to add to input zone

3. Select the Signal tab for Control (AP) and Sounder Base (AP) devices, and select the 
Relay tab for Relay (AP) devices.

4. Select the same output devices that you added to the output group in section 19.48.1. To 
select more than one device, hold down the Ctrl key and click the devices.

5. Click Add.

6. Click Close.

Note: The list of outputs in the output group must match the list of outputs 
correlated to the input zone. If the input zone contains more outputs than are in 
the output group, then the outputs that are not in the output group will not activate 
simultaneously when they are triggered by the input. However, if the output group 
contains more outputs than are in the input zone, then no outputs will activate 
simultaneously.

For example, consider a job that contains 10 output devices. If all 10 devices are 
correlated to an input zone, and the output group contains only 5 devices, then 
only the 5 devices in the output group will activate simultaneously when they are 
triggered by the input.

If the output group contains all 10 devices, but only 5 of these devices are 
correlated to an input zone, then no devices will activate simultaneously when 
they are triggered by the input.

i
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If the output devices are both in an output group and correlated to the input zone, they will 
activate simultaneously when the input zone activates.

19.49 LED Annunciator

A node can have multiple LED annunciators, but they all share the same configuration. 
Therefore, only one LED annunciator appears for each node in the Job Tree.

Add an LED annunciator

1. Click Insert in the menu bar, then click Add Annunciator.

2. In the Type menu, select LED Annunciator.

3. Type a description in the Tag field, and then click Add.

See the LED annunciator summary

• Click LED Annunciator in the Job Tree.

Figure 161 LED Annunciator

• Double-click in the CPU column to change the CPU address.
• Double-click in the Tag column to change the tag.

19.50 Loop Details

The loop details displays the hard wired (conventional) circuits or addressable devices in a 
loop.

See the loop details

1. In the Job Tree, click the loop that you want to see under the Loop Adder or Audio 
Control.

Table 33 Loop Details

Name Description

Addr For regular addressable devices, this address is the same as the device 
address. For conventional circuits display adder & circuit on adder.

Abs Addr
In order to accommodate as many device addresses as possible, 
advanced addressing uses the absolute address instead of the real 
address. Absolute address is unique and fixed for each device address.

Device

Conventional - fixed, depending on the circuit adder. See section 19.20 on 
page 165.

Addressable - chosen when adding devices. Can be edited conditionally. 
For example, a Photo Detector can be changed to other types of detector, 
a Relay Opt module can be changed to a Supv. Opt module.

Other changes can be made only by deleting the device and adding 
another.
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Flags

There are up to four Flag columns (F1, F2, F3 and F4).

• AR: Auxiliary Reset required - for relays.
• BU: Back Up amplifier - for audio controllers. This flag designates the amplifier as the 

backup. It must be of sufficient power to substitute for any of the other configured 
amplifiers. The backup amplifier can only be correlated with status LEDs, trouble LEDs 
and UDACT groups.

• ER: Enable Required - Select this if you want the switch to require a passcode.
• GA: Stage Two Alarm - in a two stage system, and also to return the supervised signal to 

EVAC rate after the code is completed in a coded system.
• NB: Non Bypassable - for relays.
• NC: Not coded - for supervised outputs (for instance, strobes) to keep the output 

operating until reset (even after the code has ended).
• ND: No Display - Select this if you do not want the input to appear in the queue.
• NS: Non Silenceable - for inputs and supervised outputs.

Type The process type of the device. You can change this by double-clicking it.

SubType

The specific subtype of the device. For instance, a photo detector can be a 
smoke, beam, or duct detector.

The SubType helps identify the device to OpenGN. In OpenGN, you can 
assign an icon to the device based on the Type or SubType. In the 
OpenGN Event List, the SubType appears in the Object Description 
column.

Sens Lvl Pre On addressable loops, the pre-alarm (or for some device types the trouble) 
sensitivity level.

Sens On addressable loops, the alarm level 1 sensitivity level.

Sens Lvl 2 On addressable loops, the alarm level 2 sensitivity level. 

Sens Lvl 3 On addressable loops, the alarm level 3 sensitivity level. 

Sens B Lvl 
Pre

On addressable loops, the after hours and night time pre-alarm (or for 
some device types the trouble) sensitivity level.

Sens B On addressable loops, the after hours and night time alarm level 1 
sensitivity level.

Sens B Lvl 2 On addressable loops, the after hours and night time alarm level 2 
sensitivity level.

Sens B Lvl 3 On addressable loops, the after hours and night time alarm level 3 
sensitivity level.

Tag1 and 2 The description, in two 20 character fields, that appears on the panel when 
an alarm occurs.

Alternate 
Tag (Line 1 
and Line 2

The description that appears on displays where Alternate Tags is 
selected. See section 19.8 on page 149. The primary tags will appear on all 
other displays. The alternate tags are typically used for a second language.

Table 33 Loop Details (Continued)

Name Description
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• SR: System Reset required - for switches used for fan control.
• NF: No LED Activation - do not turn ON an addressable device’s LED (and activate 

sounder when present) when the device is active. The LED turns ON by default and may 
only be changed to NF if the Authority Having Jurisdiction allows.

• HV: High Volume - use the High Volume setting on an AP sounder base.

Sens Columns

Sensitivity level for COSAP provides 6 levels of sensitivity, which are categorized as below: 

• Alarm 1: Level 1 - 1%/ft of smoke. No delays from processed photo output. 
• Alarm 2: Level 2 - 2%/ft of smoke. No delays from processed photo output. 
• Alarm 3: Level 3 - 3%/ft of smoke. No delays from processed photo output. 
• Alarm 4: Level 4 - 3%/ft of smoke. Maximum of 10 minutes delay from processed photo 

output. 
• Alarm 5: Level 5 - 4%/ft of smoke. Maximum of 10 minutes delay from processed photo 

output. 
• Alarm 6: Level 6 - Heat only alarm. If the heat level limits. 

Once the CO cell has reached its end of life, and enters PTIR mode, the following sensitivities 
apply: 

• Alarm 1: Level 1 - 1%/ft of smoke. No delays from processed photo output. 
• Alarm 2: Level 2 - 2%/ft of smoke. No delays from processed photo output. 
• Alarm 5: Level 5 - 3%/ft of smoke. Time elapsed from smoke detection is 
• Alarm 6: Level 6 - Heat only alarm. If the heat level on either thermistor exceeds 1 limits. 
• CO Operation: CO only alarm. 

19.51 Fire Phone Configuration

You can set up an audio controller, conventional phones, voice lines, remote field phones, 
master telephone handsets and telephone selectors, and you can connect them together.

You need at least an Audio Network Controller Module (ANC-5000), a Telephone Network 
Controller Module (TNC-5000), a Telephone Master Controller (QMT-5302N(V)), and a 
Telephone/Page Selector (QAZT-5302DS or QAZT-5348DS). The Audio Controller supports 
conventional fire phone circuits or voice lines. There may also be addressable fire phone 
modules. If you configure addressable fire phone modules you must also ensure that there is a 
voice line to support them.

19.51.1 Adding an audio controller

• See section 19.24 on page 171 for instructions on adding an audio controller.

The Audio Network Controller Module (ANC-5000) must have a Telephone Network Controller 
Module (TNC-5000) installed.

Note: Your organization needs audio systems training in order to add an audio 
controller to a job. To check whether you have this training, see section 2.9 on 
page 22.i
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You must also specify whether the four or five lines are conventional phones or voice lines to 
serve addressable phone modules. After the audio controller is added you can still edit these 
attributes, or change just some of the lines between voice and conventional.

19.51.2 Adding a fire phone module

Add a fire phone module

1. Select the loop that you want to add a device to.

2. Click Insert in the menu bar, then click Add Device.

The Add Device window appears.

Figure 162 Add fire phone module

3. Select Firephone Module in the Device pulldown menu.

4. Click the Add button.

19.51.3 Adding master telephones (QMT-5302N(V))

You can add a maximum of one master telephone to each RAXN-LCD annunciator or to the 
base panel's main display. The master telephone uses one frame.

Add a master telephone

1. Select the annunciator or display adder that you want to add the telephone to.

2. Click Insert in the menu bar, then click Add Display Adder.

3. Select Master Telephone in the Select Adder Type menu.

4. Select the header (connector) in the Select Header menu.

5. Click Add.

6. Click Close.

19.51.4 Adding telephone/page selectors (QAZT-5302DS)

You can add any number of telephone/page selector adders to each RAXN-LCD annunciator 
or to the base panel's main display, up to the maximum frame count for an annunciator. An 
annunciator has 14 frames, and a telephone/page selector uses 2 frames.



Using the Configurator

203

Add a telephone/page selector

1. Select the annunciator or display adder that you want to add the telephone to.

2. Click Insert in the menu bar, then click Add Display Adder.

3. Select Telephone/Page Selector in the Select Adder Type pulldown menu.

4. Select the header (connector) in the Select Header pulldown menu.

5. Click Add.

6. Click Close.

The telephone/page selector has 24 switches, all of which are initially unassigned. They can 
be configured as Zone Switch, Phone Select, Dig Msg, Page Select, or Node Control.

19.51.5 Adding QAZT-5348DS and IPS-4848DS

The QAZT-5348DS is represented in the Configurator by 2 Telephone/Page Selectors. It uses 
4 frames.

The IPS-4848DS is represented by 2 24 Sw Adders. It uses 4 frames.

Add a QAZT-5348DS

1. Select the annunciator or display adder that you want to add the QAZT-5348DS to.

2. Click Insert in the menu bar, then click Add Display Adder.

3. Select Telephone/Page Selector in the Select Adder Type pulldown menu.

4. Click Add.

5. Click Insert in the menu bar, then click Add Display Adder.

6. Select Telephone/Page Selector in the Select Adder Type pulldown menu.

7. Click Add.

8. Click Close.

The first Telephone/Page Selector that you added represents the first 24 switches on the 
QAZT-5348DS. The second Telephone/Page Selector represents the next 24 switches.

Add an IPS-4848DS

1. Select the annunciator or display adder that you want to add the IPS-4848 to.

2. Click Insert in the menu bar, then click Add Display Adder.

3. Select 24 Sw Adder in the Select Adder Type pulldown menu.

4. Click Add.

5. Click Insert in the menu bar, then click Add Display Adder.

6. Select 24 Sw Adder in the Select Adder Type pulldown menu.

7. Click Add.

8. Click Close.

The first 24 Sw Adder that you added represents the first 24 switches on the IPS-4848DS. The 
second 24 Sw Adder represents the next 24 switches.
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19.51.6 Correlating selector switches to remote telephones

The following constraints apply to correlations between telephones and switches.

• Each dual LED/Switch combination on a Selector can control and annunciate only one 
telephone (conventional circuit or addressable module).

• If a switch on one CPU (Annunciator) is already controlling a telephone, then no other 
switch on that same CPU can be associated with the same telephone. However, any 
given telephone module can be controlled from a similar LED/Switch combination on 
another CPU.

Typically, a bank of selectors on one Annunciator mirrors those on another. However, this is 
not required. For example, the Selector Switches at the Main Panel could control all the phone 
modules on a job, while each remote Annunciator controls only a sub-set.

Correlate a selector switch to a telephone

1. Select the addressable loop or audio controller phone list view containing the telephone.

2. Click Insert in the menu bar, then click Add Correlations.

3. Click a maximum of one switch from each CPU that you want to correlate with this 
telephone.

4. Click Add.

If you had previously correlated one or more switches to this telephone module, then you will 
not see any available switches from the same CPU as those existing correlations.

Correlate a phone module to a switch

1. Select the Selector Switch.

2. Click Insert in the menu bar, then click Add Correlations.

3. Click only one Phone Module. A switch cannot control more than one telephone.

4. Click Add.

If the phone you added was already correlated to another switch on the same CPU, you will 
receive a message "A select switch already exists for control circuit number nnn. A circuit can 
only be assigned to one Telephone Switch per CPU".

If you selected more than one Phone to add, or if you press add again, then you will receive 
the error message “Cannot correlate a Phone Select switch to more than one phone module”.

19.51.7 A fire phone device cannot be copied if it is already correlated to a 
selector switch

A fire phone device cannot be copied if it is already correlated to a selector switch. If you 
attempt to copy such a device (or a loop that contains one) an error message appears. If you 
need to copy phones, use Paste Special and unselect Copy display correlations.
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19.52 Using Master Telephones

A master telephone (QMT-5302N(V)) is attached to a node and is configured to call other 
specific master telephones.

Master telephones are called by pressing a switch on a telephone/page selector (QAZT-
5302DS or QAZT-5348DS).

In order to call one master telephone from another master telephone, you must correlate a 
switch on one node to a switch on another node. See section 19.52.4 on page 206 for 
instructions on how to do this.

The following 3 sections describe 3 applications of master telephones.

19.52.1 Calling Master-to-Master (Single Call)

In this two-node example, node 1 switch number 0 is correlated to node 2 switch number 0.

1. Press switch number 0 on node 1 to call node 2.

Node 1 and node 2 sound their buzzers and the green LEDs blink.

2. Press switch number 0 on node 2 to answer the call.

Node 1 and node 2 turn off their buzzers and green LEDs turn solid.

3. Press switch number 0 again on node 1 (or press switch number 0 on node 2) to 
disconnect the call.

19.52.2 Calling Master-to-Master (Multiple Calls)

In a three-node system, an operator at node 1 can call both node 2 and node 3. In this 
example the following correlations have been made:

• Node 1 switch number 0 <--> Node 2 switch number 0
• Node 1 switch number 1 <--> Node 3 switch number 0

• Node 2 switch number 1 <--> Node 3 switch number 1

1. Press switch number 1 on node 1 to call node 3.

Node 1 and node 3 sound their buzzers and the green LEDs blink.

2. Press switch number 0 on Node 3 to answer the call from node 1.

Node 1 and node 3 turn off their buzzers and the green LEDs turn solid.

The operators at nodes 1 and 3 can talk to each other.

3. Press switch number 1 on node 2 to call node 3.

Node 2 and node 3 sound their buzzers and the green LEDs blink.

4. Press switch number 1 on node 3 to answer the call from node 2.

Node 2 and node 3 turn off their buzzers and the green LEDs turn solid.

The operators at all 3 nodes can now talk to each other.

5. Press switch number 0 on node 3 to disconnect the call from node 1.

6. Press switch number 1 on node 3 to disconnect the call from node 2.
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19.52.3 Call Control

The operator can call all the nodes that are correlated to the node’s telephone/page selector 
by pressing the Call Control switch on the master telephone (QMT-5302N(V)).

In this example three-node system, the following correlations have been made:

• Node 1 switch number 0 <--> Node 3 switch number 0
• Node 1 switch number 1 <--> Node 2 switch number 0

1. Press the Call Control switch on node 1.

Nodes 1, 2, and 3 sound their buzzers and the green LEDs blink.

2. Press switch number 0 on node 3 to answer the call from node 1.

All nodes turn off their buzzers.

The green LEDs on node 1 and node 3 turn solid.

The green LED on node 2 blinks (the call from node 1 can still be answered).

3. Press switch number 0 on node 3 to disconnect the call from node 1.

4. Press the Deselect All switch on node 1 to disconnect all calls from this node.

19.52.4 Master telephones in the Configurator

This section describes how to set up master telephones on the three-node system described 
in section 19.52.2 on page 205.

Add the audio controllers and master telephones

Add an audio controller, a master telephone, and a telephone/page selector to each node as 
described in sections 19.24, 19.51.3 and 19.51.4. For each audio controller select the Master 
Handset check box.

Assign the phone selector switches

1. Select the Telephone/Page Selector under node 1’s Main Display.

2. For switch number 0, double-click <unassigned> and select Phone Sel.

Figure 163 Make a switch a phone selector switch

3. For switch number 1, double-click <unassigned> and select Phone Sel.

4. Repeat steps 1 and 2 for nodes 2 and 3.

Correlate the phone selector switches across nodes

1. Select the Telephone/Page Selector under node 1’s Main Display.

2. Select the row for switch number 0, and then click Insert in the menu bar, then click Add 
Correlations.
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3. In the Select items to add window, click the Call Control tab.

All the phone selector switches available for correlation appear here. Figure 164 shows 
that switch numbers 0 and 1 on node 2, and switch numbers 0 and 2 on node 3 are 
available for correlation.

Figure 164 Add correlations to a phone selector switch

4. Select switch number 0 for Node 2, and then click Add.

5. Click Close.

6. Select the row for switch number 1, and then click Insert in the menu bar, then click Add 
Correlations.

7. In the Select items to add window, click the Call Control tab.

All the phone selector switches available for correlation appear here. Figure 165 shows 
that switch numbers 0 and 2 on node 3 are available for correlation. Node 2 is not 
available because it was correlated with switch number 0 earlier.

Figure 165 Add correlations to a phone selector switch

8. Select switch number 0 for Node 3, and then click Add.

9. Click Close.

10. Select the Telephone/Page Selector under node 2’s Main Display.

11. Select the row for switch number 1, and then click Insert in the menu bar, then click Add 
Correlations.

12. In the Select items to add window, click the Call Control tab.
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Figure 166 shows that switch number 1 on node 3 is available for correlation.

Figure 166 Add correlations to a phone selector switch

13. Select switch number 1 for Node 3, and then click Add.

14. Click Close.

The switches are now correlated as follows:

• Node 1 switch number 0 <--> Node 2 switch number 0
• Node 1 switch number 1 <--> Node 3 switch number 0
• Node 2 switch number 1 <--> Node 3 switch number 1

19.53 Suite Silence

You can configure a combination of system statuses, timers, input zones, and signal zones to 
satisfy the requirements of Division B, Part 3.2.4.18 of the National Building Code of Canada 
2015 with respect to suite silence. The code allows the signals (speakers) in dwelling units in 
zones other than the zone where the alarm occurred to be automatically silenced. However, it 
specifies that the automatic signal silence can only occur after a certain amount of time. It also 
specifies that the signals must resound immediately if there is a subsequent alarm anywhere 
in the building, or if ten minutes elapse and the alarm has not been acknowledged.

For example, consider a 3 floor residential building with a speaker in each suite and a speaker 
in each hallway. If an alarm occurs on floor 3, the following events occur.

1. All the speakers sound.

2. After 60 seconds, the speakers in the suites on floors 1 and 2 are silenced. The 
speakers in the hallways on floors 1 and 2 continue to sound, and all the speakers on 
floor 3 continue to sound.

3. After 10 minutes, if the alarm is not acknowledged, all the speakers sound again.

Excerpt from the National Building Code of Canada 2015 Division B, Part 3.2.4.18

(11) Audible signal devices within dwelling units that are wired on separate signal circuits need 
not include a means for silencing as required by Sentence (7) provided the fire alarm system 
includes a provision for automatic signal silence within dwelling units, where,

• (a) the automatic signal silence cannot occur within the first 60 s. of operation or within 
the zone of initiation,

• (b) a subsequent alarm elsewhere in the building will reactuate the silenced audible 
signal devices within dwelling units,
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• (c) after a period of not more than 10 min., the silenced audible signal devices will be 
restored to continuous audible signal if the alarm is not acknowledged...

19.53.1 Timers for Suite Silence

There are three timers for suite silence in the Job Details. See section 19.5 on page 134.

• Auto Resound - This timer specifies the time, in minutes, after which the signals will 
resound if an alarm remains un-acknowledged. The default is 10 minutes.

• New Alarm - This is the time, in seconds, that the alarm plays on outputs correlated with 
the New Alarm Active Common System Status. After this amount of time, the alarm 
plays only on the outputs correlated with the zone or input that started the alarm.

For example, if you correlate the New Alarm Active Common System Status with all the 
zones that contain suites, then a new alarm will play in all the suites for this amount of 
time. After this time, the alarm with continue to play only in the zone where the alarm 
was initiated (as well as outputs correlated with the Common Alarm Common System 
Status).

In a two stage system, suite silence is canceled when the stage two alarm starts.

As per UL 864 and UL 2572 the New Alarm Active Common System Status must not be 
correlated.

• Signal Silence Inhibit - This is the time, in seconds, during which you cannot silence 
the alarm or reset the system. This time must be shorter than Auto Signal Silence.

As per UL 864 and UL 2572 only a Signal Silence Inhibit setting of 0 is permissible.

19.53.2 Common System Statuses

There are three Common System Statuses used for Suite Silence.

• New Alarm Active - This status is true when a new alarm occurs and remains true while 
the New Alarm timer is running. It is usually correlated with the suite signal circuits.

As per UL 864 and UL 2572 the New Alarm Active Common System Status must not be 
correlated.

• Auto Suite Resound - This status becomes true when the Auto Resound timer 
expires. It is usually correlated with the suite signal circuits, so that the alarm resounds in 
the suites if it is not acknowledged.

• Common Alarm - Signal circuits that are correlated with Common Alarm activate when 
any alarm is active.

Note: For more information, consult the National Building Code of Canada 2015. 
Please review the full text of the code and consult with professional advisors for 
the implications of the code.

Attention: Do not correlate the Subsequent Alarm Common System Status with 
suite signals.

i

!
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19.54 Configuring suite silence

Configure suite silence

1. Select Job Details in the job tree.

2. Set the Alert rate to Alert and the Evac rate to Temporal.

3. If the job has audio, click the Set up button under Audio. Click the buttons beside Alert 
and Evac and set the alert rate to Alert and the Evac rate to Temporal.

4. Set New Alarm to 60 seconds. After 60 seconds, the signals will stop in the correlated 
zones, except the zone where the alarm was initiated.

5. Set Auto Resound to 10 minutes. After 10 minutes, the alarm will sound in all the suites 
if it has not been acknowledged.

6. Set Signal Silence Inhibit to 60 seconds.

7. Set Auto Signal Silence to Disabled.

Figure 167 Timers for suite silence

8. Create an alarm zone for each floor.

9. Create 2 signal circuits for each floor - one circuit for the suites, and one for the hallways.

10. Correlate each floor alarm zone to the corresponding suite's signal circuits.

11. Correlate Common Alarm to the Hallways' signal circuits.

12. Correlate the Common Alarm common system status to the hallways' signal circuits.

13. Correlate the New Alarm Active common system status to all suite signal circuits.

14. Correlate the Auto Suite Resound common system status to all suite signal circuits.

19.55 Signal Silence Operation

This section describes how to configure the notification appliance circuits (NACs) in 
accordance with four types of signal silence operation:

• Basic Signal Silence Operation: A Basic Signal Silence Operation is considered to be 
any system whereby activation of the signal silence switch following receipt of an alarm 
is uninhibited.

• Modified Signal Silence Operation: A Modified Signal Silence Operation is considered 
to be any system whereby activation of the signal silence switch following receipt of an 
alarm is partially inhibited: the audible signals are deactivated and the visual signals 
remain activated.

• Non-Silenceable Waterflow Alarm Operation: A Non-Silenceable Waterflow Alarm 
Operation is considered to be any system whereby activation of a waterflow alarm shall 
inhibit the signal silencing of audible and/or visual signals.
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• Modified Non-Silenceable Waterflow Alarm Operation: A Modified Non-Silenceable 
Waterflow Alarm Operation is considered to be any system whereby activation of the 
signal silence switch following receipt of a non-waterflow alarm is partially inhibited: the 
audible signals are deactivated and the visual signals remain activated. The activation of 
a waterflow alarm shall inhibit the signal silencing of the audible and/or visual signals.

Activation of the Signal Silence button when the panel is in alarm turns on the Signal Silence 
indicator and deactivates any silenceable NACs. Non-silenceable circuits are unaffected. 
Signals will resound upon any subsequent alarm. This button does not function during any 
configured signal silence inhibit timer period. It also does not function if the signals are active 
as a result of a fire drill.

The NS (Non-Silenceable) flag is intended as an inhibitor to the signal silence command in 
accordance with certain jurisdictions where silencing of audible and/or visual notification 
appliance circuits during a waterflow alarm may not be permitted.

Where driven by the activation of an input zone with an NS flag, audible and/or visual 
notification circuits shall continue to operate following the manual activation of the signal 
silence switch. Only visual and audible notification circuits drive by silenceable input zones (no 
NS flag) shall be silenced.

It is recommended that the NS flag not be applied directly to the notification appliance circuits.

19.55.1 Signal Silence Operation (Single Stage)

Below is a description of the Signal Silence operation in accordance with requirements.

In a single stage system, all alarm inputs are treated in a similar manner. Alarm inputs include 
any of the following: Non-verified alarm, verified alarm, water-flow alarm, and general alarm 
input circuits. Upon receipt of an initial alarm input, the panel shall cause the following:

• The active alarm input is displayed within the Main Display Alarm Queue.

• The internal piezo buzzer sounds steadily.
• The Common Alarm Status is active.
• The on-board Common Alarm Relay is closed (Active).

• Audible and/or Visual signals associated with the input are activated at the evacuation 
rate.

While in alarm, and the 1-minute signal silence inhibit has expired (where applicable), 
pressing the Signal Silence Switch will cause the following events to occur (Basic Signal 
Silence Operation):

• Signal Silence switch is activated.
• Signal Silence switch LED is illuminated (flashing yellow).
• A Signal Silence trouble event is reported for each node currently silenced.

• Audible and/or Visual signals become inactive.

A Subsequent alarm shall cause the following:

• Signal Silence switch is de-activated and the Signal Silence switch LED is off.
• The Signal Silence trouble event(s) are restored.
• Audible and/or Visual signals are reactivated.
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• Any additional signals associated with the subsequent alarm are activated at the 
evacuation rate.

Where Modified Signal Silence operation is required, activation of an alarm input shall 
operate in a similar manner as described following the receipt of an initial alarm.

While in alarm, and the 1-minute signal silence inhibit has expired (where applicable), 
pressing the Signal Silence Switch will cause the following events to occur (Modified Signal 
Silence Operation):

• Signal Silence switch is activated.
• Signal Silence switch LED is illuminated (flashing yellow).
• A Signal Silence trouble event is reported for each node currently silenced.

• Audible signals become inactive.
• Visual signals shall be unimpeded.

A Subsequent alarm shall cause the following:

• Signal Silence switch is de-activated and the Signal Silence switch LED is off.

• The Signal Silence trouble event(s) are restored.
• Audible signals are reactivated.
• Any additional signals associated with the subsequent alarm are activated at the 

evacuation rate.

Where Non-Silenceable Water Flow operation is required, activation of a water flow alarm 
input shall operate in a similar manner as described following the receipt of an initial alarm.

During an active water flow alarm, pressing the Signal Silence Switch will cause the following 
events to occur (Non-Silenceable Water Flow operation):

• Signal Silence switch is activated

• Signal Silence switch LED is illuminated (flashing yellow)
• Audible and/or Visual signals driven by the water flow alarm shall be unimpeded

Where Modified Non-Silenceable Water Flow Operation is required, activation of a water 
flow alarm or any alarm input shall operate in a similar manner as described following the 
receipt of an initial alarm.

During an active alarm classified as a non-water flow, pressing the Signal Silence Switch 
will cause the following events to occur (Modified Non-Silenceable Water Flow Operation):

• Signal Silence switch is activated.
• Signal Silence switch LED is illuminated (flashing yellow).

• A Signal Silence trouble event is reported for each node currently silenced.
• Audible signals become inactive.
• Visual signals shall be unimpeded.

A Subsequent alarm shall cause the following:

• Signal Silence switch is de-activated and the Signal Silence switch LED is off.

• The Signal Silence trouble event(s) are restored.
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• Audible signals are reactivated.
• Any additional signals associated with the subsequent alarm are activated at the 

evacuation rate.

If water flow alarm receipt is received, pressing the Signal Silence Switch will cause the 
following events to occur (Non-Silenceable Water Flow operation):

• Signal Silence switch is activated
• Signal Silence switch LED is illuminated (flashing yellow)

• Audible and/or Visual signals driven by the water flow alarm shall be unimpeded

19.55.2 Signal Silence Operation (Two Stage)

Below is a description of the Signal Silence operation in accordance with requirements.

In a two-stage system, all alarm inputs are treated in a similar manner. Alarm inputs include 
any of the following: Non-verified alarm, verified alarm, water-flow alarm, and general alarm 
input circuits. Upon receipt of an initial alarm input, the panel shall cause the following:

• The active alarm input is displayed within the Main Display Alarm Queue.

• The internal piezo buzzer sounds steadily.
• The Common Alarm Status is active.
• The on-board Common Alarm Relay is closed (Active).

• Audible and/or Visual signals associated with the input are activated at the alert rate 
(unless specified with the GA flag).

• Auto GA timer becomes active (if required).

• Auto signal silence (if required).

19.55.3 Basic Signal Silence Configuration

A Basic Signal Silence Operation is considered to be any system whereby activation of the 
signal silence switch following receipt of an alarm is uninhibited.

Configure basic signal silence driven by the FleX-Net™ built-in NACs

1. Do not define the NS flag to any of the FleX-Net™ built-in NACs.

2. Do not define the NS flag to any of the alarm zones.

Configure basic signal silence driven by the INX-10A

1. Do not correlate the signal silence status to the designated internal signal silence relay 
output module of the INX-10A Power Supply panel.

2. Do not define the NS flag (F1) to any of the designated internal Supervised Output 
module (NAC’S) of the INX-10A Power Supply panel.

3. Do not define the NS flag (F1) to any of the alarm zones.

Note: All four signal silence operations in a two-stage system shall operate as 
described in the single stage operation with regards to the Silencing and 
Subsequent alarm of Audible and/or Visual signals, unless otherwise specified in 
the configuration.

i
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19.55.4 Modified Signal Silence Configuration

A Modified Signal Silence Operation is considered to be any system whereby activation of the 
signal silence switch following receipt of an alarm is partially inhibited: the audible signals are 
deactivated and the visual signals remain activated.

When the Silence NAC Audibles Only check box on the Job Details page is selected, all 
Alarm, Supervisory, Trouble, and Monitor zones with the NS flag will deactivate only audible 
signals when signal silence is activated.

Configure modified signal silence driven by the FleX-Net™ built-in NACs

1. Select the Silence NAC Audibles Only check box on the Job Details page.

2. Define the NS flag to the alarm zone that requires the modified signal silence operation.

3. Do not define the NS flag to any of the FleX-Net™ built-in NACs.

Configure modifier signal silence driven by the INX-10A

1. Select the Silence NAC Audibles Only check box on the Job Details page.

2. Correlate the signal silence status to the designated internal signal silence relay output 
module of the INX-10A Power Supply panel.

3. Do not define the NS flag (F1) to any of the designated internal Supervised Output 
module (NACs) of the INX-10A Power Supply panel.

4. Define the NS flag (F1) to the alarm zone that requires the Modified Signal Silence 
operation.

19.55.5 Non-Silenceable Waterflow Alarm Configuration

A Non-Silenceable Waterflow Alarm Operation is considered to be any system whereby 
activation of a waterflow alarm shall inhibit the signal silencing of audible and/or visual signals.

Audible and/or visual signals in the Waterflow zone type are unaffected by the activation of 
the signal silence switch.

Configure a non-silenceable waterflow alarm driven by the FleX-Net™ built-in NACs

1. Add all devices that are required to be non-silenceable to the Waterflow zone.

2. Do not define the NS flag to any of the FleX-Net™ built-in NACs.

Configure a non-silenceable waterflow alarm driven by the INX-10A

1. Add all devices that are required to be non-silenceable to the Waterflow zone.

2. Do not correlate the signal silence status to the designated internal signal silence relay 
output module of the INX-10A Power Supply panel.

3. Do not define the NS flag (F1) to any of the designated internal Supervised Output 
module (NACs) of the INX-10A Power Supply panel.

Note: NFPA 72 (2019) 10.12.2 “When a fire alarm notification deactivation means is 
actuated, both audible and visible notification appliances shall be simultaneously 
deactivated” unless otherwise specified by Authority Having Jurisdiction (AHJ).i
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19.55.6 Modified Non-Silenceable Waterflow Alarm Configuration

A Modified Non-Silenceable Waterflow Alarm Operation is considered to be any system 
whereby activation of the signal silence switch following receipt of a non-waterflow alarm is 
partially inhibited: the audible signals are deactivated and the visual signals remain activated. 
The activation of a waterflow alarm shall inhibit the signal silencing of the audible and/or visual 
signals.

When the Silence NAC Audibles Only check box on the Job Details page is selected, all 
Alarm, Supervisory, Trouble, and Monitor zones with the NS flag will deactivate only audible 
signals when signal silence is activated.

Configure a modified non-silenceable waterflow alarm driven by the FleX-Net™ built-in
NACs

1. Add all devices that are required to be non-silenceable to the Waterflow zone.

2. Select the Silence NAC Audibles Only check box on the Job Details page.

3. Define the NS flag to the alarm zone that requires the modified signal silence operation.

4. Do not define the NS flag to any of the FleX-Net™ built-in NACs.

Configure a modified non-silenceable waterflow alarm driven by the INX-10A

1. Add all devices that are required to be non-silenceable to the Waterflow zone.
2. Select the Silence NAC Audibles Only check box on the Job Details page.
3. Do not define the NS flag (F1) to any of the designated internal Supervised Output 

module (NACs) of the INX-10A Power Supply panel.
4. Define the NS flag (F1) to the alarm zone that requires the modified signal silence 

operation.
5. Add the following logic statement to internal signal silence relay output module of the 

INX-10A Power Supply panel: Signal Silence AND NOT Water Flow Zone: A
Example: **-**-**-ST-012 AND NOT 01-00-**-IZ-005: A

19.56 Menus

19.56.1 File Menu

The File menu contains the following commands:

Table 34 File Menu

Name Short cut Description 

Backup 
Database

Backup database makes a copy of the Master Database in 
the File folder specified in the User Preferences. The 
backup file will have a name of the form YYYY-MM-
DD.mdb. The back up can be used by the Restore 
Database command to recover all of the jobs in the 
database. The Import command can be used to recover 
selected jobs from a backup. Backup your Master 
Database often and store a copy of the resulting file on a 
CD or other media. 
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19.56.2 Job Menu

The Job menu contains the following commands:

Restore 
Database

Restores the database from a backup copy. Note: This 
operation will replace the entire contents of the current, 
working database with the backup. 

Compact 
Database

To ensure optimal performance, you should compact and 
repair your database on a regular basis. If you have purged 
job versions or deleted jobs, Compacting the Database will 
regain the space occupied by those records. 

User 
Preferences

Specifies User Preferences, such as the location of 
database, backups, and job files.

Open Folder Opens the folder for the backup, the job files, or the job 
build in Windows Explorer.

Print Ctrl+P Print the active job. 

Print Preview Display a Print Preview of the active job.

Print Setup Select the printer, paper size and orientation for a print job.

Exit Closes the configurator.

Table 35 Job Menu

Name Short cut Description 

New Job Ctrl-N
This command will open the Create Job dialog which will 
allow you to start a new job. The new job can be based on a 
supplied template or on an existing job. 

Open Job Ctrl+O This command will open an existing job from your 
database. 

Import Job
Imports a selected job/version from an external database or 
serialized job archive and converts the job to the current 
version if necessary. 

Export Job Ctrl+E Exports the current job in one of two formats: A single job 
database file, or a compact, serialized archive format. 

Merge Jobs
Merges a selected job into the current job, retaining all 
correlations.

New Version Ctrl+W

Make a copy of the current job, assigning it the next highest 
version number. The user is prompted for mandatory 
comments and may also override the Author field. The Job 
Name cannot be changed. The new version is un-locked for 
editing.

Delete Job 
Version Ctrl+D This command permanently deletes the current Job / Job 

Version from the database.

Table 34 File Menu (Continued)

Name Short cut Description 
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19.56.3 Insert Menu

The Insert menu contains the following commands.

Some commands may be disabled (greyed) depending on what items are selected on the user 
interface.

Some items may be suppressed depending on the product.

Version 
History

Display the Version History (Date, Author, Comments) for 
the current job.

Compare Job 
Versions

Compare two versions of the same job, or two similar jobs 
of different lineage.

Convert Job For future use. 

Validate Job This action performs all of the steps normally performed 
when preparing to send a job to the panel.

Edit Job Toggle the lock on a job that is protected against 
unintentional edits or has been down loaded to a panel.

Table 36 Insert Menu

Name Description

Add Network 
Nodes Nodes Add a network node to the job.

Add Loop 
Controllers

Add an Addressable or Conventional Loop Controller to the selected 
network node. 

Add 
Annunciators Add an LCD or LED Annunciator to the selected network node. 

Add Display 
Adder Add a Display Adder to an Annunciator or Base Panel. 

Add UDACT Add UDACT capability to the selected network node. 

Add Audio 
Controller

Add an Audio Controller to the selected network node. A maximum of one 
Audio Controller is allowed per node.

Context Dependent

Add Device If the selected tree item is a device loop, add a device or circuit. 

Add Message Add a Message if the selected tree item is a remote annunciator that can 
accept Custom Messages. 

Add 
Correlations

Launch a dialog that allows correlations to be added to the selected 
devices or display items.

Table 35 Job Menu (Continued)

Name Short cut Description 
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19.56.4 Edit Menu

The Edit menu contains the following commands.

Some commands may be disabled (greyed) depending on what items are selected on the user 
interface.

19.56.5 Panel Menu

The Panel menu contains the following commands.

Table 37 Edit Menu

Name Short cut Description 

Delete Item Del Deletes the currently selected item.

Modify Item Ctrl+M
If the currently selected item is a row in an editable list, then 
the first changeable cell is selected and prepared for 
editing.

Copy Ctrl+C Copies the selected item(s) to the clipboard.

Paste Ctrl+V Pastes items from the clipboard to the selected destination.

Paste Special Ctrl+Shift+V Similar to Paste: Opens the Paste Special dialog to allow 
defaults to be changed before pasting.

Table 38 Panel Menu

Name Short cut Description

Connect Ctrl+L

This command will establish a connection between the 
configuration tool and the panel, enabling most of the other 
commands in this menu. Remember to disconnect when 
you are finished, as a trouble will be indicated on the fire 
alarm panel as long as the laptop is connected.

Send Job Ctrl+S Build the job and send the configuration to the panel. 

Get Job Ctrl+G
Get the job from the panel and store it on the configuration 
tool's database. The job becomes the current job, shown in 
the user interface. 

Manage Jobs Displays the jobs currently loaded on the panel and lets you 
delete them.

Panel 
Information...

Displays detailed information about the panel to which the 
configuration tool is connected. 

Security Key 
Info...

Displays information about the security key for those 
products that support a key. The user must have entered 
the correct PIN when prompted - either when configurator 
was started or when the key was inserted - to enable this 
command. 

Upgrade 
Firmware... Loads firmware to the panel from a firmware archive file. 



Using the Configurator

219

19.56.6 Tools Menu

The items under the Tools menu are used mainly for troubleshooting and diagnostic purposes 
by the factory.

Note: The Tools menu is only available if you checked the Show Tools Menu option. See 
User Preferences.

Table 39 Tools Menu

Name Short cut Description

Extract All DB Extracts the latest version of every job to individual 
database files. 

Build Job Ctrl+B Builds the job, assuming the latest product version, 
creating a ".c" file in the Job Build folder.

Build Job (old 
versions)... Builds the job ".c" file for a specified, older product version.

Link Statistics Displays the connection link statistics 

Log Send
Toggle the current state of the "dump on send" option. 
Causes the ".c" file to be produced and dumped on a Get 
Job. 

Log Get
Toggle the current state of the "dump on get" option. 
Causes the ".c" file to be produced and dumped on a Send 
Get. 

Log Comms Toggles logging of serial communications. 

Trace
Toggles the current state of the trace option. When turned 
on this causes debug information to be written to a trace 
file.

Display 
Structure

This command will display a dialog that will allow you to 
view and log panel data structures. 

External Bus
Toggles the "Use External Bus" setting. When turned on, 
this signals that the configurator is connected to the 
External Bus of the panel. 
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